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Introduction About This Guide

Introduction

Welcome  Welcome to Gentran:Server® Windows® Forms Integration subsystem, Sterling
Commerce’s Electronic Data Interchange (EDI) form-generation software for the
Windows operating system. Gentran:Server provides you with the tools that you need to
design forms to facilitate the keying and printing of EDI documents.
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About This Guide

What’s in this manual

What’s in this manual

Overview

Related manuals

Intended audience

Prerequisite
knowledge

This manual contains a tutorial for Gentran:Server Forms Integration, using the ANSI
92.1 standard. This tutorial includes a print form example (purchase order) and a screen
entry form example (invoice). The purpose of this tutorial is to break the form creation
process into concise and understandable steps, using examples that enable you to
understand and master the tasks and processes required to create your own forms.

Complete the print form tutorial first. After you have mastered the steps involved in
creating a print form, you can begin the tutorial for the screen entry form.

To access reference information, refer to the Gentran:Server Forms Integration online
Help or Forms Integration User’s Guide. For additional information on the various tasks
described in this manual, refer to the Forms Integration Users Guide.

This manual is intended for the following users:

»  Technical users—users with a detailed knowledge of the Windows operating system,
networking, databases, and communications.

» Novice-to-average experienced users—users who are new to Gentran:Server for
Windows, EDI, or both.

» EDI Coordinators—users responsible for creating and maintaining the transfer of EDI
data between Trading Partners.

The audience using this software should be familiar with:
»  PC and Microsoft® Windows functions

» EDI concepts

» EDI standard structure

» the internal application format

» data mapping concepts

» Gentran:Server® Windows® product

Forns Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()



Description of Contents About This Guide

Description of Contents

Overview  The Forms Integration ANSI Tutorial contains the tasks associated with using the Forms
Integration subsystem.

Organization of  The tutorial guide is organized into the following chapters:

chapters » Chapter 1, Getting Started, explains the content, organization, conventions, and

system requirements. This chapter describes how to build forms and how to
customize global EDI date formats.

» Chapter 2, Creating a Print Form, explains the tasks necessary to create a print form
for an ANSI purchase order (ORDERS).

» Chapter 3, Creating a Screen Entry Form, explains the tasks necessary to create a
screen entry form for an ANSI invoice (INVOIC).

» The Glossary contains definitions of Forms Integration and Gentran:Server terms and
concepts.

Gentran:Server for Windows — August 2008 Forns Integration ANSI Tutorial Guide
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About This Guide Online Help

Online Help

Overview  The majority of the Gentran:Server for Windows Forms Integration User’s Guide
documentation is also contained in the online Help system.
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Getting Support

Getting Support

About This Guide

Introduction Sterling Commerce’s Gentran:Server software is supported by trained product support
personnel who are available to help you with product questions or concerns.

Note

Gentran:Server Customer Support does not support non-Sterling Commerce products
(e.g., SQL Server, Oracle, etc.), but can assist you in configuring non-Sterling Commerce
products to work with Gentran:Server.

Phone number For assistance, please refer to your Getting Started Guide to determine which support

phone number you should use.

Before calling  To help us provide prompt service, we ask that you do the following:

support )

events.

Attempt to recreate any problem that you encounter and record the exact sequence of

»  When you call product support, you should be prepared to provide us with the

information below.

Information

Description

Identification

Your company name, your name, telephone number and
extension, and the case number (if the question refers to a
previously reported issue).

System Configuration

The Gentran:Server version (and any service packs
installed) and information about the primary Gentran
system controller and all machines experiencing
problems, including: the Windows operating system
version, amount of memory, available disk space,
database version, Microsoft Data Access (MDAC)
version, and Internet Explorer version.

Also, please describe any recent changes in your
hardware, software, or the configuration of your system.

System Data Store

Which machines contain folders in the system data store?

Error Messages

Record the exact wording of any error messages you
receive and the point in the software where the error
occurred, as well as any log files.

Attempted Solutions

Record any steps that you took attempting to resolve the
problem and note all the outcomes, and provide an
estimate on how many times the problem occurred and
whether it can be reproduced.

() Gentran:Server for Windows — August 2008
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About This Guide Getting Support

Accessing the The Sterling Commerce Customer Support Web Site contains valuable information about
Sterling getting support for Gentran:Server for Windows, including the:

Commerce ,  scope of support services
Support Web Site .
» customer support policies
» call prioritizing
» customer support phone directory
» how to create new Support on Demand cases
» how to check the status of Support on Demand cases

» how to add information to Support on Demand cases

The Customer Support Web Site is constantly updated and all Sterling Commerce
customers have access to it. This web site also contains the most recent product updates
and is a valuable source of product information.

Reference
Refer to the Getting Started Guide for information on how to access the Customer Support
World Wide Web Site.

Documentation The Customer Support Web Site contains a documentation library, which has the entire
Gentran:Server for Windows documentation set. You can download the product manuals
in PDF format from this library at any time.

Forns Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()
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Introducing Forms Integration Getting Started

Introducing Forms Integration

Overview

What is a form?

What is a print

translation object?

What is a screen
entry translation
object?

The Gentran:Server® Windows® Forms Integration subsystem enables you to design
forms to facilitate the keying (screen entry) and printing (print) of EDI documents that you
receive inbound or send outbound.

A form is a set of instructions you define in the Forms Integration subsystem that indicates
how the system should format data. When you compile the form, Gentran:Server
generates a translation object. After you register the translation object with Gentran:Server
and associate the translation object with a partner relationship, the system uses the
translation object to format EDI documents. The Forms Integration subsystem enables you
to create print and screen entry translation objects.

A print translation object organizes and formats the printout of EDI documents that are
received from or sent to the trading partners for which you have established an inbound or
outbound trading relationship that utilizes that print translation object. The print
translation object enables you to view the EDI document in an easy-to-read format.

A screen entry translation object provides a standardized format for keying an EDI

document into the Document Editor for translation and transmission to your trading
partners. The screen entry translation object ensures that your users key all the data
necessary to create the required EDI document.

Gentran:Server generates the translation object format based on the EDI file format in the
EDI File Format Pane and displays that format in the Layout Pane.

Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide



Getting Started

Navigation

Navigation

Overview You can access the Gentran:Server Forms Integration Window in one of four ways:

Click the menu option from the Main Menu Bar.
Click the appropriate button on the Main Toolbar.
Click or double-click the appropriate part of the form.

Click a form component (EDI File Format Pane or Layout Pane) with the right mouse
button to access a shortcut menu that contains all the functions that are currently
available for that form component. The shortcut menus enable you to quickly and
easily access available functionality. The content of the shortcut menus varies,
depending on the type and level of the selected form component.

Note
When you start Gentran:Server, the Main Menu Bar contains a subset of menu items. The
full set of menu items is displayed after you create a new form or open (load) an existing
form.

Forms Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()



Navigation Getting Started

Forms Integration  This diagram illustrates the Forms Integration Window.
Window
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EDI File Format Pane
Layout Pane
Status Bar
— Main Menu Bar Main Toolbar —

Forms Integration This table describes the parts of the Gentran:Server Forms Integration Window.
Window parts and
functions Part Function

Main Menu Bar The Main Menu Bar contains the menus

Note
Detailed descriptions of each of the commands on these
menus are found in the online Help.

Main Toolbar The Main Toolbar gives you access to some of the most
common operations in Gentran:Server.

Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide
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Getting Started

Navigation

Part

Function

EDI File Format Pane

The EDI File Format Pane contains the EDI file format.
When you click a segment or group in the EDI file format,
the corresponding frame is displayed in the Layout Pane.
When you click an element in the EDI file format, the
corresponding layout component is highlighted in the
Layout Pane.

Layout Pane

The Layout Pane contains the actual format of the
translation object. Each group (with a maximum usage
greater than one) and repeating segment has a corresponding
frame in the Layout Pane. When you click a segment or
group in the EDI file format, the corresponding frame is
displayed in the Layout Pane. When you click an element in
the EDI file format, the corresponding layout component is
highlighted in the Layout Pane.

Status Bar

The Status Bar displays status information about a
selection, command, or process, defines menu items as you
highlight each item in the menu, and indicates any current
keyboard-initiated modes for typing (e.g., CAP for the
“Caps Lock” key, NUM for the “Num Lock” key, etc.).

Main Toolbar  The Main Toolbar gives

you access to some of the most common operations in

Gentran:Server. Unavailable items are dimmed. The Main Toolbar is a dockable toolbar,

so you can affix it to any
Toolbar.

edge of the client window. This diagram illustrates the Main

Tree Only

New Cut Constants Split Add Text Change

Paste

‘ Save

Code Lists

Deactivate ‘ Undo View

D2d] 2] =] =] E=E] (=2 (212 [ mE el ] 2UFE ]S

Copy
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Syntax Activate Lock Labels Layout
Tokens Only
Promote Generate Redo
Layout
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EDI File Format Pane Getting Started

EDI File Format Pane

Overview

Generating EDI
files

Generating
specialized EDI
standard versions

The EDI File Format Pane (left side of the Forms Integration subsystem main window)
contains the EDI file format. The EDI file must contain all the information that you need
to include to either create a document using the Document Editor (screen entry translation
object) or print documents (print translation object), so that your system can accurately
process the data.

Gentran:Server generates an EDI file for you, based on the standard (agency), version,
transaction set, and release (for the TRADACOMS standard only) you selected. The
system includes all the groups, segments, composites, and elements that are defined by the
standards agency for the version of the document you selected.

You typically need to customize the system-generated EDI file by modifying the
properties of the form components, and using specialized Gentran:Server functions to
manipulate the EDI file structure.

Reference

See Design and Create the Form on page 2 - 15 (print form) or Design and Create the
Form on page 3 - 16 (screen entry form) for more information on generating an EDI file
when you create a new form.

If you want to use a specialized version of an EDI standard that is not available in the
Gentran:Server standards database, it may be appropriate for you to define the EDI file
yourself.

Regardless of whether the system generates the EDI file or you define it, the specific EDI
form components that you use depend on the type of form you are creating. This includes
the standard, version, and transaction set (document) selected, and which groups,
segments, composites, and elements your company requires.

Recommendation
We recommend that you determine which form components you are using before
generating or defining an EDI file.

() Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide



Getting Started

EDI File Format Pane

Form components This table describes form components that Gentran:Server uses to define the EDI file

format.

Icon

Description

5

A group is a looping structure that contains related segments and/or
groups that repeat in sequence until either the group data ends or the
maximum number of times that the loop is allowed to repeat is
exhausted. Groups are defined by the EDI standards. A group that is
subordinate to another group is a subgroup (this corresponds to a
nested looping structure — a loop within a loop). The EDI file is a
group and therefore, it is visually represented the same way as other
groups and subgroups in Gentran:Server.

A segment contains a group of related elements or composite data
elements that combine to communicate useful data. Segments are
defined by the EDI standards. A segment can occur once or can repeat
multiple times.

A composite is a data element that contains two or more component
data elements or subelements. Composites are defined by the EDI
standards that use them (EDIFACT, TRADACOMS, and certain ANSI
X12 standards).

An element is the smallest piece of information defined by the EDI
standards. An individual element can have different meanings
depending on the context. Therefore, elements are normally not
considered to have useful meaning until they are combined into
segments. When an element has an operation performed against it, a
red checkmark is displayed over the element icon.

When an element contains a standard rule a black asterisk appears to
the right of the element icon.

Forms Integration ANSI Tutorial Guide
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Layout Pane

Layout Pane

Overview

List formats

Field formats

Frames

Displaying
information

Getting Started

The Layout Pane (right side of the Forms Integration subsystem main window) contains
the actual format of the translation object. Gentran:Server uses frames to format the EDI
file for the translation object. Each frame contains the groups, repeating segments, and
elements at that level (single segments are not represented on the frame).

For screen entry translation objects, groups (with a maximum usage greater than one) and
repeating segments are formatted as lists. Elements are formatted as edit boxes (boxes) or
lists on the frame. Elements are typically formatted as fields, but are formatted as a list if
you apply a standard rule that allows a selection of multiple items. Each group and
repeating segment also has a corresponding frame that contains all the groups (with a
maximum usage greater than one), repeating segments, and elements at that level.

For print translation objects, groups, repeating segments, and elements are always
formatted as fields.

Each group and repeating segment also has a corresponding frame that contains all the
groups (with a maximum usage greater than one), repeating segments, and elements at that
level.

When you click a segment or group in the EDI File Format Pane, the corresponding frame
is displayed in the Layout Pane. When you click an element in the EDI File Format Pane,
the corresponding layout component is highlighted in the Layout Pane.

Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide



Getting Started Building a Form with Forms Integration

Building a Form with Forms Integration

Overview  This section defines how to proceed with building a form using the Gentran:Server Forms
Integration subsystem.

Stages of building  This table describes the steps required to build a form using Forms Integration.
a form

Stage Description

1 Prepare and Analyze.

Obtain a layout of how you want the form to be displayed and determine
how it corresponds to the EDI standard you are using. Determine what
operations need to be performed to generate the required layout.

2 Set Global Defaults (first time only).
The first time you use the Gentran:Server Forms Integration subsystem,
you should verify the default date format that the system uses.

Reference

See Verifying the Global EDI Date Formats on page 2 - 15 (print form) or
Verifying the Global EDI Date Formats on page 3 - 16 (screen entry form)
for more information on verifying the global date default.

3 Create, Save, and Name a New Form.

Reference

See Defining the Type of Form on page 2 - 16 (print form) or Defining the
Type of Form on page 3 - 18 (screen entry form) for more information on
creating, saving, and naming a form.

4 Activate the Appropriate EDI Groups, Segments, and Elements.

Reference

See Activating Groups, Segments, and Elements on page 2 - 20 (print
form) or Activating Groups, Segments, and Elements on page 3 - 23
(screen entry form) for more information on activation.

5 Promote, Split, and Change Segments and Groups.

Reference

See Modify Form Components on page 2 - 26 (print form) or Modify Form
Components on page 3 - 29 (screen entry form) for more information on
promoting, splitting, and changing segments and groups.
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(Contd)
Stage

Description

6

Customize the EDI Data.

Reference

See Customize the EDI Data on page 2 - 41 (print form) or Customize the
EDI Data on page 3 - 41 (screen entry form) for more information on
customizing the EDI data.

Define the Layout of the Form.

Reference

See Verifying EDI Delimiters on page 2 - 23 (print form) or Verifying EDI
Delimiters and Adding Frame Help Text on page 3 - 26 (screen entry
form) for more information on customizing your EDI file, including
verifying the EDI delimiters.

Compile the Form.

Reference

See Compiling the Form on page 2 - 125 (print form) or Compiling the
Form on page 3 - 133 (screen entry form) for more information on
compiling the form and translation object naming conventions.

Print the Report.
Validate and review the form, and make modifications as needed.

Reference

See Printing the Report on page 2 - 127 (print form) or Printing the
Report on page 3 - 134 (screen entry form) for more information on
printing the report.

10

Test the Translation Object.

For a screen entry translation object, create a new document in Document
Editor, using that translation object. For a print translation object, print a
document. Verify that the output is correct.

Reference

See Testing the Translation Object on page 2 - 128 (print form) or Testing
the Translation Object on page 3 - 135 (screen entry form) for more
information on testing the translation objects.
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How to Launch Forms Integration

Overview  This section describes how to launch the Forms Integration subsystem by means of
Gentran:Server.

Procedure  Use this procedure to launch the Forms Integration subsystem.

Step Action
1 Select Programs from the Windows Start menu.
2 Select Gentran Server Forms Integration from the Gentran Server

Programs group.

System Response
The system displays the Forms Integration subsystem.
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How to Install Gentran Standards

Overview  Note
You need to install Gentran Standards only if you installed Integration Components during
the Gentran:Server installation.

Reference
See the appropriate Gentran:Server Standards card for information about installing the
Gentran Standards.
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Creating a Print Form Introduction

Overview

Introduction

In this chapter This chapter includes the following topics associated with creating a print form:
» Form analysis
» Creating, saving, and setting up a new form
» Customizing the form, including the groups, segments, and elements
» Formatting the form, including fields and field labels

» Finalizing the form

Purpose of this  This tutorial defines the tasks necessary to create a print form. The print form enables you
tutorial  to print (on a printout) customized EDI data that has been processed through the
translation object. This tutorial explains how to customize and format a form before it is
compiled into a translation object. The form that you create using the Gentran:Server
Forms Integration subsystem is a source form. When that source form is compiled, the
result is a compiled translation object. You must register the translation object with
Gentran:Server to be able to use the translation object (to print documents of that type).

Form criteria Gentran:Server generates a basic form based on the following information:
» Type of form (e.g., print or screen entry)
» Standard agency (e.g., ANSI X12, EDIFACT)
» Standard version (e.g., 003040, 92.1)
» Document type (e.g., 850 Purchase Order, ORDERS)

Mandatory  All mandatory groups, segments, and elements for the standard, version, and transaction

components set you specify are available for use (activated) when Gentran:Server creates a form. Only
these mandatory form components (groups, segments, and elements) are activated
automatically. You must activate additional form components to accommodate the data
you expect to receive from your trading partner, and then customize and format the form
so that it is appropriate and useful for your company’s needs.
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Before you begin

Creating a Print Form

Before you begin to customize a print form, you should be familiar with the following
elements of form design:

» EDI standards (how EDI standards work and how the information your users need is
translated to and from the standards)

»  Your users (the individuals who are using the print forms to create printouts of
processed EDI data)

»  Your trading partners (the organizations that send you or that you send the EDI data to
be processed and printed)

You can create a different print form for each combination of transaction set, trading
partner, and standard version. There is no limit to the number of print forms you can
create, and the number of print forms you create is not affected by the number of screen
entry forms you create.

Recommendation

We recommend that you mock up a layout of the print form the way you ultimately want it
to look. As you are designing the layout, you should take into consideration the people
who are using the printouts. Make sure that the form makes sense to the people who are
using it. By analyzing your company’s needs before you actually create the print form,
you reduce the amount of time spent later on redesigning or reformatting the form. You
should include the following design considerations in your form planning:

»  Which fields should be printed, and which are necessary for the EDI data but do not
need to be displayed on the printout

»  Where fields should be located on the form
» What labels you are using to identify the fields on the form
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Phases of Designing a Form

Design phases  This table lists the phases in designing a form.

Stage Description
1 Analyze the EDI File.
2 Design and create the form.
3 Modify form components.
4 Customize the EDI data.
5 Format the form.
6 Finalize the form.
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Getting Started

Overview

Print form
scenario

This tutorial is designed to guide you through each of these four phases in sequential
order, completing one phase before proceeding to the next. When you create your own
forms, the phases may overlap and you may have to return to one or more of the phases
several times before the form is completed.The purpose of completing each task in this
tutorial in sequential order, as if it were your own scenario, is not only to teach you how to
perform the individual tasks, but also to teach you a logical approach and methods that
should be used when you create your own form.

This section guides you in completing the steps in the first phase of form design. In this
section, you create a new print form based on a scenario we have defined for you. This
section includes the basics of creating the form, such as defining the scenario and
analyzing the purpose of the form, creating and saving the form, and setting up the form.
You can find techniques for customizing the segments, elements, and groups in the form,
as well as for formatting the organization and appearance of the form, later in this chapter.

For this tutorial, you create a print form for the 850 transaction set (purchase order), using
the ANSI X12 003040 standard. The steps involved in creating this form are broken down
into manageable pieces so that you can learn the tasks and procedures involved in creating
a print form. Then, you can apply the knowledge gained from using this tutorial to create
your print forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide
variety of pet supplies for pet stores. You create a form that formats and arranges the EDI
data you receive from one of your trading partners, Pet Zone (a large pet supply retailer),
to produce a printout of a purchase order. You do not want to alter the integrity of the EDI
data. However, you want to interpret some of the codes included in the EDI message into
more meaningful text.
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Basic Tasks

Analyze the EDI File

Basic Tasks

Introduction

Form analysis

To analyze the EDI file, you must first determine what data your trading partner is sending
you. You and your partner must agree on which standard, version, and transaction set you
are using. In this tutorial, you are using an ANSI X12 version 003040 850 purchase order.
It is important to know the information that your partner sends you in the purchase order,
and what data is contained in each element used.

It is very helpful to review the EDI standard that you are using before analyzing the EDI
file. We recommend that you obtain an EDI standard manual for the standard and version
that you are using. Standard manuals are available from EDI standard agencies.

After discussing with your partner what they will send, determining which segments and
elements your company requires, and reviewing the EDI standard, you can list the items
that you will need to use. You will then make the form components you need available for
use.

The first step in creating a form is the analysis of the form requirements. If the analysis
you perform is complete, you have all the information you need to create the form in an
efficient and logical manner. If you omit this critical step and proceed directly to creating
the form, it is likely that creating the form is a much longer and arduous task, and the form
may not work the way you need it to due to oversights and omissions.

Creating a print form for the ANSI X12 850 purchase order requires several steps. Some
steps are performed at the document level (such as activating form components), and
others are iterative steps that are performed for each group, segment, or element in the
form. In this analysis phase, you must determine what EDI data Pet Zone is sending you,
as well as what information you want to print for the purchase order. The fields on the
form must accommodate all information that you want to print from the purchase order
your trading partner sends you.
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Creating a Print Form

Mandatory For an ANSI X12 purchase order (850), the following groups, segments, and elements
components have been defined as mandatory by the standards committee. These components are
activated automatically when you create a new form:
Data
Group | Segment | Element Description Type Length
BEG Beginning Segment for
Purchase Order
BEGO1 Transaction Set Purpose String 2
Code
BEGO02 Purchase Order Type Code String 2
BEGO03 Purchase Order Number String 22
BEGO05 Purchase Order Date Dt/Tm 6
POl Item Detail
CTT Transaction Totals
CTTO1 Number of Line Items Integer | 6
When translating data, the system does not process groups, segments, and elements that
are not activated. Therefore, you must make available (activate) the groups, segments, and
elements that are not defined as mandatory by the standard, but that you have determined
you need to use in the form.
Required This table lists the form components that are required (need to be activated) and are not
components  mandatory for the standard.
Note
When you activate a conditional group or segment, the mandatory subordinate segments
and elements are activated automatically. A conditional group or segment is used only if
there is EDI data available for that element.
Data Code Value/Format to Be
Element Description Type |Length Assigned
Note/Special Instruction (NTE Segment)
NTEO02 Free Form Message String | 60
Reference Numbers (REF Segment)
REFO01 Reference Number Qualifier String | 2
REF02 Reference Number String | 30
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Basic Tasks

(Contd) Data Code Value/Format to Be
Element Description Type |Length Assigned
Terms of Sale/Deferred Terms of Sale (ITD Segment)
ITDO1 Terms Type Code String | 2
ITD12 Description String | 80
Name and Address (N1 Group)
Name (N1 Segment in N1 Group)
N101 Entity Identifier Code String | 2 » BT (Bill to)
» ST (Ship to)
» BY (Buying party)
N102 Name String | 35
Address Information (N3 Segment in N1 Group)
N301 Address Information String | 35
N302 Address Information String | 35
Geographic Location (N4 Segment in N1 Group)
N401 City Name String | 30
N402 State or Province Code String | 2
N403 Postal Code String | 9

Item Detail (PO1 Group)

Baseline Item Data (PO1 Segment in PO1 Group) (Already Activated)

PO101 Assigned Identification String | 11

PO102 Quantity Ordered Real 9 Format = R6
PO103 Unit or Basis for Measurement String | 2

Code
PO104 Unit Price Real 14 Format = R2
PO106 Product/Service ID Qualifier String | 2 VN (Vendor)
UP (UPC Code)

PO107 Product/Service ID String | 30
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Creating a Print Form

(Contd) Data Code Value/Format to Be
Element Description Type |Length Assigned
Product/Item Description (PID Group in PO1 Group)
Product/Item Description (PID:2 Segment in PID Group)
PID:201 Item Description Type String | 1
PID:202 Description String | 80
Date/Time Reference (DTM:2 Segment in PO1 Group)
DTM:201 Date/Time Qualifier String | 3 » 010 (Requested Ship)
» 038 (Ship No Later)
DTM:202 Date Dt/Tm | 6 Screen Format =

MM/DD/YY

Segment analysis For each segment activated (either mandatory or optional), you must answer the following
questions:

Is the segment a group?

What elements need to be activated for the segment?

Does the segment have a maximum use greater than one?

This table describes the segment components used in this tutorial.

Component

Description

Group

Contains related segments and/or groups that repeat
in sequence until either the group data ends or the
maximum number of times that the loop is allowed

to repeat is exhausted.

Repeating segment

Consists of elements that repeat (in sequence) until
either the data ends or the maximum number of
times the segment is allowed to repeat is exhausted.
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Basic Tasks

Component

Description

Maximum use

Refers to the number of times that a segment can be
used within the structure in which the segment is
defined. For example, if a segment can be used only
once within a group, but the group can be used
multiple times, the segment still has a maximum
use of one within each occurrence of the group. The
standard defines the maximum number of times a
segment can be used, but you must determine
which of these segments are used, based on what
your trading partner is sending you.

Elements

Each segment contains elements. Some elements
are mandatory and others are optional to the
standard but necessary for your needs. You must
define all the elements that you are expecting from
Pet Zone for each segment.

Customization  Gentran:Server generates a form based on the groups, segments, and elements you
tasks activate. At this point, the form is compliant with the standard and it contains all the
necessary components based on the data Pet Zone sends you. However, you need to
customize the form components to produce a printed report that looks the way your

company expects it to look.

This table lists the customizing tasks described in this tutorial.

Form
Component

Description

Customizing Needed

BEGO1
element

Transaction Set
Purpose Code

This element is required in the purchase
order, but is not meaningful for your
purposes. You prevent this field from being
displayed on the printout.

BEG02
element

Purchase Order Type | The code from this element is used to look up
Code

the description in a code list table, and the
description is printed in another field that you
create. You prevent the Purchase Order Type
Code field from being displayed on the
printout, because the more meaningful
description is printed instead.

BEGO05
element

Purchase Order Date | The date in the EDI data is in the format

“YYMMDD,” but you want the date to be
printed in the format “MM/DD/YY,” so you
set the format accordingly.
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(Contd)
Form
Component

Description

Customizing Needed

REF segment

Reference Numbers

The standard allows this segment to be used
up to twelve times in one purchase order, but
you and your trading partner have decided to
use this segment only once. Therefore, you
change the maximum use of this segment
from twelve to one.

REFO01
element

Reference Number
Qualifier

The code from this element is used to look up
its description in a code list table, and the
description is printed in another field that you
create. You prevent the Reference Number
Qualifier field from being displayed on the
printout, because the more meaningful
description is printed instead.

ITDO1 element

Terms Type Code

The code from this element is used to look up
its description in a code list table, and the
description is printed in another field that you
create. You prevent the Terms Type Code
field from being displayed on the printout,
because the more meaningful description is
printed instead.

N101 element

Entity Identifier
Code

The code from this element is used to look up
its description in a code list table, and the
description is printed in another field that you
create. You prevent the Entity Identifier Code
field from being displayed on the printout,
because the more meaningful description is
printed instead.

N4 segment

Geographic Location

The fields (city, state, postal code) for the N4
segment currently are set up to be printed
before the street address from the N3
segment. (The segments are set up this way
to allow the N3 segment to repeat, causing
the N3 fields to be displayed on a different
frame than the one that contains the N1 and
N4 fields.) However, this format is not the
standard format for an address. You insert a
new group and place the N4 segment under
the new group so that the address is printed

properly.
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Basic Tasks

(Contd)
Form
Component

Description

Customizing Needed

PO1 group

Baseline Item Data

After you customize and format the fields in
the PO1 group, you copy and paste the PO1
group at the same level in the EDI file. The
original PO1 group contains column
headings for the line item detail, but you
prevent the column headings from being
printed on the printout for all line items after
the first. You change the maximum use of the
first PO1 group to one so that the column
headings are printed only once (for the first
line item). The second PO1 group retains its
maximum use of one hundred thousand,
allowing up to one hundred thousand line
items to be printed on the printout (without
printing the column headings for each line
item).

PO104 element

Unit Price

Both the EDI data and the printed price are
formatted with two explicit decimal places.

PO106 element

Product/Service ID
Qualifier

The code from this element is used to look up
its description in a code list table, and the
description is printed in another field that you
create. You prevent the Product/Service ID
Qualifier field from being displayed on the
printout, because the more meaningful
description is printed instead.

PID group Product/Item The standard allows this group to be used up
Description to one thousand times for each line item. You
need this group to be used only once for each
line item, so you change the maximum use of
this group to one.
DTM segment | Date/Time The standard allows the date to be used up to
Reference ten times for each line item. You need two

separate DTM segments: one for the
requested ship date, and one for the ship no
later date (in that order). You promote this
segment to cause another iteration of this
segment to occur for each line item. Also,
because you know what types of dates you
receive (and in what order), you instruct the
system to use the key fields function to print
the requested ship date in one DTM segment
and the ship no later date in the other DTM
segment.
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(Contd)
Form
Component

Description

Customizing Needed

DTMO1
element

Date/Time Qualifier

You know that your partner sends you only
two types of dates: requested ship and ship no
later (in that order), so you use the key fields
function in both DTM segments to place the
appropriate date in the appropriate DTMO02
element. You do not need to load the code list
table for the DTMO1 element, because you
receive only one valid code for this field. You
hide this qualifier field.

DTMO02
element

Date

The date in the EDI data is in the format
“YYMMDD,” but you want the date to be
printed in the format “MM/DD/YY,” so you
set the format accordingly.

CTT segment

Transaction Totals

You want this segment to print the total
number of line items at the end of the
printout. However, if the form were
generated now, the total would be printed at
the beginning of the printout (because the
fields in the CTT segment are displayed on
the same frame as the fields in the BEG
segment). You change the arrangement of the
form, while maintaining the integrity of the
EDI data, so the total is printed at the end of
the purchase order.
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction The Forms Integration subsystem enables you to customize the global EDI date formats
(for all forms). You can specify the default EDI format of dates for both six-character
dates and eight-character dates. When you customize the global EDI date formats, the
settings are valid for all forms created in the current session of Gentran:Server. However,
you can override the default date formats for an individual element on the Element
Properties dialogue for that element.

You must verify that you are using the correct global date formats the first time you use
the Forms Integration subsystem. Typically, you verify the global EDI date formats one
time only. You can change the default date formats if they do not match the formats you
intend to use.

Procedure  Use this procedure to verify the global EDI date formats.

Step Action

1 Select Preferences from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Gentran:Server.

2 Verify that the Standard Formats tab displays the default date formats
that are used when elements are read from the standards database.

3 Verify that the Six-character dates list contains YYMMDD to define the
format of the six-character EDI dates in your forms.

4 Verify that the Eight character dates list contains YYYYMMDD to define
the format of the eight-character EDI dates in your forms.

5 Click OK to accept the default date formats for 6- and 8-character date
fields and exit the Preferences dialog.

Note

To change the order in which the date formats appear in the “Six-character
dates” and “Eight character dates” lists or to add a new date format to the
lists, select Date Formats from the Options menu.
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Creating a Print Form

Defining the Type of Form

Overview  The first task in creating a new form is to define the type of form and EDI standard,
version, and transaction set (document). In this tutorial, you are creating a print form so
that you can print the purchase orders that your partner sends you. Instead of defining the
850 message to the system yourself, you want Gentran:Server to use the standards
database on your system to build the purchase order according to the ANSI X12 standard.

Procedure  Use this procedure to create the new print form.

Step

Action

1

Select New from the File menu to display the New Form Wizard.

2

From the What kind of form list, select Print to indicate that the
translation object you are creating is a print translation object.

In the What is the name of the form box, enter Print 850 Pet Zone. This
description provides a brief explanation of the compiled translation object
that enables you to differentiate it from similar translation objects in
Gentran:Server.

Example
Print 850 Pet Zone is the description of a print translation object for an
ANSI X12 purchase order (850) for partner Pet Zone.

Verify that the name that appears in the What is your name box is
accurate.

Click Next to advance the wizard.

Select Delimited EDI as the data format syntax that you want to use.

Click Customize.

System Response
The system displays the New Delimited EDI Wizard.

Click Next to continue.

From the Data Source list, select Gentran Standards ODBC data source.

10

Click Next to continue.

11

From the Agency list in the Standards section, select [X] X12, which is
the EDI standard you will use for this translation object.
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(Contd)
Step Action

12 From the Version list, select [003040] ANSI X 12 VERSION 3
RELEASE 4, which is the version of the standard you use for this
translation object. The versions that are available depend on which
standard you selected.

13 From the Transaction list, select [850] PURCHASE ORDER, which is
the transaction set (document) you use for this translation object. The
documents that are available depend on which standard and version you

selected.
14 Click Next to continue.
15 Click Finish. This may take a few seconds.

System Response
The system displays the New Form Wizard dialog box.

16 Click Next to continue.
17 Click Finish to create the EDI file (it may take a few seconds to create the
file).

System Response
The form is displayed as follows:
R T - =]
|

File Edt Functions View Display Options Window Help
N E R EEEEE R E ) [
Z Print 850 Pet Zone

B850 - M - 1PURCHASE ORDER
[T BEG - M - 1BEGINNING SEGMENT FOR PURCHASE ORDER

(5 0300_PO1 - M - 100000
FEICTT M- 1 TRANSACTION TOTALS

< |

For Help, press F1

18 From the Edit menu, select Details.

System Response
The Translation Object Details box is displayed.

(Continued on next page)
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(Contd)
Step

Action

19

Verify that Print is selected from the Translation Object Function list.

20

In the Major version box, enter 1 to designate the version number for this
translation object.

21

In the Minor version box, accept the default value 0 that designates the
release number for this translation object.

Hint

When you make a major change to this form, increase the version to the
next higher sequential number (e.g., 2.0, 3.0). If you make a minor change
to the form, increase the release to the next higher sequential number (e.g.,
2.1,2.2).

22

The Input and Output boxes (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For this tutorial, do not change the information in
these boxes.

Note

The system allows you to change the information in the Input and Output
boxes, but modifying this information does not alter the content of the
form. An example of when you might want to alter these boxes is when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
alter the form to be compliant with that version.

23

Click OK to save the translation object details.

24

Select Save from the File menu.

Recommendation

We recommend that you save the form as often as possible, to mitigate the
possible loss of additions or modifications in the event of a hardware or
system error.

Note

If you have performed any function that invalidates the current format of
the translation object, the Save function is unavailable until you
regenerate the layout (Click Generate Layout on the Main Toolbar).

25

Verify that the Save in list reflects the drive\folder where Gentran:Server
is installed.

Default
The default drive\folder is GENSRVNT\Forms.

Gentran:Server for Windows — August 2008
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Defining the Type of Form

(Contd)
Step

Action

26

In the File name box, enter pet_850p.stp to replace the default file name.
You allocate a file name to a form when you save the form for the first
time or use the Save As function to save a copy of the form under a
different name. The name of the form must be one to eight unique
characters that define the form in a meaningful way. For example,
“PET_850P” is the name of a print form for an ANSI X12 purchase order
message (850) for partner Pet Zone.

Note

The default file extension for forms is .STP. Using this extension
distinguishes source form files from other types of files, such as compiled
translation objects. The naming conventions in Gentran:Server are as
follows:

» The source form (form created in Gentran:Server) should be named
using the file extension .STP (e.g., PET_850P.STP).

» The compiled translation object (translation object that is the result of
compiling the source form) should be named using the same file
name that was allocated to the source form, but with the file extension
.TPL (e.g., PET 850P.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source forms and compiled translation objects from other types of files.
We also recommend that you use the same file name (different file
extension) for a source form and the translation object that was compiled
from it.

27

Click Save to save the form.
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Activating Groups, Segments, and Elements

Overview

Example

Groups, segments,
composites, and
elements used in

this tutorial

When Gentran:Server generates the form, the system includes all the groups, segments,
and elements that are defined by the standard agency (ANSI) for the version (003040) of
the transaction set (850) you selected. The system activates all the groups, segments, and
elements that are defined as mandatory (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, and elements.

In the example below, the 850 PURCHASE ORDER file icon and BEG segment are
mandatory for the purchase order. You do not need to activate these components. TheE,
CUR, and REF segments are not mandatory, so they are dimmed on the form. To view the
segments and elements in a group or segment on your form, double-click the form
component in the EDI File Format Window (left side of the Forms main window). To
activate an inactive form component, click Activate on the Main Toolbar, then click the
form component. The component is no longer dimmed.

B850 - M - 1 PLURCHASE ORDER
CIEBEG -t - 1 BEGINNING SEGMENT FOR PURCHASE ORDER
O
O
O

This table lists the groups, segments, composites, and elements to be used in this tutorial.

Group Group Segment Element
NTE
REF REF02
ITD ITDO1
ITD12
N1 N1 N102
N3 N302
N4 N401
N402
N403
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Activating Groups, Segments, and Elements

Group Group Segment Element

PO1

PO1 PO101

(already activated) PO102

PO103

PO104

PO106

PO107

PID PID:2 PID:205

DTM:2 DTM:202

Procedure Use this procedure to activate the required groups, segments, and elements.

IMPORTANT

YOU MUST ACTIVATE ALL REQUIRED GROUPS, SEGMENTS,
COMPOSITES, AND ELEMENTS LISTED ON THE FOLLOWING
TABLE. FAILURE TO DO SO WILL HINDER YOUR ABILITY TO
PERFORM STEPS LATER IN THIS TUTORIAL.

Step

Action

1

Double-click the segments and groups listed in the previous table to open
them. The table lists all the groups, segments, and elements that you need
to activate. Opening all the necessary groups and segments before you
start to activate enables you to scroll down the form and activate the
groups, segments, and elements sequentially.

Note
When you activate a conditional group or segment, the mandatory
subordinate segments and elements are activated automatically.

Click Activate on the Main Toolbar.

Click each inactive group that you need to use. Clicking these groups
activates the groups.

Note

If you accidentally click a group, segment, or element that you did not
mean to activate, click the component with the right mouse button to
access the shortcut menu. Select Deactivate from the shortcut menu.

Click each inactive segment that you need to use. Clicking these segments
activates the segments.
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Step

Action

Click each inactive element that you need to use. Clicking these elements
activates the elements. When you activate an element in a print form, the
tag “Printed” is displayed before that element’s description to indicate that
this field is printed. If you later prevent a field from being displayed on
the printout, then the tag “Not Printed” is displayed before that element’s
description.

Click Activate on the Main Toolbar to turn activation mode off.

To hide the groups, segments, and elements that you are not using, select
Show Active Only from the View menu.

Gentran:Server for Windows — August 2008
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Verifying EDI Delimiters

Verifying EDI Delimiters

Overview  Ifyou are using an EDI standard that contains composite elements or subelements, you
must verify that Gentran:Server is specifying the correct delimiters. Delimiters are flags
that you define to the system as separating specific EDI components. Delimiters are
necessary for all variable field-length standards, because the data is compressed (and the
leading zeroes and trailing blanks are removed). The fields vary in length, so the system
needs a flag to determine where one element ends and another begins. For example, an
element delimiter marks the beginning of a new element.

Recommendation
Although setting EDI delimiters in Gentran:Server is mandatory on/y if you are using a
standard with composite elements or subelements, we recommend that you perform this
task regardless of which standard you use.

EDI delimiters This table lists the valid EDI delimiters.

table
ANSI X12 Default ANSI X12 Default Hex
Field Character Value

Tag Delimiter

Segment Delimiter ~ (tilde) 0x7E

Element Delimiter * (asterisk) 0x2A

Sub Element Delimiter : (colon) 0x3A

Decimal Separator

Release Character

Procedure  Use this procedure to verify EDI delimiters.

Step

Action

1

to access the shortcut menu.

Click the 850 PURCHASE ORDER file icon with the right mouse button
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(Contd)
Step Action
2 Select Properties from the shortcut menu to display the File Format
Properties dialog.
File Format Properties E3
N ame | Delimitersl Loop Extended Hulesl
Pleaze enter the name :
tetall
Fleaze enter a short description :
FURCHASE ORDER
QK I Cancel Sppi Help
3 Select the Delimiters tag to access the Delimiters dialog.

File Format Properties E3

Mame  Delimiters | Loop Extended Hulesl

Tag Delimiter I Sub Element Delimiter Ii
Seqgment Delimiter I" Decimal Separatar I
Element Delimiter I“ Releaze Character I

QK I Cancel Sppi Help
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(Contd)
Step Action

4 Verify that the correct delimiters are being used for the ANSI X12
standard. If the delimiters differ from the default values listed in the
previous table, you can enter either the character or the hexadecimal value
in the correct box. The default delimiters for ANSI X12 are the following
(the tag delimiter, release character, and decimal separator are not used for
ANSI):

Note
If you use the default hex value, the value must begin with “0x” (the
number zero and the letter “x”).

Reference
See the EDI delimiters table on page 2 - 23 for a list of valid EDI
delimiters.

5 Click OK to save the delimiters and exit the dialog.

Note

The Stream segments check box on the Delimiters dialog currently is not selected. For this
tutorial, leave it cleared so that the translator will continue to insert a carriage return after
every segment.
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Modify Form Components

Promoting and Changing Segments and Groups

Introduction

Changing the
maximum use

The Promote function extracts one iteration (instance) of a group or repeating segment.
Promote is a specialized function that preserves the integrity of the EDI structure.

By default, the fields corresponding to each group and repeating segment are displayed on
a separate frame from the rest of the fields in the document. When you promote a group to
the parent frame, the fields corresponding to the group are displayed on the frame to which
the group is subordinate. If you do not promote a group to the parent frame, the fields
corresponding to the group are displayed on their own frame.

Changing the maximum use of a segment or group changes the maximum number of times
the segment or group can be used. A segment or group with a maximum use greater than
one repeats (loops), and is placed on a separate frame than the segment or group to which
it is subordinate. A segment or group with a maximum use of one does not repeat, and its
fields are displayed on the same frame as the group or segment to which they are
subordinate.
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Modifying the Maximum Use of the REF Segment

Overview  The REF segment contains Reference Numbers (for example, a contract number) used in
the EDI data. The standard allows the REF segment to be used up to twelve times in one
purchase order. In this tutorial, you expect the REF segment only once from your trading
partner, so you change the maximum number of times this segment can be used to one.

Procedure  Use this procedure to change the maximum use of the REF segment.

Step Action

1 Click the REF segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

EDI Segment Properties E3

Mame |S|:|ecia|| Ky FieIdI Frint I Lnnpingl Loop Extended Hulesl

Flease enter the name
RE

Pleaze enter a short description :
REFEREMNCE MUMBERS

QK. I Cancel Lpply Help

2 Select the Looping tab.

3 In the Max Usage box, enter 1 to indicate that this segment can be used
only once.

4 Click OK to exit the EDI Segment Properties dialog.
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Inserting a New N4 Group

Overview

How to add a
group

The N4 segment (in the N1 group) contains the Geographic Location of the entity or
individual named in the N1 segment. If the form were generated now (displaying the
layout of the fields in the form on the right side of the Forms main window), the fields
associated with the N4 segment would be located on the same frame as the fields
associated with the N1 segment. (In a print form, each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that level.)
The name would be printed, then the city, state (or province), and postal code would be
printed, and then the street address would be printed. This print sequence would not
format the address in a standard address format.

To ensure that the city, state (or province), and postal code are printed afer the street
address, and to maintain the integrity of the purchase order, you must create an N4 group
with a minimum use of zero and a maximum use of one, then cut the N4 segment and
paste it as a subordinate to the group you just created. Making the N4 segment subordinate
to the N4 group enables you to retain the N3 segment’s maximum use of two, and use the
standard address format. The fields associated with the N4 segment (city, state, and postal
code) are displayed on a separate frame, which is printed affer the street address.

Use this procedure to add a new N4 group.

Step Action

1 Select the N3 segment, which is the segment after which you want to
insert the group.

2 Select Insert from the Edit menu.
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Inserting a New N4 Group

(Contd)
Step

Action

3

Select Group from the submenu.

System Response
The Group Properties dialog is displayed.

Group Properties E2

Marme |F'rint I Loopingl Loop Extended Hulesl

Please enter the name ;

Fleaze enter a zhort description :

ak I Cancel Sl | Help |

In the Name box, enter NEW_N4 as the segment loop identification code.

Important
Do not use spaces or hyphens (-) in the Name box. You can use the
underscore (_) to separate words.

In the Description box, enter NEW N4 to provide a brief explanation of
the loop.

Click OK to create the group.

How to cut and  Use this procedure to cut and paste the N4 segment.

Action

Select the N4 segment.

Click Cut on the Main Toolbar.

Click Yes at the prompt.

paste the N4
segment Step
1
2
3
4

Select the NEW_N4 group, which is the group for which you want to
paste the N4 segment as a subordinate.
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Creating a Print Form

Step

Action

Click Paste on the Main Toolbar to paste the N4 segment.

At the prompt, accept the default to paste the Clipboard contents as a child
(subordinate) of the group and click OK to exit the dialog.

Gentran:Server for Windows — August 2008
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Modifying the Maximum Use of the PID Group

Modifying the Maximum Use of the PID Group

Overview  If the form were generated now, the fields associated with the PID group (in the PO1
group) would be displayed on a separate frame than the PO1 fields. The PID and PO1
fields all relate to the same set of purchase order items, so all those fields need to be
displayed on the same frame. You change the maximum use of the PID group from one
thousand to one and set the Promote flag on the group. When you generate the form later
in this tutorial, the PID fields are displayed on the same frame as the PO1 fields.

Procedure  Use this procedure to change the maximum use of the PID group.

Step Action
1 Click the PID group with the right mouse button and Select Properties
from the shortcut menu.
System Response
The Group Properties dialog is displayed.
Ky Fingmaluz
N -
Ines: I Lo
Leea Zencd Iﬂl
M- Ui Ll -
G :
Al ey
T =i goep o saer . i
Fir—r 'a'r| n |
alann |
Fir=r 4= Tra | bt Hiln T e
| f
=T (== 8
2 Select the Looping tab.
3 In the Max Usage box, enter 1 to indicate that this group can be used only
once.
4 Select the Print tab.
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(Contd)
Step

Action

5

Click the Promote group to parent frame check box to display the fields
in the PID group on the same frame as the fields in the parent group (PO1

group).

Note

If you change the maximum use of this group, but do not check the
“Promote group to parent frame” check box, then the fields in this group
are not displayed on the same frame in the Layout Window as the fields in
the parent group.

Click OK to promote the group and exit the Group Properties dialog.
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Promoting the DTM:2 Segment

Overview  Ifthe form were generated now, the date in the DTM:2 segment (in the PO1 group) for the
line item information would be printed on a separate frame than the rest of the line item
fields. You want the date to be placed on the same frame as the rest of the line item
information, so you promote the DTM:2 segment. Your trading partner sends you two sets
of dates: the requested date and the ship date (in this order). The DTM:2 segment must
occur twice in the form to accommodate both sets of dates from your trading partner. To
customize the DTM:2 segment while preserving the integrity of the EDI structure, you
promote the DTM:2 segment, then change the maximum use of the original DTM:2
segment to one so that it is no longer a repeating segment.

How to promote  Use this procedure to promote the DTM:2 segment.

the segment
Step Action

1 Click the DTM:2 segment with the right mouse button to access the
shortcut menu.

2 Select Promote from the shortcut menu to extract one iteration of the
DTM:2 segment and place it directly above the DTM:2 segment that you
selected to promote.

System Response
The new iteration of the DTM:2 segment is named DTM:4.
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How to make the  Use this procedure to make the DTM:4 segment conditional.

DTM:4 segment

conditional Note

When you promote a segment, the new segment is defined as mandatory (with a minimum
use of one). If you want to make the segment conditional, you must change the minimum
use to zero.

Step Action

1 Click the DTM:4 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

EDI Segment Properties E3
Mame |S|:|ecia|| Ky FieIdI Frint I Lnnpingl

Flease enter the name :
|DTM:4

Pleaze enter a short description :
DATE/TIME REFERENCE

QK I Cancel S Help

2 Select the Looping tab.

3 In the Min Usage box, enter 0 to make this segment conditional.

4 Click OK to exit the EDI Segment Properties dialog.
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How to change the  Use this procedure to change the maximum use of the DTM:2 segment.
maximum use of

the DTM:2 Step Action

segment
g 1 Click the DTM:2 segment with the right mouse button and select

Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

EDI Segment Properties

Name |Specia|| ey FieIdI Print I Loopingl Loop Extended Hulesl

Please enter the name ;
IDTM:2

Fleaze enter a zhort description :
CATE/TIME REFEREMCE

ak I Cancel Sl Help

2 Select the Looping tab.
3 In the Max Usage box, enter 1 to allow this segment to be used only once.
4 Click OK to exit the EDI Segment Properties dialog.
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Creating a CTT Group

How to create the

Creating a Print Form

Overview  The CTT segment is a mandatory segment that can display Transaction Totals for the
purchase order. If the form were generated now, the total number of line items would be
printed with the BEG fields at the beginning of the printout (because the fields in the CTT
segment are displayed on the same frame as the fields in the BEG segment). For the CTT
segment to print the total number of line items at the end of the printout and maintain the
integrity of the purchase order, you must create a CTT group with a minimum use and a
maximum use of one, then cut the CTT segment and paste it as a subordinate to the group
you just created. By moving the CTT segment to a new CTT group that you create, the
total number of line items are displayed on a frame that is separate from the header (BEG)

information.

Use this procedure to create a CTT group.

CTT group

Step

Action

1

Select the CTT segment.

2

Select Insert from the Edit menu.

Select Group from the submenu.

System Response

The Group Properties dialog is displayed.

Group Properties E

Mame |F'rint I Loopingl Loop Extended Hulesl

Fleasze enter the name :

Please enter a short deszcription

QK. I Cancel

Eppli

Help
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Creating a CTT Group

(Contd)
Step

Action

4

In the Name box, enter CTT_Group as the segment loop identification
code.

Important
Do not use spaces or hyphens (-) in the Name box. You can use the
underscore (_) to separate words.

In the Description box, enter CTT Group as the segment loop
identification code.

Select the Looping tab.

In the Min Usage box, enter 1 to make this group mandatory.

Note

Changing the minimum use of a segment or group from zero to one
changes the status of the segment or group from conditional to mandatory.
If EDI data is not present for a segment or group that has a minimum use
of one or greater, a compliance error occurs during translation for that
segment or group.

Click OK to create the group.
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Creating a Print Form

How to cut and  Use this procedure to cut and paste the CTT segment.

paste the CTT

segment Step

Action

1

Select the CTT segment.

2

Click Cut on the Main Toolbar.

Select the CTT group, which is the group for which you want to paste the
CTT segment as a subordinate.

Click Paste on the Main Toolbar to paste the CTT segment.

System Response

Gentran:Server prompts you to specify whether you want the contents of
the Clipboard pasted as a child (subordinate) of the selected group, or at
the same level as the group.

GEMTRAMN:Forms Integration E
The contents of the clipboard can be pazted az follows:

9 Pasgte Options Cancel |

¥ Paste az a child of selected itent

" Paste after selected item [at the same level]

The Paste as a child of selected item option is selected as the default.
Accept the default to paste the Clipboard contents as a child (subordinate)
of the group. Click OK to exit the dialog.
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Generating the Form

Overview

Generating the Form

Generating a form is different from compiling a form. When you compile a form, the

source form is translated into a compiled translation object. When you generate a form,
the fields of the form are displayed on a frame in the Layout Window (right side of Forms
main window), based on the groups, segments, and elements that are activated.

Procedure

Note

Use this procedure to generate the print form based on the groups, segments, and elements
you activated.

You should regenerate the form periodically as you customize the print form to ensure that
the most recent changes to the frame are reflected in the Layout Window.

Step

Action

Select the 850 PURCHASE ORDER file icon. Selecting the 850
PURCHASE ORDER file icon before you generate the layout enables you
to view the beginning of the purchase order layout in the Layout Window
after the layout is generated. However, selecting the 850 PURCHASE
ORDER file icon is not a required prerequisite to generating the layout.

Click Generate Layout on the Main Toolbar.

System Response
The layout of the print form is displayed in the Layout Window.

[ % Gentran Forms Integration lpet 850pstp) _________ HEH|
% File Edit Functions Yiew Display Options Window Help -|& ﬂ
o =2 = o e = S S =T
= o = = —

- 1PLU i
BEG -M - 1 BEGINNING SEGMENT FOR PURCHASE ORDER
E" 010353 - M - String 2 -Printed- TRAMSACTION SET FURPOSE CI

Transaction Set Purpose Code |:|
@ 020092 - M - Sting 2 -Printed- PURCHASE ORDER TYPE CODE

# 030324 - M - Stiing 22 -Printed- PURCHASE ORDER NUMBER
® 050323 -M - Dt/Tm 6 Frinted- FURCHASE ORDER DATE
FOIMTE - - 100 NOTE/SPECIAL INSTRUCTION :
L # 020003 - M - String 50 -Printed- FREE FORM MESSAGE
FCIREF - C- 1 REFERENCE NUMBERS
|:- 010128 - M - Stiing 2 Frinted- REFERENCE NUMBER QUALIFIEF
# 020127 - C - String 30 Frinted- REFERENCE NUMEER
HOIITD - € - 5 TERMS OF SALE/DEFERRED TERMS OF SALE
|:- 01033 - C - String 2 -Prinked- TEAMS TYPE CODE
1203526 - C - Sting 80 Piinled- DESCRIPTION B
6 0200N1 -C - 200
FOON1-C - 1 NaME B
|: @ 01 0098 - M - Shiing 2 -Printed- ENTITY IDENTIFIER CODE
® 02 0093 - C - Shiing 35 Piinled- NAME
HON3-C - 2 ADDRESS INFORMATION i
|: B 01 0166 - M - String 35 Printed- ADDRESS INFORMATION
® 02 D18E:2 - C - Sting 35 -Printed- ADDRESS INFORMATION | |&
L6 NEW N4 -C- 1 NEW N4
L4 - - 1 GEOGRAPHIC LOCATION
HE 0300_POT - M - 100000
HTIPO1-C - 1BASELINE ITEM DATA
® 01 0350 - C - String 11 Printed- ASSIGNED IDENTIFICATION
# 020330- C - Real 9 Printsd- QUANTITY ORDERED
® 03 0355 - C - Shing 2 -Printed- UNIT OFt BASIS FOR MEASURI
® 040212-C-Real 14 Frinted- UNIT PRICE =
4 »

Purchase Order Type Code D

Purchase Crder Nuwber
Purchase Order Date l:l

Reference Number Qualifier D

Reference Nuwher

| o

[

For Help, press F1
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After generating
the form

After you generate the form, there is one field on the right side of your screen (Layout
Window) for every activated element on the left side of your screen (EDI File Format
Window). You can click either the field or its corresponding element to select it. To access
the Element Properties dialogue for a field/element, either double-click the element, or use
the right mouse button to click the field or element, then select Properties from the
shortcut menu.

Note

When you first generate the form, each field in the Layout Window is labeled with the
same name as its corresponding element in the EDI File Format Window. As you
customize the form, however, you change some of the labels and remove others, so all the
fields are not labeled the same as their corresponding elements. Even though you change
or remove some field labels, each field still corresponds to one element.

When the print form is generated, each group and repeating segment has a corresponding
frame in the Layout Window that contains all the groups, segments, and elements at that
level. Fields in groups or segments that have a maximum use of only one are displayed on
the frame corresponding to the group to which the groups or segments are subordinate. For
example, the Transaction Set Purpose Code (BEGO1), Purchase Order Type Code
(BEGO02), Purchase Order Number (BEGO03), Purchase Order Date (BEGO5), Reference
Number Qualifier (REF01), and Reference Number (REF(02) are displayed on one frame
(all the groups and segments in which these fields are contained are subordinate to the
same group).

In print forms, the frames are not titled in the Layout Window (as they are in screen entry
forms). To identify the frame that currently is displayed, click one of the fields on the
frame, then check the EDI File Format Window to determine in which segment or group
the field is contained.
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Overview

Customize the EDI Data

Overview

Introduction

How to set up the
document name

You can customize the form, including the properties of each type of form component
(group, segment, and element).

Customizing the form is an iterative process. This tutorial guides you through all the steps
involved in customizing the form, component by component. When you create print
forms, you usually activate the form components you need to use, then compile the form,
test it, and print the EDI data using the compiled translation object. As you substantially
customize the form, you usually compile and print the form several times to view your
changes before the form truly is finalized.

This section explains how to customize the form components for each sequential
component.

We recommend that you set up a Document Name for each form. The document name
makes the identification of a document created by the form easier in Gentran:Server.
Setting up the document name enables you to differentiate between documents in the
document browsers in Gentran:Server. If you set up the document name in the Forms
Integration subsystem, the Name field of the document browsers that contain this
document in Gentran:Server contains the data from that element. You can choose any
element as the document name, but we strongly recommend that you select an element
that occurs only once in the document and has a data type of string. For an ANSI X12 850
purchase order, the document name usually is the Purchase Order Number.

Use this procedure to set up the document name.

Step Action

1 Double-click the BEG03 element.

Recommendation
We recommend that you select this element because it is a non-recurring,
mandatory element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.
3 Select the Update from the Please select a standard rule to use list.
4 Click Yes at the prompt.
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(Contd)
Step Action

5 From the Select the table (or group) to update list, select Document
record to indicate that you are updating the document record.

6 From the Column (or field) to update list, select Document Name to
indicate that you are updating the Name field in the document browsers
with the contents of the BEG03 element.

System Response

The dialog now should look like this:

Element Properties E2
Mamie I Validationl Fririt I Extended Rule  Standard Rule | Cnndilionsl
Fleaze zelect the standard rule to use : IUpdate ﬂ
Flzaze zelect the table [or group] to update :
ID-:u::umenl record ﬂ
Fleaze zelect the column [or field) o update
ok I Cancel el Help
7 Click OK to set up the document name.
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Customizing the BEG Segment

Overview

How to customize
the BEG01
element

How to customize
the BEG02
element

The BEG segment contains the Beginning Segment for the purchase order. This segment
uses four mandatory elements: Transaction Set Purpose Code, Purchase Order Type Code,
Purchase Order Number, and Purchase Order Date. Each of these elements contains
information that is pertinent to the entire purchase order.

The BEGO1 element (Transaction Set Purpose Code) is a mandatory element for the ANSI
X12 850 purchase order. You do not need to print the code on the printout, so you prevent
(hide) the Transaction Set Purpose Code field from being printed.

Use this procedure to prevent the Transaction Set Purpose Code field from being printed.

Step Action

1 Double-click the BEGO01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include in print check box to turn the option off.
4 Click OK to exit the dialog.

The BEGO02 element (Purchase Order Type Code) also is a mandatory element for the
ANSI X12 850 purchase order. This element contains the two-character code from your
partner’s EDI data representing the type of purchase order (e.g., new order, order change,
etc.) for this document. You want the more meaningful description of the code to be
printed on the printout, instead of the code itself. Therefore, you hide the Purchase Order
Type Code field, but use the code from that element (BEG02) to look up the code
description in the Purchase Order Type Code table and print that description in another
field that you create. The description of the code is displayed in the new field on the
printout. Also, you rename the new field.

For this tutorial, you and your trading partner have agreed that they send you these two
types of purchase orders:

» New orders (Purchase Order Type Code “NE”)
» Purchase order changes (Purchase Order Type Code “CP”)
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How to copy the
BEGO02 element

How to change the
BEG09 element
and field
properties

The description of the EDI code in the BEG02 element is important, even though you do
not need to print the code itself. For example, the EDI code value “NE” is not descriptive
enough for users reading a printout of the purchase order. The description of code “NE”
(“New Order”) is meaningful, however.

Before you can print the description of the EDI code value, you must create a new element
in the BEG segment to store and print the description. The new BEG element is the
element that displays the description of the Purchase Order Type Code. You use the Copy
and Paste functions to move EDI information in the form. Copied form components retain
all the information of the original form components.

Complete the following steps to copy and paste the BEG02 element.

Step Action
1 Select the BEG02 element.
2 Click Copy on the Main Toolbar.
3 Select the BEGO08 element, which is the last element in the BEG segment.

The BEGOS element is the element after which you want the BEG02
element to be pasted.

4 Click Paste on the Main Toolbar to paste the BEG02 element.

System Response
A new element (BEGO09) is created. The BEG09 element is an exact copy
of the BEGO02 element.

The system names the new element created from copying the BEG02 element 0092:2. You
rename the new element to identify its purpose, which is to print the description of the
code from the BEG02 element.

You remove the Mandatory status from the BEG09 element to make it a conditional
element (this element is used only if there is EDI data available for it), and increase its
length to accommodate the longer description.

Also, you need to change the field label corresponding to the newly-created BEG09
element to reflect the contents of the field (the description of the Purchase Order Type
Code). Also, you increase the display length of the field to accommodate the longer
description.
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How to change the Use this procedure to change the element name and length, make the element conditional,
BEGO09 element and change the field label and field length for the BEG09 element.5.
and field

(contd) 1 Double-click the BEG09 element.

System Response
The Element Properties dialog is displayed.

2 In the Name box, enter 0092_DESC to give the name a more descriptive
identifier than its current name.

3 Select the Validation tab.
4 Click the Mandatory check box to make the element conditional.
5 In the Min box, enter 0 for the minimum number of characters allowed for

this element.

6 In the Max box, enter 30 for the maximum number of characters allowed
for this element.

7 Click the Print tab.
8 In the Label box, enter Order Type: to replace the existing field label.
9 In the Maximum number of characters to print box, enter 30 to allow a

thirty-character description to be displayed on the printout.

10 Click OK to save the new label and exit the dialog.

How to hide the = Now that you have created an exact copy of the BEG02 element to retain all of the EDI
BEGO02 Field and data and formatting associated with that element, you can hide the first Purchase Order
load a code list ~ Type Code field.
table from the

standard When you use code list tables, you load a code list table from the standard to tell the

system which code list table to use in looking up EDI code values. You can load the
specific code values you expect to receive in the EDI data, or you can load the entire code
list table. For this tutorial, you know that your trading partner sends you only two types of
purchase orders:

» New orders (Purchase Order Type Code “NE”)
» Purchase order changes (Purchase Order Type Code “CP”)

You do not need to load the entire code list table, so you load only codes “NE” and “CP”
from the Purchase Order Code List table.
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How to hide the  Use this procedure to hide the Purchase Order Type Code field and load the code list table
BEGO02 Field and from the standard.

load a code list

table from the

standard

(contd)

Step Action

1 Double-click the BEG02 element. You need to use a code list table for
this element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Include in print check box to turn the option off.

4 Select the Standard Rule tab.

5 Click the Use Code option from the Please select a standard rule to use
list.

6 Click Yes at the prompt.

7 Click Edit to access the Edit Code List dialog.

Edit Code List

— Table Details
TablelD [0052 Dess |PURCHASE ORDER TYFE CUDE D
—&llowed Codes Cancel
Code W alue Drescription

MHew

Change...
Delete

Load...

el il

The Table ID box contains 0092, the name of the element for which this
code list table is used. The Desc box contains PURCHASE ORDER
TYPE CODE, the description of the element for which this code list table
is used.
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Customizing the BEG Segment

(Contd)
Step

Action

8

Click Load to access the Load Code List dialog. The Codes In Standard
list contains the entire code list table. you are prompted to select an ODBC

data source name. Select the appropriate DSN and click OK to access the
Load Code List dialog.

Load Code List
~ Select Code Source
Standard [700504070 ]} st foosz v
Cancel |
-~ Select Codes
Codes In Standard Codes Selected

AR ASSORTMENT AGH
AC AOG [AIRCRAFT O

A0 A0G [AIRCRAFT OF Ll

ED BIDDING
BE BL&MNKET ORDER/ Add &l - |
BE. BL&NKET ORDER |

BL  BAILMENT .
Bﬂ EUDGETARY DLEI'LI ﬂl
4 [ 3

KN il

From the Codes In Standard list, highlight code CP.

10

Click Add to move it to the Codes Selected list.

11

From the Codes In Standard list, highlight code NE.

12

Click Add to move it to the Codes Selected list.

13

Click OK to load the code list table and exit the Load Code List dialog.

14

Click Close to exit the Edit Code List dialog.
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(Contd)
Step Action

15 From the Store Field list, select 0092_DESC PURCHASE ORDER
TYPE CODE to store the description in the BEG09 element you created.

The dialog now should look like this:
Element Properties

Mame I Validationl Print I Extended Rule  Standard Rule | Cnnditionsl

Fleasze select the standard rule to uge : IUse Code j

Flease select the code list bo uge :

[0032 PURCHASE ORDER TYPE CODE -] Ea |

[" Raize a compliance eror if the code is not found in the list

If pou would like the deszcription of the code to be stored in a field, please
zelact that field below :

0092 DESC PURCHASE ORDER TYFE CODE

ak I Cancel Sl Help

16 Click OK to exit the dialog.

How to customize The BEGO03 element is a mandatory element that contains the Purchase Order Number.
the BEGO03 This element is defined by the standard to be a string of twenty-two alphanumeric
element  characters. Your trading partner’s purchase order number is always a ten-character
alphanumeric string, so you change the element and field lengths to accommodate the
shorter purchase order number. In addition, you rename the field label.

Use this procedure to change the field and element lengths, as well as the field label, for
the Purchase Order Number field.

Step Action

1 Double-click the BEG03 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 to allow a ten-character string in this element.
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Step Action
4 Select the Print tab. .
5 In the Label box, enter Order Number: to replace the existing field label.
6 In the Maximum number of characters to be printed box, enter 10 to allow
a ten-character purchase order number to be displayed on the printout.
7 Click OK to exit the dialog.

How to customize The BEGOS5 element is a mandatory element in the header (BEG) segment of the purchase
the BEGO05 order that contains the Purchase Order Date. The EDI data from your trading partner is
element formatted as YYMMDD, but you want to format the date as MM/DD/YY on the printout.
In addition, you rename the field label.

Use this procedure to change the date format and the field label for the Purchase Order

Date field.
Step Action

1 Double-click the BEG0S element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 From the Form Format list, select MM/DD/YY to designate the format for
the date on the printout.

5 Verify that YYMMDD is selected in the File Format list to designate the
format for the date in the EDI data.

6 Select the Print tab.

7 In the Label box, enter Order Date: to replace the existing field label.

8 In the Maximum number of characters box, enter 8 to allow the entire
date, including separators (/), to be displayed.

9 Click OK to exit the dialog.
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(Contd)
Step

Action

10

Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

System Response
The purchase order frame now should look like this

[

Crder Nuster: |

Crdsr Date :l

PFrfmrmnce bhmber Qumlifier D

Reference hmbec |

Crder Type=: |
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Customizing the NTE Segment

Customizing the NTE Segment

Overview  Your trading partner sends you messages or notes after the purchase order header
information, so the NTE segment should be present to receive each message. The standard
allows the NTE segment to be used up to one hundred times in one purchase order.

How to customize The NTEO2 element is a mandatory element that contains the exact message that should
the NTEOQ2 element be printed. Because the message is self-explanatory, you do not need to print the label for
this field. The only customizing that is necessary for the NTE02 element is to remove the
field label from the form.

Use this procedure to hide the Free Form Message field label.

Step

Action

1

Double-click the NTE02 element.

System Response
The Element Properties dialog is displayed.

Select the Print tab.

In the Label box, delete the existing field label.

Click OK to exit the dialog.
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(Contd)
Step

Action

5

Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

System Response
The Note (NTE) frame now should like this:
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Customizing the REF Segment

Customizing the REF Segment

Overview

How to customize
the REF01 element

The REF segment contains Reference Numbers used in the EDI data. In this tutorial, you
know that the only reference number your partner sends you in the REF segment is a
contract number that your trading partner uses for their records. Although the standard
allows the REF segment to be used up to twelve times in one purchase order, you expect
the REF segment only once from your trading partner. You already changed the maximum
use of this segment to one.

The REFO01 element (Reference Number Qualifier) is a mandatory element for the REF
segment. The REF01 element contains the two-character code from your partner’s EDI
data to indicate what type of reference number follows. For this tutorial, you know that
your trading partner sends you only one type of reference number—the contract number
(“CN”). The system does not enable you to deactivate this element, because it is a
mandatory element. However, since you expect only one code in this element, you do not
need to print the code on the report. Therefore, you hide the Reference Number Qualifier
field.

Use this procedure to hide the Reference Number Qualifier field.

Step Action

1 Double-click the REF01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include in print check box to turn the option off.
4 Click OK to exit the dialog.
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Customizing the REF Segment

Creating a Print Form

The REF02 element is a mandatory element that contains the Reference Number. This
element is defined by the standard to be a string of thirty alphanumeric characters. In this

tutorial, you know that your trading partner’s reference number (the contract number) is
always a twelve-character alphanumeric string, so you change the field and element
lengths to accommodate the reference number that is shorter than the standard allows. In
addition, you rename the field label.

Use this procedure to change the field and element lengths, and to change the field label,
for the Reference Number field.

Step

Action

1

Double-click the REF02 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 12 to allow a twelve-character string in this element.

Select the Print tab.

In the Label box, enter Contract No. (note the period in the label) to
replace the existing field label.

In the Maximum number of characters box, enter 12 to allow twelve
characters to be displayed on the printout.

Click OK to exit the dialog.
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(Contd)
Step

Action

8

Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

System Response
The purchase order frame now should look like this:

re

Order MNuwber: |

Order Date: [::::]

Order Type: |

Contract No. |
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Customizing the ITD Segment

Overview  The ITD segment is a conditional segment that specifies the Terms of Sale/Deferred Terms
of Sale for the purchase order. In this tutorial, you already activated the ITDO1 and ITD12
elements for the Terms Type Code and Description, respectively. The standard specifies
that the ITD segment can be used up to five times in one purchase order. Since this is a
conditional segment, if the ITD segment is not used at all in a purchase order (data is not
present), the fields are not printed.

The ITD12 element contains the terms of the purchase order. The description of the code
in the ITDO1 element explains the data in the ITD12 element, so you hide the field label
for the ITD12 element.

Customizing the  The ITDO1 element contains the Terms Type Code, a two-character code that identifies the
ITDO1 element terms under which this purchase order is valid. The code itself is not meaningful for a
printout, so you hide the ITDO1 element and print the description of the code in a new
element that you create.

For this tutorial, you know that your trading partner sends you purchase orders with only
these terms:

» Previously agreed upon (Terms Type Code “14”)
» Payment due upon (Terms Type Code “237)

To print the description of an EDI code value, you must copy the ITDO1 element to a new
element in the ITD segment, then use the new ITD element to print the description of the
Terms Type Code.

How to copy the  Use this procedure to copy and paste the ITDO1 element.
ITDO01 element

Step Action
1 Select the ITD01 element.
2 Click Copy on the Main Toolbar.
3 Select the ITD15 element, which is the last element in the ITD segment.

The ITD15 element is the element after which you want the copied
element to be pasted.

4 Click Paste on the Main Toolbar to paste the new element. A new element
(ITD16) is created, which is an exact copy of the ITDO1 element.

How to change the The system names the new element created from copying the ITDO1 element 0336:3. You
ITD16 element and rename the new element to identify its purpose, which is to print the description of the

field properties
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How to hide the
ITDO1 field and
load the code list
table from the
standard

Customizing the ITD Segment

code from the ITDO1 element. Also, you increase the element and field lengths to
accommodate the longer description.

Use this procedure to change the element name and length and change the field label and
length for the ITD16 element.

Step Action

1 Double-click the ITD16 element.

System Response
The Element Properties dialog is displayed.

2 In the Name box, enter 0336_DESC to give the name a more descriptive
identifier than its current name.

3 Select the Validation tab.

4 In the Min box, enter 0 for the minimum number of characters allowed for
this element.

5 In the Max box, enter 30 for the maximum number of characters allowed
for this element.

6 Select the Print tab.

7 In the Label box, delete the existing field label. The description of the
terms type code is self-explanatory and does not require a label.

8 In the Maximum number of characters box, enter 30 to allow thirty
characters to be displayed on the printout.

9 Click OK to exit the dialog.

Now that you have created an exact copy of the ITD01 element to retain all of the EDI
data and formatting associated with that element, you can hide the first Terms Type Code
field.

For this tutorial, you know that your trading partner sends you purchase orders with these
two term types:

» Previously agreed upon (Terms Type Code “14”)
» Payment due upon (Terms Type Code “237)

You do not need to load the entire code list table, so you load only codes “14” and “23”
from the Terms Type Code list table.
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ITDO1 field and
load the code list
table from the
standard

(contd)

Creating a Print Form

Use this procedure to hide the first Terms Type Code field and load the code list table from

the standard.

Step Action
1 Double-click the ITDO01 element. You need to use a code list table for this
element.
System Response
The Element Properties dialog is displayed.
2 Select the Print tab.
3 Clear the Include in print check box to turn the option off.
4 Select the Standard Rule tab.
5 Click the Use Code option.
6 Click Yes at the prompt.
7 Click Edit to access the Edit Code List dialog.
Edit Code List
T able Details
Table ID |n:335 Desc |TERMS TYPE CODE
-~ Allowed Cade Carcel |
Code Walue Description
Mew...
Chanae... |
Delete |
Load... |
Note
The Table ID box contains 0336, the name of the element for which this
code list table is used. The Desc box contains TERMS TYPE CODE, the
description of the element for which this code list table is used.
8 Click Load to access the Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to access the Load Code List dialog. The Codes In Standard list
contains the entire code list table.
9 From the Codes In Standard list, highlight code 14.
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(Contd)
Step

Action

10

Click Add to move it to the Codes Selected list.

11

From the Codes In Standard list, highlight code 23.

12

Click Add to move it to the Codes Selected list.

13

Click OK to load the code list table and exit the Load Code List dialog.

14

Click Close to exit the Edit Code List dialog.

15

From the Store Field list, select 0336_ DESC TERMS TYPE CODE to
store the code in the ITD16 element you created.

The dialog now should look like this:

Element Properties E

M ame I Validatinnl Fririt I Extended Rule  Standard Rule |E0nditinns|

Please zelact the standard rule bo uze IUse Code j

Please zelact the code list to uze

0336 TERMS TYPE CODE ] Ea |

™ Raise a compliance enor if the code is not found in the list

If wou would like the description of the code ta be stored in & field, please
zelect that field below :

DESC TERMS TYPE CODE

QK I Cancel S Help

16

Click OK to exit the dialog.
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How to customize The ITD12 element contains the exact terms of the purchase order. The terms are
the ITD12 element explained by the description of the Terms Type Code, so there is no need to print the label
associated with the message. Therefore, you hide the field label for the ITD12 element on
the printout.

Use this procedure to hide the Description field label.

Step Action

1 Double-click the ITD12 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 In the Label box, delete the existing field label.

4 Click OK to exit the dialog.

5 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

System Response
The ITD frame now should look like this:

oy
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Customizing the N1 Group

Overview  The standard allows the N1 group to be used up to two hundred times. In the N1 group,
you already activated the N1, N3, and N4 segments to provide the name and address of an
entity or individual. Your trading partner uses the N1 group to send you these three types
of addresses:

» Bill to name and address (Entity Identifier Code “BT”)
» Ship to name and address (Entity Identifier Code “ST”)
» Buying party name and address (Entity Identifier Code “BY™)

You already inserted an N4 group and moved the N4 segment to be subordinate to the N4
group (so that the city, state or province code, and postal code are printed after the address
information), so the fields for the N1, N3, and N4 segments are displayed on three frames.
Currently, the three frames look like these (your frames may be larger than the ones shown
below):

Entlty Idemtifisr Code El

[

Addre=a [nformation |

aAddresa [nfocmation |

]

CiEF [Name |

State Jdr Frowrloce Code l:l
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After After you customize the N1, N3, and N4 segments, the fields still are displayed on three
customization frames. The frames are printed in order, so that the name is printed first; then the address
(one to four lines of address information); then the city, state, and postal code. The address
is formatted the way you expect an address to be formatted. After you customize and
format the N1 group, the address fields (on three frames) should look like these:

Il
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Customizing the N1 Segment

Customizing the N1 Segment

Overview

Customizing the
N101 element

How to copy the
N101 element

The N1 segment identifies the Name of the entity or individual. When the N1 segment is
used, the N101 element is mandatory. The N101 element contains the two-character Entity
Identifier Code.

You want the more meaningful description of the code to be printed on the printout,
instead of the code itself.

The N102 element is a conditional element that identifies the name of the entity or
individual. You hide the field label for this field, since the the name is self-explanatory.

For this tutorial, you know that your trading partner sends you these three types of names
and addresses:

» Bill to name and address (Entity Identifier Code “BT”)
» Ship to name and address (Entity Identifier Code “ST”)
» Buying party name and address (Entity Identifier Code “BY”)

To print the description of the EDI code value, you must copy the N101 element to another

element in the N1 segment, then use the new N1 element to print the description of the
Entity Identifier Code.

Use this procedure to copy and paste the N101 element.

Step Action

1 Select the N101 element.

2 Click Copy on the Main Toolbar.

3 Select the N106 element, which is the last element in the N1 segment. The
N106 element is the element after which you want the N101 element to be
pasted.

4 Click Paste on the Main Toolbar to paste the new element.

System Response
A new element (N107) is created, which is an exact copy of the N101
element.
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How to change the The system names the new element created from copying the N101 element 0098:3. You
N107 element and rename the new element to identify its purpose, which is to print the description of the
field properties code from the N101 element. You also remove the Mandatory status from the N107
element to make it a conditional element (the element is used only if there is EDI data
available for it) and increase the element and field lengths to accommodate the code
description.

Use this procedure to change the element name and length, make the element conditional
instead of mandatory, and change the field label and field length for the N107 element.

Step Action

1 Double-click the N107 element.

System Response
The Element Properties dialog is displayed.

2 In the Name box, enter 0098_DESC to give the name a more descriptive
identifier than its current name.

3 Select the Validation tab.

4 Clear the Mandatory check box to make the element conditional.
5 In the Min box, enter 0.

6 In the Max box, enter 30.

7 Select the Print tab.

8 In the Label box, delete the existing field label.

9 In the Maximum number of characters box, enter 30.

10 Click OK to exit the dialog.
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How to hide the = Now that you have created an exact copy of the N101 element in order to retain all of the
N101 Field and EDI data and formatting associated with that element, you can hide the first Entity
load the code list Identifier Code field.

table from the
standard For this tutorial, you know that your trading partner sends you the following types of

names and addresses:

» Bill to name and address (Entity Identifier Code “BT”)

»  Ship to name and address (Entity Identifier Code “ST”)

» Buying party name and address (Entity Identifier Code “BY”

You do not need to load the entire code list table, so you load only codes BT, ST, and BY
from the Entity Identifier Code table.

Use this procedure to hide the first Entity Identifier Code field and load the code list table
from the standard.

Step Action

1 Double-click the N101 element. You need to use a code list table for this
element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.

3 Clear the Include this field in the print check box.
4 Select Standard Rule tab.

5 Click the Use Code option.

6 Click Yes at the prompt.

7 Click Edit to access the Edit Code List dialog.

The Table ID box contains 0098, the name of the element for which this
code list table is used. The Desc box contains ENTITY IDENTIFIER
CODE, the description of the element for which this code list table is
used.

8 Click Load to access the Load Code List dialog.

System Response

You are prompted to select an ODBC data source name. Select the
appropriate DSN and click OK to access the Load Code List dialog. The
Codes In Standard list contains the entire code list table.

9 From the Codes In Standard list, highlight code BT.
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(Contd)
Step Action
10 Click Add to move it to the Codes Selected list.
11 From the Codes In Standard list, highlight code BY.
12 Click Add to move it to the Codes Selected list.
13 From the Codes In Standard list, highlight code ST.
14 Click Add to move it to the Codes Selected list.
15 Click OK to load the code list table and exit the Load Code List dialog.
16 Click Close to exit the Edit Code List dialog.

17 From the Store Field list, select 0098_DESC ENTITY IDENTIFIER
CODE to store the code in the N107 element you created.

System Response
The dialog now should look like this:

Element Properties E3

Mame I Validatinnl Frint I Extended Rule  Standard Rule |E0nditinns|

Please select the standard rule to uze IUse Code j

Please select the code list to uze

[0038 ENTITY IDENTIFIER CODE -] Ea |

[™ Raize a compliance erar if the code is not found in the list

If you would like the description of the code ta be stared in a field, please
zelect that field below :

0033 DESC ENTITY IDEMTIFIER CODE

QK. I Cancel | Lpply Help

18 Click OK to exit the Element Properties dialog.
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How to customize The N102 element contains the exact name that should be printed. The name is explained

the N102 element by the description of the Entity Identifier Code, so you do not need to print the label
associated with the name. The only customizing that is necessary for the N102 element is
to hide the field label on the printout.

Use this procedure to hide the Name field label.

Step Action

1 Double-click the N102 element.

System Response
The Element Properties dialog is displayed

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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Customizing the N3 Segment

Overview  The N3 segment contains the Address of the entity or individual named in the N1 segment.
If the N3 segment is used, the N301 element is mandatory. The N301 element contains
address information, which identifies the street name, suite number, or any other address
information that your trading partner sends you. This element does not contain the city,
state/province, or postal code; that data is contained in the N4 segment. You already
activated the N302 element, which is a conditional element that contains an additional line
of address information (if it is received).

The N301 and N302 elements contain the exact address information that should be
printed. The address information corresponds to the name that is printed from the N101
element. Therefore, there is no need to print the labels associated with the address
information, so you hide the field labels for the N301 and N302 elements.

How to customize  Use this procedure to hide the Address Information field label.
the N301 element

Step Action

1 Double-click the N301 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.

How to customize Use this procedure to hide the second Address Information field label.
the N302 element

Step Action

1 Double-click the N302 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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Customizing the N4 Segment

Customizing the N4 Segment

Overview

How to customize
the N401 element

How to customize
the N402 element

The N4 segment (in the NEW N4 group in the N1 group) contains the Geographic
Location of the entity or individual named in the N1 segment. The N4 segment is not a
mandatory segment. The N401 element contains the name of the city, the N402 element
contains the code for the state or province, and the N403 element contains the postal code.

There is no need to print the labels associated with the geographic location, because it is

evident on the printout that the name, address, and geographic location are associated.
Therefore, you hide the field labels for the N401, N402, and N403 elements.

Use this procedure to hide the City Name field label.

Step Action

1 Double-click the N401 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.

Use this procedure to hide the State or Province Code field label.

Step Action

1 Double-click the N402 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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How to customize Use this procedure to hide the Postal Code field label.
the N403 element

Step Action

1 Double-click the N403 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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Customizing the N4 Segment

(Contd)
Step

Action

5

Click Generate Layout on the Main Toolbar to refresh the display of the
print form.

System Response
The N1, N3, and N4 frames now should look like these (your frames may
be larger than the ones shown below:

+

Later in the tutorial, you format these fields so they are formatted in a
standard address format, like the example below:

M. Wolfgang

Pet Zone

123 Corporate Blvd.
Anytown, NY 12345-6789
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Customizing the PO1 Group

Overview

Before customizing

After customizing

The standard allows the PO1 group to be used up to one hundred thousand times,
containing up to one hundred thousand line items in one purchase order. You already
activated these segments and group in the PO1 group: PO1 segment, PID group, DTM:4
segment, and DTM:2 segment.

Before you customize the group, segments, and elements in the PO1 group, the fields in
the form are arranged with one field on a line, like the following:

Assigned Identification [:::::::::]
Cuantitcy Ordered [:::::::]

Unit Or Basis For Measurement Code []

Product/Service Id Qualifier []

-

Product/Service Id

Item Description Type D

DIescription

Date/Time Qualifier [:]

Date [::::]

Date/Time Qualifier [:]

Date [::::]

: : hd

If the frames were not customized and formatted differently, then each set of fields would
be repeated for each item ordered. A more efficient and traditional way of listing items on
a purchase order is to arrange the related information in columns, so all the related
information for one item is listed on one or two lines. The column headings are printed
only once.

The following figure shows how you ultimately want the fields in the PO1 group to be
arranged (after customizing and then formatting the fields).

Libne Code Lo Pripe Raqueated Zhlp No
Na. Bead ID Type Crd Unit Emah Ship Date Late=e

11 | OO 1 OO | [EE | |

The following sections describe how to customize the PO1 segment, the PID group, and
the DTM segment so that their associated fields are displayed on a single frame.
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Customizing the PO1 Segment

Customizing the PO1 Segment

Overview

How to customize
the PO101 element

The PO1 segment (in the PO1 group) contains the Baseline Item Data that identifies the
details of the items on the purchase order. You assign new labels for each of the fields in
the PO1 segment to identify more specifically the information your partner sends you. You
then change the maximum lengths for some of the fields, and print the description of the
Product/Service ID Qualifier.

The PO101 element contains the Assigned Identification for one item on the purchase
order. Assigned Identification is a general term; you and your trading partner have agreed
to call this identification a line number. You change the label for this field to reflect the
new field name. You and your trading partner also have agreed that there are no more than
99,999 line items per purchase order. Since each line item is numbered sequentially,
starting with one, you need a maximum length of only five digits for this field. You change
the maximum length for this field to five.

Use this procedure to change the element and field lengths, field label, and field length for
the Assigned Identification field.

Step Action

1 Double-click the PO101 element.

System Response
The Element Properties dialog is displayed.

Element Properties E2
Mame |\-"alidation| Prirnt I Extended Hulel Standard Hulel Cnndilionsl

Fleasze enter the name ;
0350

Please enter a short description :
ASSIGMED IDEMTIFICATION

ak I Cancel Sl Help

2 Select the Validation tab.
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(Contd)
Step

Action

3

In the Max box, enter 5 to allow a five-character string in this element.

4

Select the Print tab.

In the Label box, enter Line to replace the existing field label.

Note

The label for the Assigned Identification field ultimately forms the
column heading “Line No.” To make the width of the column heading as
narrow as possible, you place “Line” on one line and “No.” below. The
Label box does not enable you to enter a label on more than one line, so
you enter “Line” in the Label box, then add “No.” by adding static text
later in this tutorial.

In the Maximum number of characters box, enter 5 to allow five numeric
digits to be displayed on the printout.

Click OK to exit the dialog.
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Customizing the PO1 Segment

How to customize The PO102 element contains the Quantity Ordered for one item on the purchase order. For

the PO102 element brevity on the printout, you rename the field label. The standard allows up to a nine-digit
number in this field. You know that your trading partner orders no more than 99,999 (a

five-digit number) of any one item, so you change the maximum length to six for this field

(for a five-digit number and a place separator) and change the value in the Screen Format

and EDI Format lists to “NO” (for a number with an implied decimal point and no decimal

places).

Use this procedure to change the element length, field label, and field length for the

Quantity Ordered field.
Step Action

1 Double-click the PO102 element.
System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 6 to allow a five-digit number and a place separator
in this element.

4 From the Form Format list, select NO to allow a number with an implicit
decimal point and no decimal places to be displayed on the printout.

5 From the File Format list, select N0 to indicate that you expect a number
with an implied decimal point and no decimal places in the EDI data.

6 Select the Print tab.

7 In the Label box, enter Qty to replace the existing field label.

8 In the Maximum number of characters box, enter 6 to allow a five-digit
number and a place separator to be displayed on the printout.

9 Click OK to exit the dialog.
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How to customize
the PO103 element

How to customize
the PO104 element

The PO103 element contains the Unit or Basis for Measurement Code for each item on the
purchase order. For brevity on the printout, you rename the field label.

Use this procedure to change the field label of the Unit or Basis for Measurement Code
field.

Step Action

1 Double-click the PO103 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, enter Unit to replace the existing field label.
4 Click OK to exit the dialog.

The PO104 element contains the Unit Price for each item on the purchase order. For this
tutorial, you rename the field label.

The standard designates an EDI format of “R9” for the Unit Price field, meaning that the
price is formatted with an explicit decimal point and up to nine decimal places. Your
trading partner sends you EDI data for the price in “R2” format, and this is also the format
you want to use to display the price on the printout (e.g., “100.00” instead of
“100.000000000”). You change the number formats in the Screen Format and EDI Format
fields for this element to reflect the number formats you use.

The standard defines this element as having a maximum length of fourteen, but the items
you sell to Pet Zone are not priced at more than $9,999.99 each, so this field needs a
maximum length of only eight (four places for the dollars; two places for the cents; one
place for the decimal point; and one place for a plus or minus sign, if present).

Use this procedure to change the element and field lengths, field label, and number
formats for the Unit Price field.

Step Action

1 Double-click the PO104 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow eight numeric digits in this field,
including a plus or minus sign and a decimal point.

() Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide




Creating a Print Form Customizing the PO1 Segment

(Contd)
Step Action

4 From the Form Format list, select R2 to allow a number with an explicit
decimal point and four decimal places to be displayed on the printout.

5 Click Yes at the prompt.

6 From the File Format list, select R2 to indicate that you expect a number
with an implicit decimal point and no decimal places.

7 Click Yes at the prompt.

8 Select the Print tab.

9 In the Label box, enter Price to replace the existing field label.

10 In the Maximum number of characters box, enter 8.

11 Click OK to exit the dialog.

How to customize The PO106 element contains the Product/Service ID Qualifier for each item on the
the PO106 element purchase order. For this tutorial, Pet Zone sends you one of these two types of product
codes: VN (Vendor) or UP (UPC Code). For brevity on the printout, you rename the field
label.

Use this procedure to change the field label for the Product/Service ID Qualifier field.

Step Action

1 Double-click the PO106 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, enter Code to replace the existing field label.
4 Click OK to exit the Element Properties dialog.
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How to customize The PO107 element contains the Product/Service ID for one item on the purchase order.
the PO107 element For brevity on the printout, you change the field label to “Prod ID.” The standard allows
up to a thirty-character string in this field. Your trading partner uses product identification
numbers that are no longer than ten characters, so you change the maximum length for this
field to ten.

Use this procedure to change the field and element lengths and the field label for the
Product/Service ID field.

Step Action

1 Double-click the PO107 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 for the maximum number of characters allowed
for this element.

4 Select the Print tab.

System Response
The Print dialog is displayed.

Element Properties E2

Mame I ‘alidation  Print | Extended Hulel Standard Hulel Cnndilionsl

W iCheck here to include this field in the prink

Fleasze enter the label for thiz field ;
IF'roduct.f’Service 14

Fleaze enter the marimum number of characters to be printed ; |3|:I

ak I Cancel Sl Help

5 In the Label box, enter Prod ID to replace the existing field label.

6 In the Maximum number of characters box, enter 10 to allow a ten-
character string to be displayed on the printout.
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Step Action
7 Click OK to exit the dialog.
8 Click Generate Layout on the Main Toolbar to refresh the display of the

print form.

System Response
The PO1 frame now should look like this:

— r
Unit ]

Code ]

Prod ID q 3

Item Description Type D

Description

Date/Tim=e Qualifier [:]

Date/Time Qualifier [:]
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Customizing the PID Group

Overview  The PID group contains the item description. The standard allows the PID group to be
used up to one thousand times for each line item, but you need the PID group to be used
only once for each line item. You already changed the maximum use of the PID group to
one and promoted the group to the parent frame.

How to customize The PID:201 element (in the PID:2 segment in the PID group) contains the Item
the PID:201 Description Type (“F” for free-form item description, “S” for structured description, or
element  “X” for semi-structured). This element must be present, because you expect this data from
your trading partner. However, you can hide this field, since the meaningful information
for a print is the description itself, not the type of description.

Use this procedure to hide the Item Description Type field.

Step Action

1 Double-click the PID:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 Clear the Include fields in the print check box.
4 Click OK to exit the dialog.

How to customize The PID:205 element (in the PID:2 segment in the PID group) contains the Description of
the PID:205 the purchase order item. The description is self-explanatory, so there is no need to print the
element field label associated with the message.

Use this procedure to hide the Description field label.

Step Action

1 Double-click the PID:205 element.

System Response
The Element Properties dialog is displayed.

2 Select the Print tab.
3 In the Label box, delete the existing field label.
4 Click OK to exit the dialog.
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Step Action
5 Click Generate Layout on the Main Toolbar to refresh the display of the

print form.

System Response
The PO1 frame now should look like this:

Unit D
Code |:|

Frod ID |

|»

{

Date/Time Qualifier l:l

Date I:I

Date/Time Qualifier l:l

Date I:I

i ] ! —
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Customizing the DTM:4 Segment

Overview

The DTM:4 segment (in the PO1 group) is used to print the requested ship date. To ensure
that Gentran:Server prints the correct date in the Date field, you must use the key field
function. The key field function enables you to specify a second qualification in selecting
a segment (the segment name is the first qualification). Data must be provided in the order
designated through the use of key fields. For example, for this tutorial, you expect the
requested ship date (DTM:4) first, and then the ship no later date (DTM:2).

Important

For this tutorial, the dates printed in the DTM:4 and DTM:2 segments can be set up using
key fields because you expect the dates in a particular order. If the dates were sent in a
different order, only one date would be printed. If you were not sure of the order in which
your partner sends the dates, you could not use key fields. You would need to use three
DTM segments (using the promote function), and two of those DTM segments would
need to be identical.

For this tutorial, when the Date/Time Qualifier field contains the value “010” (Requested
Ship), then the date is printed in the Date field of the DTM:4 segment. If the Date/Time
Qualifier field contains the value “038” (Ship No Later), then the date is printed in the
Date field of the DTM:2 segment.
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Customizing the DTM:4 Segment

How to use a key  Use this procedure to use a key field for the DTM:4 segment.

Action

Click the DTM:4 segment with the right mouse button to access the

shortcut menu and select Properties from the shortcut menu.
System Response
The EDI Segment Properties dialog is displayed.
EDI Segment Properties E3
Name |Special| Key Fieldl Frint | Loopingl

Please enter the name :
IDTM:4

Fleaze enter a short description ;
DATELTIME REFEREMCE

(u] 4 I Cancel | Al | Help |

field for the
DTM:4 segment
Step
1
2

Select the Key Field tab to access the Key Field dialog.

EDI Segment Properties

Mame I Special  key Field IF'rint I Loopingl

e — =

B e ]

1 e comstant I vl Exdite.. |
) e codelist I vl Elf;. |

™ tatet record whern key does inot match

Ok, I Cancel Lappl i Help
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(Contd)
Step

Action

3

From the Field list, select 0374:9 DATE/TIME QUALIFIER.

4

Verify that the Use constant option is selected.

Click Edit to access the Map Constants dialog.

Click New to display the Edit Constant dialog.

Edit Constant E2

1] Type
|| —

ralue Cancel |

In the ID box, enter Requested Ship to identify the unique literal
constant.

From the Type list, select String.

In the Value box, enter 010 to identify the actual value of the constant.

10

Click OK to exit the Edit Constant dialog.

11

Click Close to exit the Map Constants dialog.

12

From the Use constant list, select 010 to indicate to the system that this
date is the requested ship date.

13

Click OK to exit the dialog.

How to customize The DTM:401 element (in the DTM:4 segment) contains the Date/Time Qualifier for the
the DTM:401 date in the DTM:402 element. For this tutorial, your trading partner sends you just two
element types of dates: the requested ship date and the ship no later date (in that order). You used
the key field function for the DTM:4 segment to indicate to Gentran:Server that only the
requested ship date is printed in the Date field (DTM:402), so you can prevent the
qualifier (DTM:401) from being printed. The ship no later date is printed in the Date field
for the DTM:2 segment.

Use this procedure to hide the Date/Time Qualifier field.

Step

Action

1

Double-click the DTM:401 element.

System Response
The Element Properties dialog is displayed.
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Step Action
2 Select the Print tab.
3 Clear the Include fields in the print check box.
4 Click OK to exit the dialog.

How to customize The DTM:402 element contains the Date corresponding to the date qualifier in the
the DTM:402 DTM:401 element. For this tutorial, the DTM:402 element is used to designate when the
element shipment is requested.

In this section of the tutorial, you rename the label for this field (the new label is named
Requested). You add the words Ship Date later in this tutorial using static text (static text
is text that is always printed when the form is used, and that is not defined in the field
properties of the element) so that Ship Date is displayed on the line below Requested.
Therefore, the full field label is Requested Ship Date.

The EDI data from your trading partner is formatted as “YYMMDD,” but you format the
date as “MM/DD/YY” on the printout.

Use this procedure to change the element and field lengths, hide the Date field label, and
set the date format for the date on the printout.

Step Action

1 Double-click the DTM:402 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), in this element.

4 From the Format of the data in the form list, select MM/DD/YY to
designate the format for the date on the printout.

5 Verify that YYMMDD is selected in the Format of the data in the file list
to designate the format for the date in the EDI data.

6 Select the Print tab.
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Step

Action

7

In the Label box, enter Requested to replace the existing field label.

Note

The label for the Date field ultimately forms the column heading,
Requested Ship Date. To make the width of the column heading as narrow
as possible, you place “Requested” on one line and “Ship Date” below.
The Label box does not enable you to enter a label on more than one line,
so you enter “Requested” in the Label box, then add “Ship Date” by
adding static text later in this tutorial.

In the Maximum number of characters box, enter 8 to allow the entire
date, including separators (/), to be displayed on the printout.

Click OK to exit the dialog.
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Customizing the DTM:2 Segment

Overview  The DTM:2 segment (in the PO1 group) is used to print the latest date that the order can
be shipped. To ensure that Gentran:Server prints the correct date in the Date field, you
must use the key field function. The key field function enables you to specify a second
qualification in selecting a segment (the segment name is the first qualification). Data
must be provided in the order designated through the use of key fields. For example, for
this tutorial, you expect the requested ship date (DTM:4) first, and then the ship no later
date (DTM:2).

Important

For this tutorial, the dates printed in the DTM:4 and DTM:2 segments can be set up using
key fields because you expect the dates in a particular order. If the dates were sent in a
different order, then only one date would be printed. If you were not sure of the order in
which your partner sends the dates, then you could not use key fields. You would need to
use three DTM segments (using the promote function), and two of those DTM segments
would need to be identical.

For this tutorial, if the Date/Time qualifier field contains the value “010” (Requested
Ship), then the date is printed in the Date field of the DTM:4 segment. If the Date/Time
Qualifier field contains the value “038,” then the date is printed in the Date field of the
DTM:2 segment.
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How to use a key  Use this procedure to use a key field for the DTM:2 segment.
field for the
DTM:2 segment

Step Action

1 Click the DTM:2 segment with the right mouse button and select
Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

EDI Segment Properties E2
Mame |S|:uecia|| Kep Fieldl Frint | Loopingl

Pleaze enter the name :

IDTM:2

Fleasze enter a short description ;
DATE/TIME REFEREMCE

Ok, I Cancel | Lppi | Help |

2 Select the Key Field tab to access the Key Field dialog.
EDI Segment Properties E2
MHame I Special  Keyp Field I Print | Loopingl

Field [

I atehing rules

! e corstant I vl Edit:.. |
) (52 codeist I 'I Edlif: |

I | Miatehrecord wher key does rot mateh

QK I Cancel Al Help
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(Contd)
Step Action
3 From the Field list, select 0374:6 DATE/TIME QUALIFIER.
4 Verify that the Use constant option is selected.
5 Click Edit to display the Map Constants dialog.
6 Click New to display the Edit Constant dialog.
] —
ralue Cancl |
7 In the ID box, enter Ship No Later to identify the literal constant.
8 From the Type list, select String.
9 In the Value box, enter 038 to identify the actual value of the constant.
10 Click OK to exit the Edit Constant dialog.
11 Click Close to exit the Map Constants dialog.
12 From the Use constant list, select 038 to indicate to the system that this
date is the Ship No Later date.
13 Click OK to exit the dialog.

How to customize The DTM:201 element (in the DTM:2 segment) contains the Date/Time Qualifier for the
the DTM:201 date in the DTM:202 element. For this tutorial, your trading partner sends you just two
element  types of dates: the requested ship date and the ship no later date (in that order). You used
the key field function for the DTM:2 segment to indicate to Gentran:Server that the ship
no later date is printed in the DTM:202 field (Date). The DTM:201 element must be
present, but you can prevent this field from being displayed, since the meaningful
information for a printout is the date itself.

Use this procedure to hide the second Date/Time Qualifier field.

Step Action

1 Double-click the DTM:201 element.

System Response
The Element Properties dialog is displayed.
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Step

Action

2

Select the Print tab.

3

Clear the Include fields in the print check box.

4

Click OK to exit the dialog.

How to customize The DTM:202 element contains the Date corresponding to the date qualifier in the
the DTM:202 DTM:201 element. For this tutorial, the DTM:202 element is used to designate the latest
element date that shipments should be shipped.

In this section of the tutorial, you rename the label for this field (the new label is named
Ship No). You add Later further in this tutorial using static text so that Later is displayed
on the line below Ship No. The full field label is Ship No Later.

The EDI data from your trading partner is formatted as YYMMDD, but you format the
date as MM/DD/YY on the printout.

Use this procedure to change the field and element lengths, hide the Date field label, and
set the date format for the date on the printout.

Step

Action

1

Double-click the DTM:202 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8 to allow the entire date, including separators
(/), in this element.

From the Format of the data in the form list, select MM/DD/YY to
designate the format for the date on the printout.

Verify that YYMMDD is selected in the Format of the data of the file list
to designate the format for the date in the EDI data.

Select the Print tab.

In the Label box, enter Ship No to replace the existing field label.

In the Maximum number of characters box, enter 8 to allow the entire
date, including separators (/), to be displayed on the printout.

Click OK to exit the dialog.
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(Contd)
Step Action
10 Click Generate Layout on the Main Toolbar to refresh the display of the

print form.

The PO1 frame now should look like this:

Line |:| ﬂ
Unit D
Code D

prod ID |

Requested
3hip Mo E

M

Now you are ready to format the fields and their labels to make the frame more consistent
and visually attractive.
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Format the Print Form

Overview

Introduction In the previous section of this tutorial, you customized the print form for an ANSI X12
003040 purchase order (850) that you use to print the data you receive from Pet Zone.
After successfully customizing the fields and elements of the print form, you are ready to
format the layout of the form.

One form can consist of several frames. Each group and repeating segment has a
corresponding frame that contains all the groups, segments, and elements at that level.
When the form is printed, the frames are printed consecutively, in the order in which they
occur in the form. Each frame is not printed on a separate page.

This section explains how to format the form, field by field.
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Resizing the Header Frame

Overview  When a printout is produced based on the customized print form, the information is
arranged according to how the frames and the fields contained in them were arranged
when the form was compiled. You should eliminate unnecessary space as you arrange the
fields on each frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Procedure  Use this procedure to resize the header frame.

Step Action

1 Click the BEG segment to display the Beginning Segment for Purchase
Order (header) frame in the Layout Window.

2 To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window is wide enough to display as much of the form as
you want.

Note

You should be able to view the entire width of the frame. If the right side
of the header frame (and the vertical scroll bar for the frame) are not
visible in the Layout Window, then move the center bar between the EDI
File Format Window and the Layout Window farther to the left so the
entire frame is displayed. Alternatively, you can use the horizontal scroll
bar at the bottom of the Forms main window to bring the right side of the
header frame into view.

3 To resize the header frame, click and drag the right side of the frame
approximately to the 20 cm. mark on the horizontal ruler (a form with a
width of 20 cm. can be printed on an 8 1/2” x 11” sheet of paper).

Note

Use the horizontal ruler at the top of the frame to help you resize the
frame. The instructions in this tutorial are given in centimeters. You can
toggle from inches to centimeters by double-clicking the yellow square
where the vertical and horizontal rulers meet.
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Adding a Title to the Form

Overview  You want the form to have a title designating the standard agency (ANSI X12), the version
(3040), the type of document (purchase order), and the trading partner for which this form
is used. You add a title to the print form by adding static text.

Procedure  Use this procedure to add and position the title for the form.

Step

Action

1

Click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.

Note

If the template is larger than the frame (there is a scroll bar on the right
side of the frame), the static text is displayed in the upper left corner of the
part of the template that is displayed, not at the top of the template.

In the new selected text box, enter ANSI X12 3040 Purchase Order and
click OK.

Click Add Text on the Main Toolbar

System Response.
A new text box is added to the current frame in the upper left corner.

In the new selected text box, enter Pet Zone and click OK.

System Response
The static text you added is displayed in the upper left corner of the frame.

How to center the Use this procedure to center the static text at the top of the purchase order form.

text

Step

Action

1

Click and drag the first line of static text (ANSI X12 3040 Purchase
Order) so that the text is centered on the first line of the frame.
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Step Action
2 Click and drag the second line of static text (Pet Zone) so that the text is

centered on the second line of the frame.

System Response
The header frame (BEG) now should look like this:

AMNSI X1Z 3040 Purchase Order iI
Fet Zone

Crder MNuber: | |

Crder Date: I:I

QOrder Type: | |

Contract No. | |

-
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Arranging the Header Fields (BEG and REF Segments)

Overview

How to resize the
header fields

By default, each field and its associated label are printed on their own line. However, it is
common for purchase orders and forms to arrange some fields in columns of information.
The first fields you rearrange are the header fields, which are the fields associated with the
BEG and REF segments.

You prevented some of the field labels from being printed (by removing the field label in
the Label box of the Print dialog). For these fields, the fields are displayed on your print
form, but their associated labels are not.

Note

If you forget which unlabeled field contains what data, you can click the field. Its
associated element is highlighted in the EDI File Format Window, providing you with a
description of the field.

When you customized the element properties in the previous section of this chapter, you
changed the display lengths (on the Element Properties dialog) for some of the fields on
the header frame. The fields that are displayed in the Layout Window currently reflect the
default display lengths for the fields. To reflect the new sizes of the fields in the Layout
Window, you must select the fields for which you changed the display lengths, then resize
the fields.

Note

If a field and its corresponding field label move together, the Lock Labels to Fields option
is turned on. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels
option.

Use this procedure to resize the fields on the header frame.

Step Action

1 Select all the fields on the header frame (Order Number, Order Date,
Contract No., and Order Type).

Note
To select a group of fields, click and drag the mouse diagonally across all
the fields you want to select.

2 Select Size to Length from the Display menu. The selected fields are
resized to the lengths specified in the Maximum number of characters box
of the Print dialog for each field.

Note
If you format a form component in a way you did not intend, select Undo
from the Display menu to undo your last formatting action.
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How to move and
align the header
fields and field
labels

Arranging the Header Fields (BEG and REF Segments)

Use this procedure to move and align the fields and field labels on the header frame.

Note

If a field is not in the part of the frame that currently is displayed, use the scroll bar to
scroll down the frame until you locate the hidden fields.

Step

Action

1

Select each field individually and drag it closer to its respective field label.

CAUTION
DO NOT MOVE FIELDS THAT ARE NOT LABELED.

Select the Order Date label and field and drag them to the right of the
Order Number label and field (at approximately 11.5 cm.).

Select the Order Type label and field and drag them below the Order
Number label and field.

Select the Contract No. label and field and drag them below the Order
Date label and field.

Select the Order Number and Order Type ficld labels.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the Order Type and Order
Number field labels are aligned.

Select the Order Type and Order Number fields (in that order).

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the Order Type and Order
Number fields are aligned.

Select the Order Date and Contract No. field labels (in that order).

10

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the Contract No. and Order
Date field labels are aligned.

11

Select the Order Date and Contract No. fields (in that order).

12

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the Contract No. and Order
Date fields are aligned.

13

Select the Order Number and Order Date labels and fields.

Note
To select a group of fields, click and drag the mouse diagonally across all
the items you want to select.
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(Contd)
Step

Action

14

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and field labels
are aligned.

15

Select the Order Type and Contract No. labels and fields.

16

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and field labels
are aligned.

17

To resize the frame, click and drag the bottom of the frame to just below
the Order Type and Contract No. labels and fields.

System Response

The header frame now should look like this:

ANST ¥12 3040 Purchase Order *
Pet Zone
Order Nwrber: l:l Order Date:
Order Type: | Contract No.
+
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Arranging the Note Field

Arranging the Note Field

Overview

How to move the
field

How to resize the
NTE frame

The field that contains any notes or messages for the purchase order is contained on a
separate frame than the header fields. To access this frame, select the NTE segment.

You prevented the label for the Free Form Message field from being displayed, so you see
the field in the layout of your print form, but not its associated label.

In arranging the Free Form Message field and its frame, you first move the field, then you

resize the frame to give it the same width as the header frame.

You should move the Free Form Message field so that its left side is aligned with the left
sides of the field labels on the header frame.

Step Action
1 Click the NTE segment to display the Note frame in the Layout Window.
2 To move the Free Form Message field, click and drag it to the upper left
corner of the Note frame.

Use this procedure to resize the NTE (Note) frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Step Action

1 Click and drag the bottom of the frame to just below the Free Form
Message field.

2 Click and drag the right side of the frame to the 20 cm. mark on the
horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 117 piece of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.

System Response
The NTE (Note) frame now should look like this:

[ [+
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Arranging the Terms of Sale Fields

Overview

How to resize the
ITD fields

How to move the
fields

How to align the
fields

The fields that contain information about the Terms of Sale for the purchase order are
contained on another frame. To access this frame, select the ITD segment.

You prevented the labels for the Terms Type Code and Description fields from being
displayed, so you see the fields in your print form, but not their associated labels.

In arranging the Terms of Sale fields and their frame, you first resize, move, and align the
fields, then you resize the frame to give it the same width as the other frames.

Use this procedure to resize the Terms of Sale fields.

Step

Action

1

Click the ITD segment to display the Terms of Sale frame in the Layout
Window.

Select the Terms Type Code and Description ficlds.

Note
To select a group of fields, click and drag the mouse diagonally across all
the fields you want to select.

Select Size to Length from the Display menu. The selected fields are
resized to the lengths specified in the Maximum number of characters box
of the Print dialog for each field.

Use this procedure to move the Terms of Sale fields.

Step Action
1 Select the Terms Type Code ficld and drag it to the upper left corner on
the frame.
2 Select the Description field and drag it to the right of the Terms Type
Code field (on the same line).

Use this procedure to align the Terms of Sale fields.

Step Action
1 Select the Terms Type Code and Description fields.
2 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields are aligned.
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How to resize the Use this procedure to resize the ITD (Terms of Sale) frame.

ITD frame
Note

When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Step Action
1 Click and drag the bottom of the frame to just below the Description and
Terms Type Code fields.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 117 piece of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.

The ITD (Terms of Sale) frame now should look like this:

i

Forms Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()



Arranging the Name and Address Fields Creating a Print Form

Arranging the Name and Address Fields

Overview

How to resize the
N1 frame

The fields that contain information about the Names and Addresses for the purchase order
are contained on three frames. When you finish formatting all the associated name and
address fields, the information printed in these fields is arranged in a standard address
format (the name on the first line; the street address on the next four lines; and the city,
state, and zip code on the last line). To access the first frame, select the N1 segment.

After you format the fields in the N1 group, the address fields (on three frames
corresponding to the N1, N3, and N4 segments) should look like these:

I

You prevented all the labels for the name and address fields from being displayed, so you
see the fields in your print form, but not their associated labels.

In arranging the Name and Address fields and their frames, first you resize the frames to
give them the same width as the header frame, then you move and resize the fields.

Use this procedure to resize the N1 (Name) frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Step Action
1 Click the N1 segment to display the Name frame in the Layout Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 117 piece of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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How to resize the
N3 frame

How to resize the
N4 frame

How to arrange
the N1 fields

Arranging the Name and Address Fields

Use this procedure to resize the N3 (Address Information) frame.

Step Action
1 Click the N3 segment to display the Address Information frame in the
Layout Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 11” piece of paper).

Use this procedure to resize the N4 (Geographic Location) frame.

Step Action
1 Click the NEW_N4 group to display the Geographic Location frame in
the Layout Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 11” piece of paper).

Use this procedure to arrange the Name fields on the N1 frame.

Step Action

1 Click the N1 segment to display the Name frame in the Layout Window.

2 Select the Entity Identifier Code field (0098 DESC) and drag it to the
upper left corner on the frame.

3 Select the Name field and drag it to right of the Entity Identifier Code
field (on the same line).

4 Select the Entity Identifier Code and Name fields.
Note
To select more than one field, click the first field, then press CTRL and
click the second field.

5 Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields are aligned.

6 To resize the frame, click and drag the bottom of the frame to just below

the Entity Identifier Code and Name fields.

Forms Integration ANSI Tutorial Guide

Gentran:Server for Windows — August 2008



Arranging the Name and Address Fields Creating a Print Form

How to arrange  Use this procedure to move the Address Information fields on the N3 frame.

the N3 fields

Step

Action

1

Click the N3 segment to display the Address Information frame in the
Layout Window.

Select both Address Information fields.

Click and drag them so that the left margins of the fields begin at
approximately 8.3 cm. The Address Information fields are aligned with
the Name field on the previous (Name) frame.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the Address Information
fields are aligned.

To resize the frame, click and drag the bottom of the frame to just below
the second Address Information field.

How to arrange Use this procedure to move the Geographic Location fields on the N4 frame.

the N4 fields

Step

Action

1

Click the NEW_N4 group to display the Geographic Location frame in
the Layout Window.

Click and drag the City Name field so that the left margin of the field
begins at approximately 8.3 cm. The City Name field is aligned with the
Name field on the Name frame, and with the Address Information fields
on the Address Information frame.

Click and drag the State or Province Code field to the right of the City
Name field (on the same line).

Click and drag the Postal Code field to the right of the State or Province
Code field (on the same line).

Select the City Name, State or Province Code, and Postal Code fields.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected items are aligned.
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Arranging the Name and Address Fields

Step

Action

To resize the frame, click and drag the bottom of the frame to just below

the City Name, State or Province Code, and Postal Code fields.

The N1, N3, and N4 frames now should look like these:

1]

Forms Integration ANSI Tutorial Guide

Gentran:Server for Windows — August 2008 ()




Arranging the Line Items Fields Creating a Print Form

Arranging the Line Items Fields

Overview

How to resize the

PO1 frame

The fields that contain information about each line item for the purchase order are
contained on a separate frame. To access this frame, select the PO1 group.

You prevented some of the field labels from being displayed, so you see the fields in the
layout of your print form, but not all of the associated labels. In case you have forgotten
which unlabeled field contains what data, you can click the field. The name of the element
is highlighted in the EDI File Format Window.

Before you arrange the line items fields and their frame, first you resize the frame to give
it the same width as the other frames. Then, you move and resize the fields and field
labels, as well as add static text to the form.

Use this procedure to resize the PO1 (Line Items) frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Step Action
1 Click the PO1 group to display the Line Items frame in the Layout
Window.
2 Click and drag the right side of the frame to the 20 cm. mark on the

horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 11” piece of paper).

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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How to resize the  Use this procedure to resize the line items fields.
line items fields

Step Action

1 Select the following fields:
» Line
» Qty
» Price
» ProdID
» Requested
» Ship No
» Description
Note
To select more than one field, click the first field, then press CTRL and
click the second field.

2 Select Size to Length from the Display menu.

System Response
The selected fields are resized to the lengths specified in the Maximum
number of characters field of the Print dialog for each field.

Adding column You can add column headings (using static text) to the frame to change the way the field
headings labels are displayed in the form. Currently, each field label in this form takes up one line
of text.

You need all the horizontal space that is available to arrange the line item fields
horizontally. By adding a second line of text to some of the longer field labels (these field
labels are identified in the steps that follow), more horizontal space is available on the
frame.

You are adding the following lines of static text to the form:

Static Text Placement on Form
No. Below the Line field label
Type Below the Code field label
Ord Below the Qty field label
Each Below the Price field label
Ship Date Below the Requested field label
Later Below the Ship No field label
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Adding column  You add all of the static text (column headings and separating lines), then move each line
headings of static text into its proper location, later in this section.

(contd)

When you finish adding the static text and moving each line of static text to its proper
location, the PO1 (Baseline Item Data) frame should look like this:

Line Code LT Price Eaquested Shlp No
Ho. Prod IO Type Crd Unit Each Ship Date Later
11 | O L1 00 | | | |

Procedure  Use this procedure to add and position static text.

Step

Action

1

Select all the fields and field labels on the frame.

Note
To select more than one field or field label, click and drag the mouse
diagonally across all the fields and field labels you want to select.

Click and drag them to the bottom portion of the frame. You are arranging
the fields at the top of the frame, so moving the fields and field labels out
of the way initially gives you room to work with at the top of the frame.

Click Add Text on the Main Toolbar.

System Response

A text box is added to the current frame, displayed in the upper left corner
of the frame. If the template is larger than the frame (there is a scroll bar
on the right side of the frame), the static text is displayed in the upper left
corner of the part of the template that is displayed, not at the top of the
template.

In the selected text box, enter No. (note the period included in the text)
and click OK.

Note

A field already has a label named Line. To complete the identification of
this field, you add static text with the name “No.” After you add the static
text for this field, you move No. below “Line” to create a column heading
for the fields containing the line item number.

Again click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.
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(Contd)
Step

Action

6

In the new text box, enter Type and click OK.

Note

A field already has a label named Code. To complete the identification of
this field, you add static text with the name, Type. After you add the static
text for this field, you move “Type” below “Code” to create a column
heading for the fields containing the product/service ID qualifier.

Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

In the new text box, enter Ord.

Note

A field already has a label named Qty. To complete the identification of
this field, you add static text with the name Ord. After you add the static
text for this field, you move Ord below Qty to create a column heading for
the fields containing the quantity ordered.

Click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.

10

In the new text box, enter Each.

Note

A field already has a label named Price. To complete the identification of
this field, you add static text with the name, Each. After you add the static
text for this field, you move “Each” below “Price” to create a column
heading for the fields containing the price of each line item.

11

Click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.

12

In the new text box, enter Ship Date.

Note

A field already has a label named Requested. To complete the
identification of this field, you need to add static text with the name Ship
Date. After you add the static text for this field, you move Ship Date
below Requested to create a column heading for the fields containing the
requested ship date.
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(Contd)
Step

Action

13

Click Add Text on the Main Toolbar.

System Response
A text box is added to the current frame, displayed in the upper left corner
of the frame.

14

In the new text box, enter Later.

Note

A field already has a label named “Ship No”. To complete the
identification of this field, you need to add static text with the name
“Later”. After you add the static text for this field, you move “Later”
below “Ship No” to create a column heading for the fields containing the
latest date items may be shipped.

The column headings (static text) you added are displayed in the upper
left corner of the frame.

15

Select all the static text you added and drag it to the bottom of the frame.
Moving the static text out of the way gives you more room at the top of
the frame.

How to add lines  In this print form, rectangular boxes are used to designate fields. The boxes make it easy
separating column to distinguish fields from field labels and static text. On the printout, there are not
headings and fields  rectangular boxes surrounding the data in the fields. The printed field data and the field
labels tend to look the same on the printout (same typeface, same size text, no boldface or
italic type). You can make the field labels and static text stand out from the fields
containing the actual data by adding lines separating the labels from the fields. You add
static text to the form to add the separating lines.

You add the following lines of static text (hyphens) to the form:

Number of
Static Text Hyphens Placement on Form

------ Six Below the No. static text
____________ Twelve Below the Prod ID field label
———- Four Below the Type static text
-------- Eight Below the Ord static text

— Four Below the Unit field label
----------- Eleven Below the Each static text
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(Contd) Number of
Static Text Hyphens Placement on Form
---------- Ten Below the Ship Date static text
---------- Ten Below the Later static text

When you finish adding the static text and moving each line of static text to its proper
location, the PO1 (Baseline Item Data) should look like this:

Liom Code [ 38 Price Begue=ted Ship No
o, Frod IR TSDE ord TUnik Each Ship Patae Later
11 | OO L1 00 | | | |

You add all of the static text, then move each static text to its proper location.

Use this procedure to add and position separating lines (------ ) in the form.
Step Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the template is larger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper left corner of the part of the template
that is displayed, not at the top of the template.

2 In the new text box, enter ------ (six hyphens). This series of hyphens
forms a separating line between the words Line No. and the field below.

3 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

4 In the new text box, enter =------------ (twelve hyphens). This series of
hyphens forms a separating line between the words Prod ID and the field
below.

5 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

6 In the new text box, enter --——- (four hyphens). This series of hyphens
forms a separating line between the words Code Type and the field below.

7 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

8 In the new text box, enter -------- (eight hyphens). This series of hyphens
forms a separating line between the words Qty Ord and the field below.
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Step Action

9 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

10 In the new text box, enter ---- (four hyphens). This series of hyphens
forms a separating line between the word Unit and the field below.

11 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

12 In the new text box, enter --—---—----—- (eleven hyphens). This series of
hyphens forms a separating line between the words Price Each and the
field below.

13 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

14 In the new text box, enter ---------- (ten hyphens). This series of hyphens
forms a separating line between the words Requested Ship Date and the
field below.

15 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame.

16 In the newtext box, enter ---------- (ten hyphens). This series of hyphens
forms a separating line between the words Ship No Later and the field
below.

The column headings you added are displayed in the upper left corner of
the frame.

17 Select all the static text you added and drag it to the bottom of the frame.
Moving the static text out of the way gives you more room at the top of
the frame.

Moving the PO1  The POI frame now contains all of the fields, column headings, and separating lines that
fields, column are arranged on the form to create columns of information. Now you are ready to move the
headings, and fields, labels, static text (column headings), and separating lines to their proper locations

separating lines ~ on the frame.
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How to arrange
the line no. column

How to arrange
the prod ID
column

How to arrange
the code type
column

Arranging the Line Items Fields

Use this procedure to arrange the Line No. column on the PO1 frame.

Step Action
1 Select the Line field label and drag it to the upper left corner on the frame.
2 Select the No. static text and drag it below the Line field label.
3 Select the first separating line you added (six hyphens) and drag it below
the No. static text.
4 Select the Line field and drag it below the separating line you just moved.

Use this procedure to arrange the Prod ID column on the PO1 frame.

Step Action
1 Select the Prod ID field label and drag it to the right of the No. static text.
2 Select the second separating line you added (twelve hyphens) and drag it
below the Prod ID field label.
3 Select the Prod ID field and drag it below the separating line you just
moved.

Use this procedure to arrange the Code Type column on the PO1 frame.

Step Action
1 Select the Code field label and drag it to the right of the Prod ID field
label (but in the same row as the Line field label).
2 Select the Type static text and drag it below the Code field label.
3 Select the third separating line you added (four hyphens) and drag it
below the Code field label.
4 Select the Code field and drag it below the separating line you just moved.
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How to arrange
the Qty Ord
column

How to arrange
the Unit column

How to arrange
the Price Each
column

Creating a Print Form

Use this procedure to arrange the Qty Ord column on the PO1 frame.

Step Action
1 Select the Qty field label and drag it to the right of the Code field label.
2 Select the Ord static text and drag it below the Qty field label.
3 Select the fourth separating line you added (eight hyphens) and drag it
below the Ord static text.
4 Select the Qty field and drag it below the separating line you just moved.

Use this procedure to arrange the Unit column on the PO1 frame.

Step Action
1 Select the Unit field label and drag it to the right of the Ord static text.
2 Select the fifth separating line you added (four hyphens) and drag it below
the Unit field label.
3 Select the Unit field and drag it below the separating line you just moved.

Use this procedure to arrange the Price Each column on the PO1 frame.

Step Action
1 Select the Price field label and drag it to the right of the Unit field label
(but in the same row as the Qty field label).
2 Select the Each static text and drag it below the Price field label.
3 Select the sixth separating line you added (eleven hyphens) and drag it
below the Each static text.
4 Select the Price field and drag it below the separating line you just moved.
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How to arrange
the Requested Ship
Date column

How to arrange
the Ship No later
column

How to move the
Description field

Arranging the Line Items Fields

Use this procedure to arrange the Requested Ship Date column on the PO1 frame.

Step Action

1 Select the Requested field label and drag it to the right of the Price field
label.

2 Select the Ship Date static text and drag it below the Requested field
label.

3 Select the seventh separating line you added (ten hyphens) and drag it
below the Ship Date static text.

4 Select the Requested field and drag it below the separating line you just
moved.

Use this procedure to arrange the Ship No Later column on the PO1 frame.

Step Action

1 Select the Ship No field label and drag it to the right of the Requested
field label.

2 Select the Later static text and drag it below the Ship No field label.

3 Select the eighth separating line you added (ten hyphens) and drag it
below the Later static text.

4 Select the Ship No field and drag it below the separating line you just
moved.

The Description field is not placed in a column. Rather, this field is placed below the other
fields on the PO1 frame.

Step

Action

1

To move the Description field, click and drag it below the last row of
fields.
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How to resize the You should resize the PO1 frame to eliminate unnecessary space resulting from arranging
PO1 frame the fields on the frame.

Step

Action

1

To resize the frame, click and drag the bottom of the frame to just below
the Description field.

The PO1 frame now should look like this:

Line Code Qty Price Requested Ship No X
HNo. Prod ID Type ord Unit Each Ship Date Later
I I A i B | O | |

| %

How to align rows  One of the remaining tasks in formatting the print form is to align the fields, field labels,
and static text. First, you align the items in rows to give the form a consistent appearance.
You align the items in columns later in this tutorial.

Use this procedure to align the fields, field labels, and static text by row (horizontally).

Step

Action

1

Select the following field labels and static text:

» Line
» Code
» OQty

» Price

» Requested
» Ship No
Note

To select a group of items, click and drag the mouse diagonally across all
the items you want to select.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected field labels and static
text are aligned in a row.
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(Contd)
Step

Action

3

Select the following field labels and static text:

» No.

» ProdID

» Type

» Ord

» Unit

» Each

» Ship Date
» Later

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected field labels and static
text are aligned in a row.

Select all the separating lines between column headings and fields.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected static text are aligned in
a row.

Select the following fields:

» Line No.

» ProdID

» Code Type
» QtyOrd

» Unit

» Price Each
» Requested Ship Date
» Ship No Later

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields are aligned in a
row.
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How to align Now, you align the fields, field labels, and static text in columns to help give the form a
columns consistent appearance.

Use this procedure to align the fields, field labels, and static text in columns.

Step

Action

1

Select the Line No. column heading, its separating line, the Line No.
field, and the Description ficld.

Note
To select a group of items, click and drag the mouse diagonally across all
the items you want to select.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

Select the Prod ID column heading, its separating line, and the Prod ID
field.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

Select the Code Type column heading, its separating line, and the Code
Type field.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

Select the Qty Ord column heading, its separating line, and the Qty Ord
field.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

Select the Unit column heading, its separating line, and the Unit field.

10

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

11

Select the Price Each column heading, its separating line, and the Price
Each field.

12

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

13

Select the Requested Ship Date column heading, its separating line, and
the Requested Ship Date field.

14

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.
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Step

Action

15

Select the Ship No Later column heading, its separating line, and the
Ship No Later field.

16

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The selected items are left-aligned in a column.

The PO1 (Baseline Item Data) frame now should look like this:

Line Code Qty Price Requested Ship No £
No. Prod ID Type ord Unit Each Ship Date Later
C I 100 | L L |

| v

Creating the Line  You have completed formatting the Line Items frame so that the line item information is
Items frame displayed in columns and rows. If you were to register the translation object now with
without column Gentran:Server and run EDI data through the translation object, then you would see that
headings the column headings would be repeated for every line item.

The column headings need to be printed on the printout only once, so you copy and paste
the PO1 group to create a second PO1 group (named PO1:2). The formatting in the PO1
group is retained in the PO1:2 group. You change the maximum use of the first PO1 group
to one (so that the column headings are printed only once). Then, you remove the column
headings in the PO1:2 group from the area that is printed, leaving only the fields for
printing the information on the printout.

In addition, you change the maximum use of the PO1:2 group to 99,999. Your partner can
send you up to 100,000 line items, so the total maximum use of both PO1 groups does not
need to exceed 100,000. The maximum use of the PO1:2 group is changed to 99,999.

How to copy and  Use this procedure to copy and paste the PO1 group.

Action

Select the PO1 group.

paste the PO1
group
Step
1
2

Click Copy on the Main Toolbar.
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(Contd)
Step

Action

3

Select Paste on the Main Toolbar to paste the PO1 group after the existing
POI1 group. Gentran:Server prompts you to specify whether you want the
contents of the clipboard pasted as a child (subordinate) of the selected
group, or at the same level as the group.

Gentran Forms Integration E
The contents of the clipboard can be pasted as follows:

9 Paste Option: Cancel |

¥ Paste as a child of selected iter

" Paste after selected item [at the same lewel]

Click the Paste after selected item (at the same level) option to paste the
Clipboard contents after the original PO1 group.

Click OK to exit the dialog. The pasted PO1 group is renamed PO1:2.

maximum use of

Use this procedure to change the maximum use of the PO1 group.

the PO1 group Step

Action

1

Click the PO1 group with the right mouse button to access the shortcut
menu.

Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

In the Max Usage box, enter 1 to indicate that this group can be used only
once in each purchase order.

Click OK to exit the Group Properties dialog.
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How to change the  Use this procedure to change the maximum use of the PO1:2 group.
maximum use of

the PO1:2 group Step Action
1 Click the PO1:2 group with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

3 Select the Looping tab.

4 In the Max Usage box, enter 99999 to indicate that this group can be used
up to 99,999 times in each purchase order.

5 Click OK to exit the Group Properties dialog.

How to move the Use this procedure to move the column headings on the second Line Items frame (PO1:2)
PO1:2 column  below the print area, so the headings are not printed.
headings below the

print area

Step Action
1 Click Generate Layout on the Main Toolbar to refresh the display of the
print form.
2 Select the PO1:2 group. Its corresponding frame is displayed in the
Layout Window.
3 Select all of the column headings and separating lines on the frame, and

drag them below the bottom of the frame so they are not displayed. These
items are still included in the print form, but they are not printed on the
printout.

Note
To select more than one field label or static text, click and drag the mouse
diagonally across all the items you want to select.

4 Select all of the fields on the frame, and drag them to the top of the frame.
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Step

Action

5

To resize the frame, click and drag the bottom of the frame to just below
the Description field.

CAUTION

SELECT SAVE FROM THE FILE MENU TO SAVE THE
FORM, BECAUSE YOU HAVE COMPLETED THE FORM
AND YOU ARE READY TO COMPILE THE FORM.

The PO1:2 frame now should look like this:

L Lo [ -

| .
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Resizing the Transaction Total Frame

Overview  The Number of Line Items field (CTT Group group) for the purchase order is contained
on a separate frame than the rest of the purchase order information because this field
contains summary information that you want to be printed at the bottom of the translation

object.

You resize the Transaction Total (CTT Group) frame to give it the same width as the other
frames in the purchase order.

Procedure  Use this procedure to resize the following steps to resize the Transaction Total frame.

Step

Action

1

Click the CTT_Group group to display the Transaction Total
(CTT_Group) frame in the Layout Window.

Click and drag the right side of the frame to the 20 cm. mark on the
horizontal ruler (a form with a width of 20 cm. can be printed on an
8 1/2” x 117 sheet of paper).

Click and drag the bottom of the frame to just below the Number of Line
Items field.

Select Save from the File menu. The CTT_ Group frame now should look
like this:

-+
Number Of Line Items |:| E‘

You have completed your Purchase Order form and you are ready to compile the form.

Forms Integration ANSI Tutorial Guide

Gentran:Server for Windows — August 2008 (



Overview Creating a Print Form

Finalize the Form

Overview

Introduction Now that you have created and customized the print form, you are ready to compile the
form to generate the translation object (*. TPL) that Gentran:Server uses before you print
the report and test the compiled translation object.
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Compiling the Form

Overview  The Compile function compiles the form. The form that you create using Gentran:Server
is a source form. When that source form is compiled, the result is a compiled translation

object.

This translation object must be registered with the Gentran:Server system before you can
use it. Use the Compile function after the form is completed and saved.

Procedure  Use this procedure to compile the form.

Step

Action

1

Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.

CAUTION

Run-Time Translation DObject Mame
Save jn: |¢3 Trans0Obj j | EFl 5o

File narme: Ipet_SEDp.TF'L

Save az upe; ITransIation Objects [* TPL] ﬂ Cancel |
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Step Action
2 Click Save to accept the translation object name (pet_850p.tpl) in the File
name box.
This name for the compiled translation object (.TPL file) is the same file
name as the source form (.STP file). Preserving the same file name (with
different file extensions) ensures that the relationship between the source
form and the compiled translation object remains evident.
System Response
The system compiles the form and generates an error report. The error
report is displayed in the Compile Errors dialog.
Compile Errors [ [5] x|
Compiling loop 1TD
Compiling loop 0200_M1
Compiling loop N3
Compiling loop MEW_M4
Compiling loop 0300_P0O1
Compiling loop 0300_P0O7:3
Compiling loop 0300_P0O1:2
Cormpiling loop CTT_Group
Compilation complete, O erors, 0 warnings.
3 Click OK to exit the Compile Errors dialog.
Note
If the Compile Errors dialog contains errors, you must fix the problems by
redoing the appropriate section of the tutorial. Recompile the form after
you correct the errors and save the form.
4 Select Save from the File menu to save the form.
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Printing the Report

Overview  The Gentran:Server report enables you to validate and review the translation object, and
make modifications as needed. If you review the report and determine that the translation
object is incorrect, you should reiterate the form creation process as many times as
necessary (make the modifications, save the form, recompile the form, and print the report
again).

Procedure  Use this procedure to print the Gentran:Server report.

Step Action

1 Select Print from the File menu to access the Print Options dialog.

System Response
The Print Options dialog is displayed

Print Options E

Repart zections

¥ Print branching diagram

¥ Prirt record details Cancel |

¥ Prirt extended rules

™ Frirt code lists

¥ Include only active objects

2 Click OK to accept the defaults on this dialog (all options checked), so the
report includes all sections and only the activated form components.

System Response
The Print dialog is displayed.

3 Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» Ifyes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» Ifno, click OK to begin the print process.
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Testing the Translation Object

Overview  Before you can use the ANSI 850 Pet Zone print translation object, you must test the
translation object to verify that there are no errors in it. To test the translation object, you
must have a file containing test data. For this tutorial, you use the PETTEST2.INT test

file.

Procedure  Use this procedure to test the print translation object you just created.

Step

Action

1

Register the PET_850P.TPL translation object with Gentran:Server.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on registering a translation object.

Import the PETZONE.PAR partner relationship into Gentran:Server.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on importing a partner.

The default path for the partner is:
CA\GENSRVNT\TUTORIAL\PETZONE4.PAR

Verify (in Partner Editor) that the Print 850 Pet Zone print translation
object is selected for the Inbound Relationship.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on selecting inbound translation objects.

Use the Process File option in Gentran:Server to process the data file
(PETTEST2.INT) through the translation object. The data file is located
in the TUTORIAL subfolder under the folder where Gentran:Server is
installed.

The default path for the data file is:
C:\GENSRVNT\TUTORIAL\PETTEST2.INT

After the document is translated, it is located in the In Documents in
Gentran:Server. Print the document to ensure that the document was
translated correctly and that the printout looks the way you want it to look.

Reference
See the User s Guide for more information on printing documents.
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Overview

Introduction

In this chapter This tutorial defines the tasks necessary to create a screen entry form. A screen entry form
is a predesigned layout that, when compiled into a translation object, enables users in your
company to easily enter the data necessary to create a business document.

This chapter includes the following topics associated with creating a screen entry form:
» Form analysis

» Creating, saving, and setting up a new form

» Customizing the form, including the groups, segments, and elements

» Formatting the form, including fields and field labels

» Finalizing the form

Form criteria Gentran:Server generates a basic form based on the following criteria you specify:
» Type of form (e.g., print or screen entry)
» Standard agency (e.g., ANSI X12, EDIFACT)
» Standard version (e.g., 003040, 90.1)
» Document type (e.g., 810 INVOICE, INVOIC)

Mandatory  All mandatory groups, segments, and elements for the standard, version, and transaction

components set you specify are available for use (activated) when Gentran:Server creates a form. Only
these mandatory form components (groups, segments, and elements) are activated
automatically. You must activate additional form components that you want to be
displayed in the screen entry form, and then customize and format the form so that it is
appropriate and useful for your company’s needs.

Before you begin  Before you begin to customize a screen entry form, you should be familiar with the
following elements of form design:

» EDI standards (how EDI standards work and how the information your users need is
translated to and from the standards)

» Your users (the individuals who are using the screen entry forms to enter EDI data)

»  Your trading partners (the organizations receiving the EDI data that your users enter
in the screen entry form)
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Before you begin You can create a different screen entry form for each combination of transaction set,
(contd) trading partner, and standard version. There is no limit to the number of screen entry forms
you can create, and the number of screen entry forms you create is not affected by the
number of print forms you create.

Recommendation

We recommend that you mock up a layout of the screen entry form the way you ultimately
want it to look. As you are designing the layout, you should take into consideration the
people who are using the translation object. Make sure that the form makes sense to the
people who are using it. By analyzing your company’s needs before you actually create
the screen entry form, you reduce the amount of time spent later on redesigning or
reformatting the form.
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Phases of Designing a Form

Design phases  This table lists the phases of form design.

Phase Description
1 Analyze the EDI file.
1 Design and creating the form.
2 Modify the form components.
3 Customize the EDI data.
4 Format the form.
5 Finalize the form.
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Getting Started

Overview

Screen entry form

scenario

This tutorial is meant to be completed in its entirety. We strongly recommend that you
complete each task sequentially. The purpose of completing each task in this tutorial in
sequential order, as if it were your own scenario, is not only to teach you how to perform
the individual tasks, but also to teach you a logical approach and methods that should be
used when you create your own form.

This section guides you in completing the steps in the first phase of form design. In this
section, you create a new screen entry form based on a scenario we have defined for you.
This section includes the basics of creating the form, such as defining the scenario and
analyzing the purpose of the form, creating and saving the form, and setting up the form.
You can find techniques for customizing the segments, elements, and groups in the form,
as well as for formatting the organization and appearance of the form, later in this chapter.

For this tutorial, you create a screen entry form for the 810 transaction set (invoice), using
the ANSI X12 003040 standard. The steps involved in creating this form are broken down
into manageable pieces so that you can learn the tasks and procedures involved in creating
a screen entry form. Then, you can apply the knowledge gained from using this tutorial to
create your screen entry forms.

In this scenario, your company is MWT Manufacturing Co., which manufactures a wide
variety of pet supplies for pet stores. One of your trading partners, Pet Zone (a large pet
supply retailer), orders products from your company. Your company then invoices Pet
Zone for those products. You create a form that your data entry users will use to enter EDI
data for the invoice that you send to Pet Zone. From discussions with Pet Zone, you know
the requirements for the invoices that they receive from you.
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Analyze the EDI File

Basic Tasks

Introduction

Form analysis

To analyze the EDI file, first you must determine what data you need to send your trading
partner and what data your trading partner expects to receive. It is important to analyze the
data in this way so that the invoice contains all the necessary information, and so that your
company can bill your partner correctly for the order you shipped to them. You and your
partner must agree on which standard, version, and transaction set you are using. In this
tutorial, you are using an ANSI X12 version 003040 810 invoice. It is important to know
the information your partner expects you to send in the invoice, and what data is contained
in each element used.

It is very helpful to review the EDI standard that you are using before analyzing the EDI
file. We recommend that you obtain an EDI standard manual for the standard and version
that you are using. Standard manuals are available from EDI standard agencies.

After discussing with your partner what you are sending, determining which segments and
elements your partner requires, and reviewing the EDI standard, you can list the items that
you must use (activate). When Gentran:Server generates the EDI file format, the system
includes all the groups, segments, and elements that are defined by the standard agency for
the version of the document you selected. The system activates all the groups, segments,
and elements that are defined as mandatory (must be present) by the standard. The system
does not enable you to deactivate mandatory groups, segments, and elements.

The first step in creating a form is the analysis of the form requirements. If the analysis
you perform is complete, you have all the information you need to create the form in an
efficient and logical manner. If you omit this critical step and proceed directly to creating
the form, it is likely that creating the form is a much longer and arduous task, and the form
may not work the way you need it to, due to oversights and omissions.

Creating a screen entry form for the ANSI X12 810 invoice requires several steps. Some
steps are performed at the document level (such as activating form components), and
others are iterative steps that are performed for each group, segment, or element in the
form. In this analysis phase, you must determine what EDI data you are sending Pet Zone,
as well as what information Pet Zone requires to process the invoice. The fields on the
form must account for all information that you expect to send to Pet Zone.
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Mandatory
components

Required
components

Creating a Screen Entry Form

This table lists the following groups, segments, and elements have been defined as
mandatory by the standard committee for an ANSI X12 invoice (810). These components
are activated automatically when you create a new form.

Segment Element Description Data Type| Length
BIG Beginning Segment for
Invoice
BIGO1 Invoice Date Dt/Tm 6
BIG02 Invoice Number String 22
TDS Total Monetary Summary
TDSO01 Total Invoice Amount Real 10
CTT Transaction Totals
CTTO1 Number of Line Items Integer 6

When translating data, the system does not process groups, segments, and elements that
are not activated. Therefore, you must make available (activate) the groups, segments, and
elements that are not defined as mandatory by the standard, but that you have determined

that you need to use in the form.

This table lists the form components that are required (need to be activated) and are not
mandatory for the standard for this tutorial.

Note

When you activate a conditional group or segment, the mandatory subordinate segments
and elements are activated automatically. A conditional group or segment is used only if
there is EDI data available for an element contained in it.

Code Value/Format to
Element Description Data Type| Length Be Assigned
Beginning Segment for Invoice (BIG Segment) (Already Activated)
BIG03 Purchase Order Date Dt/Tm 6
BIG04 Purchase Order Number | String 22
Reference Numbers (REF Segment)
REF01 Reference Number String 2 CT (Contract Number)
Qualifier
REF02 Reference Number String 30
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Basic Tasks
(Contd) Code Value/Format to
Element Description Data Type| Length Be Assigned
Name and Address (N1 Group)
Name (N1 Segment)
N101 Entity Identifier Code String 2 » ST (Ship To)
» RT (Remit To)
N102 Name String 35
Address Information (N3 Segment)
N301 Address Information String 35
N302 Address Information String 35
Geographic Information (N4 Segment)
N401 City String 30
N402 State or Province Code | String 2
N403 Postal Code String 9
Terms of Sale/Deferred Terms of Sale (ITD Segment)
ITDO1 Terms Type Code String 2 Any valid code
Date/Time Reference (DTM Segment)
DTMO1 Date/Time Qualifier String 3 090 (Contract Effective)
DTMO02 Date Dt/Tm 6
Baseline Item Data (IT1 Group)
Baseline Item Data (Invoice) (IT1 Segment in the IT1 Group)
IT101 Assigned Identification | String 11
1T102 Quantity Invoiced Real 10
1T103 Unit or Basis for String 2 Any valid code
Measurement Code
IT104 Unit Price Real 14 Format = R2
IT106 Product/Service ID String 30
1T107 Product/Service ID String 2 UP (UPC Consumer
Qualifier Package Code)
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(Contd) Code Value/Format to
Element Description Data Type| Length Be Assigned
Product/Item Description (PID Group in the IT1 Group)
Product/Item Description (PID:2 Segment in the PID Group)
PID:201 Item Description Type String 1 F (Free-Form
Description)
PID:205 Description String 80
Date/Time Reference (DTM:2 Segment in the IT1 Group)
DTM:201 | Date/Time Qualifier String 3 011 (Date Shipped)
DTM:202 | Date Dt/Tm 6
Carrier Detail (CAD Segment in the IT1 Group)
CADO1 Transportation Method/ | String 2 Any valid code
Type Code
CADOS Reference Number String 30

Segment analysis

» Does the segment have a maximum use greater than one?

» What elements need to be activated for the segment?

For each segment activated (either mandatory or optional), you must ask the following
questions:

» This table describes the segment components used in this tutorial.

Component

Description

Group

Contains related segments and/or groups that repeat
in sequence until either the group data ends or the
maximum number of times that the loop is allowed

to repeat is exhausted.

Repeating segment

Consists of elements that repeat (in sequence) until
either the segment data ends or the maximum
number of times the segment is allowed to repeat is

exhausted.
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Component

Description

Maximum use

Refers to the number of times that a segment can be
used within the structure in which the segment is
defined. For example, if a segment can be used only
once within a group, but the group can be used
multiple times, the segment still has a maximum
use of one within each occurrence of the group. The
standard defines the maximum number of times a
segment can be used, but you must determine how
many times a segment is used, based on what you
are sending your trading partner.

Elements

Some elements are mandatory and others are
optional to the standard but necessary for your
needs. You must define all the elements that you are
sending Pet Zone for each segment.

Customization

Gentran:Server generates a form based on the groups, segments, and elements you

tasks activate. At this point, the form is compliant with the standard and it contains all the
necessary components based on the data you send Pet Zone. However, you need to
customize the form components to produce a form that is easy to use to enter data in a

logical manner.

This table lists the customization tasks described in this tutorial.

Form Component Description

Customization Task

BIGO1 element Invoice Date

Your users enter the date in the format “MM/DD/YY,”
but the date in the EDI data should be in the format of
“YYMMDD,” so you set the format accordingly.

BIGO03 element Purchase Order

Your users enter the date in the format “MM/DD/YY,”

Date but the date in the EDI data should be in the format of
“YYMMDD,” so you set the format accordingly.
REF segment Reference The standard allows this segment to be used up to
Numbers twelve times, but you and your trading partner have

decided to use this segment only once. Therefore, you
change the maximum use of this segment to one.
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(Contd)
Form Component

Description

Customization Task

REFO01 element

Reference Number
Qualifier

The only type of reference number that you use is the
contract number, so you do not need to load the entire
code list table. You define a constant value in this field
designating the type of number (contract number) you
expect your users to enter. Then, you prevent this field
from being displayed in the screen entry form, because
the value for this field (“CT” for contract number) is
entered automatically.

N1 group

Name and Address

The standard allows this group to be used up to two
hundred times, but you and your trading partner have
decided to use two iterations of this segment and use
each iteration once: one iteration is for the Ship To
name and address, and one iteration is for the Remit To
name and address. You promote this group twice so that
one iteration of the N1 group is used for the Ship To
name and address and another N1 group is used for the
Remit To name and address. Then, you use the key field
function to ensure that only the Ship To name and
address are displayed in the first N1 group, and only the
Remit To name and address are displayed in the second
N1 group.

N3 segment in the
N1 group

Address
Information

The standard allows this segment to be used up to two
times for each occurrence of the N1 group. You need
this segment to be used only once for each name and
address, so you change the maximum use of this
segment to one.

N101 element in
the Ship To
address

Entity Identifier
Code

The only type of entity identifier code that you use in
this element is the Ship To name, so you do not need to
load the entire code list table. You define a constant
value in this field designating the type of name (Ship To
name) you expect your users to enter. Then, you prevent
this field from being displayed in the screen entry form,
because the value for this field (“ST” for Ship To name)
is entered automatically.

N101 element in
the Remit To
address

Entity Identifier
Code

The only type of entity identifier code that you use in
this element is the Remit To name, so you do not need
to load the entire code list table. You define a constant
value in this field designating the type of name (Remit
To name) you expect your users to enter. Then, you
prevent this field from being displayed in the screen
entry form, because the value for this field (“RI” for
Remit To name) is entered automatically.
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Form Component Description

Customization Task

Terms of Sale/
Deferred Terms of
Sale

ITD segment

The standard allows this segment to be used up to five
times in one invoice to specify the terms under which
this invoice is valid. You need this segment to be used
only once for each invoice, so you change the maximum
use of this segment to one.

ITDO1 element Terms Type Code

Your users can enter any of the terms type codes that the
standard designates as valid codes. You load the entire
code list for this element, which creates a list containing
valid codes from which users can select.

Date/Time
Reference

DTM segment

The standard allows the date to be used up to ten times.
You use the DTM segment only once (for the contract
date), so you change the maximum usage of the DTM
segment.

DTMO1 element Date/Time

Qualifier

The only type of date that you use in the DTM segment
is the contract date, so you do not need to load the entire
code list table. You define a constant value in this field
designating the type of date (contract date) you expect
your users to enter. Then, you prevent this field from
being displayed in the screen entry form, because the
value for this field (“090” for contract date) is entered
automatically.

DTMO02 element Date

Your users enter the date in the format

“MM/DD/YY,” but the date in the EDI data should be in
the format “YYMMDD,” so you set the format
accordingly.

IT101 element Assigned

Identification

You use an accumulator for this element to count line
items in the invoice. This accumulator is used in the
Number of Line Items element (CTTO1) to calculate the
total number of line items in the invoice.

IT102 element Quantity Invoiced

You use an accumulator for this element to calculate a
running total of the invoice amount, which is used to
calculate the total invoice amount. This accumulator is
used in the Total Invoice Amount element (TDSO01) to
identify the total dollar amount invoiced.

Unit or Basis for
Measurement
Code

IT103 element

Your users can enter any of the unit codes that the
standard designates as valid codes. You load the entire
code list for this element, which creates a list containing
valid codes from which users can select.
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Form Component

Description

Customization Task

IT104 element

Unit Price

Both the EDI data and the data that your users enter in
the screen entry form should be formatted with an
explicit decimal point and two decimal places. Also,
you use an accumulator for this element to calculate the
total dollar amount of the invoice. This accumulator is
used in the Total Invoice Amount element (TDSO01) to
identify the total dollar amount invoiced.

IT106 element

Product/Service
ID Qualifier

The only type of qualifier that you use in this element is
the UPC code for the item, so you do not need to load
the entire code list table. You define a constant value in
this field designating the type of qualifier (UPC code)
you expect your users to enter. Then, you prevent this
field from being displayed in the screen entry form,
because the value for this field (“UP” for UPC code) is
entered automatically.

PID group in the
IT1 group

Product/Item
Description

The standard allows this group containing line item
information to be used up to two thousand times in one
invoice. Your users complete the fields in this group
only once per invoiced item, so you change the
maximum use of this segment to one.

PID:201 element
in the IT1 group

Item Description
Type

The only type of item description that you use in this
element is a free-form description for the item, so you
do not need to load the entire code list table. You define
a constant value in this field designating the type of
description (free-form) you expect your users to enter.
Then, you prevent this field from being displayed in the
screen entry form, because the value for this field (“F”
for free-form description) is entered automatically.

DTM:2 segmentin | Date/Time The standard allows the date segment to be used up to

the IT1 group Reference ten times for each invoiced item. Your users complete
the fields in this segment only once per invoiced item.
You change the maximum use of this segment to one,
which places the Date/Time Reference fields on the
same frame as the rest of the line item fields.

DTM:201 element | Date/Time The only type of date that you use in the DTM:2

in the IT1 group Qualifier segment is the date shipped, so you do not need to load

the entire code list table. You define a constant value in
this field designating the type of date (date shipped) you
expect your users to enter. You then prevent this field
from being displayed in the screen entry form, because
the value for this field (“011” for date shipped) is
entered automatically.
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in the IT1 group

(Contd)
Form Component Description Customization Task
DTM:202 element | Date Your users enter the date in the format

“MM/DD/YY,” but the date in the EDI data should be in
the format “YYMMDD,” so you set the format
accordingly.

CAD segment

Carrier Detail

The standard allows this segment to be used up to
999,999 times for each line item. Your users use the
fields in this segment only once per invoiced item. You
change the maximum use of this segment to one (which
places the Carrier Detail fields on the same frame as the
rest of the line item fields).

CADO1 element

Transportation
Method/Type
Code

Your users can enter any of the transportation type
codes that the standard designates as valid codes. You
load the entire code list for this element, which creates a
list containing valid codes from which users can select
when completing a screen entry form.

TDSO01 element

Total Invoice
Amount

You use an accumulator to generate a running total of
price (obtained by multiplying the quantity invoiced for
each line item by the unit price) for this element.

CTTO1 element

Number of Line
Items

You use an accumulator to generate a total of the
number of line items in the invoice for this element.
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Design and Create the Form

Verifying the Global EDI Date Formats

Introduction The Forms Integration subsystem enables you to customize the global EDI date formats
(for all forms). You can specify the default EDI format of dates for both six-character
dates and eight-character dates. When you customize the global EDI date formats, the
settings are valid for all forms created in the current session of Gentran:Server. However,
you can override the default date formats for an individual element on the Element
Properties dialog for that element.

You must verify that you are using the correct global date formats the first time you use
Gentran:Server. Typically, you verify the global EDI date formats one time only. You can
change the default date formats if they do not match the formats you intend to use.

Procedure  Use this procedure to verify the global EDI date formats.

Step

Action

1

Launch the Forms Integration subsystem.

Reference
See How to Launch Forms Integration on page 1 - 11 for step-by-step
instructions.

Select Preferences from the Options menu to display the Preferences
dialog. The Preferences dialog is a property sheet that enables you to set
global defaults for Gentran:Server.

Select the Standard Formats tab.

Verify that the Standard Formats tab displays the default date formats that
are used when elements are read from the standards database.

Verify that the Six-character dates drop-down list box contains
YYMMDD to define the format of the six-character EDI dates in your
forms.

Verify that the Eight character dates list contains YYYYMMDD to
define the format of the eight-character EDI dates in your forms.
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(Contd)
Step

Action

7

Click OK to accept the default date formats for 6- and 8-character date
fields and exit the Preferences dialog.

Note

To change the order in which the date formats appear in the Six-character
dates and Eight character dates lists or to add a new date format to the
lists, select Date Formats from the Options menu.
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Defining the Type of Form

Overview  The first task in creating a new form is to define the type of form and EDI standard,
version, and transaction set (document). In this tutorial, you are creating a screen entry
form so that your data entry users can enter EDI data in an invoice translation object in
Gentran:Server. Instead of defining the 850 (Invoice) transaction set to the system
yourself, you want Gentran:Server to use the standards database on your system to build
the invoice according to the ANSI X12 standard.

Before you begin  Before you begin this procedure, verify that you have installed the Gentran standards.

Reference
See How to Install Gentran Standards on page 1 - 12 for instructions.

Procedure  Use this procedure to create the new screen entry form.

Step Action
1 Select New from the File menu to display the New Form Wizard.
2 From the What kind of form are you creating list, select Screen Entry to

indicate that the translation object that your are creating is a Screen Entry
translation object.

3 In the What is the name of the form box, enter Screen 810 Pet Zone. This
description provides a brief explanation of the compiled translation object
that enables you to differentiate it from similar translation objects in
Gentran:Server.

Example
Screen 810 Pet Zone is the description of a screen entry translation object
for an ANSI X12 Invoice (810) for partner Pet Zone.

4 Verify that the name that is displayed in the What is your name box is
accurate.

5 Click Next to advance the wizard.

6 Select Delimited EDI as the data format syntax that you want to use.

7 Click Customize.

System Response
The New Delimited EDI Wizard is displayed.

8 Click Next to continue.
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Step Action

9 From the Data Source list, select the ODBC data source that you wish to
use.

10 Click Next to continue.

11 From the Agency list, select [X] X12, which is the EDI standard you are
using for this translation object.

12 From the Version list, select [003040] ANSI X 12 VERSION 3
RELEASE 4, which is the version of the standard you are using for this
translation object. The versions that are available depend on which
standard you selected.

13 From the Transaction list, select [810] INVOICE, which is the transaction
set (document) you are using for this translation object. The documents
that are available depend on which standard and version you selected.

14 Click Next to continue.

15 Click Finish.

16 Click Next to continue.
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Step

Action

17

Click Finish to create the EDI file This may take a few seconds.

System Response
The form is displayed.

Z IGentran Forms Integration - [Screen 810 Pet Zone] HE B
% File Edit Functions Yiew Display Options Window Help =& x|
Dle(d| =l 2 =EELE =] oo mElalsiz] s

EAEI0-M - 1INWOICE
FCOBIG - - 1 BEGINNING SEGMENT FOR INVOICE

LOICTT - M- 1 TRANSACTION TOTALS

| | |
For Help, press F1 NLIM

After you create a new form, it is important to define the details of the
form and save it.

Recommendation

We recommend that you save the form as often as possible, to mitigate the
possible loss of additions or modifications in the event of a hardware or
system error.

18

From the Edit menu, select Details.

System Response
The Translation Object Details box is displayed.

19

Verify that Screen Entry is selected in the Translation Object Function
list.

20

In the Major version box, enter 1 to designate the version number for this
translation object.

(Continued on next page)
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Action

21

In the Minor version box, accept the default value 0 that designates the
release number for this translation object.

Recommendation

When you make a major change to this form, increase the version to the
next higher sequential number (e.g., 2.0, 3.0). If you make a minor change
to the form, increase the release to the next higher sequential number (e.g.,
2.1,2.2).

22

The Input and Output boxes (Agency, Version, Transaction, Release, and
F Group) contain information only if the Input and/or Output sides of the
form are of EDI format. For this tutorial, do not change the information in
these boxes.

Note

The system allows you to change the information in the Input and Output
boxes, but modifying this information does not alter the content of the
form. An example of when you might want to alter these boxes is when
you want the form to reflect a standard version that is not loaded on your
system. You can change the version on this dialog, and then physically
alter the form to be compliant with that version.

23

Click OK to save the translation object details.

24

Select Save from the File menu.

System Response
The Translation Object Details dialog is displayed.

Note

If you have performed any function that invalidates the current format of
the translation object, the Save function is not available (dimmed) until
you regenerate the layout (click Generate Layout on the Main Toolbar).

25

Verify that the Save in list reflects the drive\folder where Gentran:Server
is installed.

The default is GENSRVNT\Forms.
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Action

26

In the File name field, enter pet_810s.stp to replace the default file name.
You allocate a file name to a form when you save the form for the first
time or use the Save As function to save a copy of the form under a
different name. The name of the form must be one to eight unique
characters that define the form in a meaningful way. For example,

PET 810S is the name of a screen entry form for an ANSI X12 3040
invoice (810) for partner Pet Zone.

Note

The default file extension for forms is .STP. Using this extension
distinguishes source form files from other types of files, such as compiled
translation objects. The naming conventions in Gentran:Server are as
follows:

» The source form (form created in Gentran:Server) should be named
using the file extension .STP (e.g., PET_810S.STP).

» The compiled translation object (translation object that is the result of
compiling the source form) should be named using the same file
name that was allocated to the source form, but with the file extension
.TPL (e.g., PET 810S.TPL).

Recommendation

We recommend that you use these naming conventions to distinguish
source forms and compiled translation objects from other types of files.
We also recommend that you use the same file name (different file
extension) for a source form and the translation object that was compiled
from it.

27

Click Save to save the form.
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Activating Groups, Segments, and Elements

Overview

Example

Groups, segments,
composites,
elements used in
this tutorial

Forms Integration ANSI Tutorial Guide

When Gentran:Server generates the form, the system includes all the groups, segments,
and elements that are defined by the standard agency (ANSI) for the version (003040) of
the transaction set (810) you selected. The system activates all the groups, segments, and
elements that are defined as mandatory (must be present) by the standard. The system does
not enable you to deactivate the mandatory groups, segments, and elements.

In the example below, the 810 INVOICE file icon and BIG segment are mandatory for the
invoice. You do not need to activate these components. The NTE, CUR, and REF
segments are not mandatory, so they are dimmed on the form. To view the segments and
elements in a group or segment on your form, double-click the form component in the EDI
File Format Window (left side of the Forms main window). To activate an inactive form
component, click Activate on the Main Toolbar, then click the form component. The
component is no longer dimmed.

E=A810-M - 1INVDICE
[CIBIG -M - 1 BEGINNING SEGMENT FOR INVOICE
.
.
O

When translating data, the system does not process groups, segments, and elements that
are not activated. Therefore, you must activate the groups, segments, and elements that are
not defined as mandatory by the standard, but that you have determined that you need to
use in the form.

This table lists the Groups, segments, composites, elements to be used in this tutorial.

Group Segment Element
BIG (already BIGO03
activated)

BIG04
REF REF02

N1 N1 N102

N3 N302
N4 N401

N402

N403
ITD ITDO1
DTM DTMO02
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Group Segment Element
IT1 IT1 IT101
IT106
IT107
PID PID:2 PID:205
DTM:2 DTM:202
CAD CADO1
CADO8

Procedure Use this procedure to activate the required groups, segments, and elements.

CAUTION

Step

Action

Double-click the groups and segments listed in the previous table to open
them. This table lists all the groups, segments, and elements that you need
to activate. Opening all the necessary groups and segments before you
start to activate enables you to scroll down the form and activate the
segments and elements sequentially.

Note
When you activate a conditional group or segment, the mandatory
subordinate segments and elements are activated automatically.

Click Activate on the Main Toolbar.

Click each inactive group that you need to use. Clicking these groups
activates the groups.

Note

If you click a group, segment, or element that you did not mean to
activate, click the component with the right mouse button to access the
shortcut menu. Select Deactivate from the shortcut menu.

Click each inactive segment that you need to use. Clicking these segments
activates the segments.
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(Contd)
Step

Action

5

Click each inactive element that you need to use. Clicking these elements
activates the elements. When you activate an element in a screen entry
form, either the tag “Edit Box” or the tag “Drop Down” is displayed
before that element’s description. “Edit Box™ indicates that the element is
formatted as a field. “Drop Down” indicates that the element is formatted
as a list because you applied a standard rule that allows a selection of
multiple items.

Click Activate on the Main Toolbar to turn activation mode off.

Note
To hide the groups, segments, and elements that you are not using, select
Show Active Only from the View menu.

From the File menu, select Save to save your form.
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Verifying EDI Delimiters and Adding Frame Help Text

Overview

EDI delimiters

If you are using an EDI standard that contains composite elements or subelements, you
must define the EDI delimiters to Gentran:Server. Delimiters are flags that you define to
the system as sepa.rating specific EDI components. Delimiters are necessary for all
variable field-length standards, because the data is compressed (and the leading zeroes and
trailing blanks are removed). The fields vary in length, so the system needs a flag to
determine where one element ends and another begins. For example, an element delimiter
marks the beginning of a new element.

CAUTION

ALTHOUGH SETTING EDI DELIMITERS IN GENTRAN:SERVER IS
MANDATORY ONLY IF YOU ARE USING A STANDARD WITH
COMPOSITE ELEMENTS OR SUBELEMENTS, WE RECOMMEND
THAT YOU PERFORM THIS TASK REGARDLESS OF WHICH
STANDARD YOU USE.

In addition, you add frame Help text so screen entry translation object users can access
online Help for the Invoice Details frame

This table lists the default delimiters for ANSI X12.

ANSI X12 ANSI X12
Default Default Hex
Field Character Value

Tag Delimiter

Segment Delimiter ~ (tilde) 0X2A
Element Delimiter * (asterisk) 0X7E

Sub Element Delimiter : (colon) 0X3A
Decimal Separator

Release Character
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Verifying EDI Delimiters and Adding Frame Help Text

Procedure Use this procedure to add frame Help text and set EDI delimiters.

Step

Action

1

Click the 810 INVOICE file icon with the right mouse button to access
the shortcut menu and select Properties from the shortcut menu

System Response
The File Format Properties dialog is displayed.

File Format Properties E3
Mame | Displa_l,JI Delimitersl Loop Extended Hulesl

Flease enter the name :
|s1 0

Pleaze enter a short description :
INWOICE

QK I Cancel S Help

Select the Display tab.
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(Contd)
Step

Action

3

In the Frame Help Text list, enter the following text (press Enter at the
end of each line of text below):

This frame contains information pertaining
to the entire invoice document (810). For
online Help on an individual field on this
frame, select the field and press F1.

Note

Pressing Enter creates line breaks for the online Help that the screen entry
translation object users in Document Editor view when they press F1. If
you do not create line breaks, the online Help is displayed on one line of
text in the online Help pop-up window (the text does not wrap to the next
line), and text that extends beyond the width of the user’s monitor is not
displayed.

When you generate the form (display the fields in the Layout Window),
there is one frame in the Layout Window (right side of Forms main
window) for every group and repeating segment in the EDI File Format
Window (left side of Forms main window). Entering frame Help text for
the group or segment corresponding to each frame enables screen entry
translation object users to access context-sensitive Help text for the frame.

Select the Delimiters tab to access the Delimiters dialog.

Verify that the correct delimiters are being used for the ANSI X12 3040
standard. If the delimiters differ from the default values listed in the table
below, you can enter either the character or the hexadecimal value. The
default delimiters for ANSI X12 are listed in the previous table (the tag
delimiter, release character, and decimal separator are not used for ANSI).

Note
The hexadecimal value must begin with “0x” (that is, the number zero and
the letter “x™).

Note

The Stream segments check box on the Delimiters dialog currently is not
checked. For this tutorial, do not check this check box, so the translator
continues to insert a carriage return after every segment. If the Stream
segments check box is checked, then a carriage return is not used after
every segment, and the segments are “streamed.”

Click OK to save the delimiters and exit the Delimiters dialog.
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Modify Form Components

Promoting and Changing the Maximum Use of Segments and
Groups

Introduction The Promote function extracts one iteration (instance) of a group or repeating segment.
Promote is a specialized function that preserves the integrity of the EDI structure.

Changing the maximum use of a segment or group changes the maximum number of times
the segment or group can be used. A segment or group with a maximum use greater than
one repeats (loops), and is placed on a separate frame than the segment or group to which
it is subordinate. A segment or group with a maximum use of one does not repeat, and its
fields are displayed on the same frame as the segment or group or segment to which it is
subordinate.

In this tutorial, you change the maximum use of the groups and segments before you
generate the form (display the fields in the Layout Window). By customizing the group
and segment properties first, all fields are placed on their appropriate frames the first time
you generate the form. If you change the maximum use of the groups and segments affer
you generate the form, the fields are placed on several more frames than are present
ultimately in the form. Therefore, changing the group and segment properties before you
first generate the form enables the fields to be placed on as few frames as necessary.
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Modifying the Maximum Use of the REF Segment

Overview The REF segment contains Reference Numbers used in the EDI data, such as a contract
number used to identify when a relationship began between your company and your
trading partner. The standard allows the REF segment to be used up to twelve times in one
invoice. In this tutorial, you use the REF segment only once (for the contract number).
You change the maximum use of the REF segment to one, which places the associated
fields on the same frame as the header segment.

Procedure  Use this procedure to change the maximum use of the REF segment.

Step

Action

1

Click the REF segment with the right mouse button to access the shortcut
menu.

Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

EDI Segment Properties
N ame |Specia|| = FieIdI Displa_l,JI Loopingl Loop Extended Hulesl

Please enter the name
|HEF

Fleaze enter a short dezcription :
REFEREMCE NIJMEERS

ak I Cancel Sl Help

Select the Looping tab.

In the Max Usage box, enter 1 to designate that this segment can be used
only once per invoice.

Click OK to exit the EDI Segment Properties dialog.
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Modifying the Maximum Use of the N3 Segment

Modifying the Maximum Use of the N3 Segment

Overview

Procedure

The N3 segment in the N1 group contains the Address of the entity or individual named in
the N1 segment. If the form were generated now (displaying the layout of the fields in the
form on the right side of your screen), the fields associated with the N1 and N4 segments
would be located on the main invoice frame, but the fields associated with the N3 segment
would be located on a separate frame. The separate frame is necessary because the N3
segment has a maximum use of two, so it requires another frame for users to enter two sets
of address information. (In screen entry forms, each group with a maximum use greater
than one and repeating segment has a corresponding frame that contains all the groups,
segments, and elements at that level.)

Your users need the N3 segment to be used only once in one invoice, so you change the
maximum use from two, as the standard allows, to one. When you generate the form, the
fields associated with the N3 segment are displayed on the same frame as the fields for the
N1 and N4 segments.

Use this procedure to change the maximum use of the N3 segment.

Step Action

1 Click the N3 segment with the right mouse button and select Properties
from the shortcut menu.

System Response
The system displays the EDI Segment Properties dialog.

2 Select the Looping tab.

3 In the Max Usage box, enter 1 to designate that this segment can be used
only once per invoice.

4 Click Yes at the prompt.

5 Click OK to exit the EDI Segment Properties dialog.
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Creating a Screen Entry Form

Promoting the N1 Group

Overview  The standard allows the N1 group to be used up to two hundred times in one invoice. The
N1 group contains the N1, N3, and N4 segments to provide the name and address of an
entity or individual.

You promote the N1 group twice to accommodate the information for both the Ship To
and Remit To names and addresses. Promoting the N1 group causes two singly-occurring
N1 groups to exist in the form.

Procedure  Use this procedure to promote the N1 group.

Step

Action

1

Click the N1 group with the right mouse button and select Properties from
the shortcut menu.

Select Promote from the shortcut menu. Promoting the N1 group extracts
one iteration of the N1 group and places it directly above the N1 group
that you selected to promote. The new iteration of the N1 group is named
N1:2.

Click the original N1 group with the right mouse button to access the
shortcut menu.

Select Promote from the shortcut menu. Another iteration of the N1
group is extracted and placed above the N1 group. The new iteration of
the N1 group is named N1:3.

Click the original N1 group with the right mouse button to access the
shortcut menu.

Select Deactivate from the shortcut menu to deactivate this group.

Gentran:Server for Windows — August 2008
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Changing the Maximum Use of the ITD Segment

Changing the Maximum Use of the I'TD Segment

Overview  The ITD segment is a conditional segment that specifies the Terms of Sale/Deferred Terms
of Sale for the invoice. The standard specifies that the ITD segment can be used up to five
times in one invoice. For this tutorial, you know that your users must use the ITD segment
only once, so you change the maximum use of this field from five to one.

If the form were generated now, the Terms Type Code would be displayed on a separate
frame than the majority of the invoice fields because the ITD segment has a maximum use
of five. After you change the maximum use to one and generate the form, the Terms Type
Code field is displayed on the parent frame.

Procedure  Use this procedure to change the maximum use of the ITD segment.

Step

Action

1

Click the ITD segment with the right mouse button to access the shortcut
menu.

Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.
EDI Segment Properties
Narne |Specia|| FKep Fieldl Displa_l,ll Loopingl Loop Extended Hulesl

Please enter the name :
IITD

Pleaze enter a short description :
TERMS OF SALE/DEFERRED TERMS OF SALE

QK I Cancel L ulli} Help

Select the Looping tab.

In the Max Usage box, enter 1 to designate that this segment can be used
only once per invoice.

Click OK to exit the EDI Segment Properties dialog.
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Changing the Maximum Use of the DTM Segment

Overview The DTM segment contains the Date/Time Reference Numbers for the invoice. In this
tutorial, the DTM segment is used for the contract date associated with the contract
number (in the REF segment). The standard allows the DTM segment to be used up to ten
times in one invoice. In this tutorial, you use the DTM segment only once (for the contract
date). You change the maximum use of the DTM segment to one, which places the
associated fields on the main Invoice frame with the majority of the invoice fields.

Procedure  Use this procedure to change the maximum use of the DTM segment.

Step Action
1 Click the DTM segment with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

3 Select the Looping tab.

4 In the Max Usage box, enter 1 to designate that this segment can be used
only once per invoice.

5 Click OK to exit the EDI Segment Properties dialog.
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Changing the Maximum Use of the PID Group

Overview  The standard allows the PID group (Product Item/Description) in the IT1 group to be used
up to one thousand times in one invoice. If the invoice were generated now, the fields
associated with the PID group would be displayed on a separate frame than the majority of
the invoice fields. For this tutorial, you know that your users complete the fields in the
PID group only once per invoiced item. You change the maximum use of the PID group to
one, which moves the Product Item/Description fields to the frame containing line item
information.

Procedure  Use this procedure to change the maximum use of the PID group.

Step Action
1 Click the PID group with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The Group Properties dialog is displayed.

Group Properties E
Marme | Displayl Loopingl Loop Extended Hulesl

Fleasze enter the name ;
|n41 0_PID

Please enter a short description

QK I Cancel S Help

3 Select the Looping tab.
4 In the Max Usage box, enter 1.
5 Select the Display tab.
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(Contd)
Step

Action

6

Click the Promote group to parent frame check box to promote this
group.

Note

If you change the maximum usage of this group, but do not check the
“Promote group to parent frame” check box, the fields in this group are
not displayed on the same frame in the Layout Window as the fields in the
parent group.

Click OK to exit the Group Properties dialog.
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Changing the Maximum Use of the DTM:2 Segment

Changing the Maximum Use of the DTM:2 Segment

Overview The standard allows the DTM:2 segment (Date/Time Reference) in the IT1 group to be
used up to ten times in one invoice. If the invoice were generated now, the fields
associated with the DTM:2 segment would be displayed on a separate frame than the
majority of the invoice fields. For this tutorial, you know that your users complete the
fields in the DTM:2 segment only once per invoiced item. You change the maximum use
of the segment from ten to one, which enables the Date/Time Reference fields to be
displayed on the frame containing other line item information.

Procedure  Use this procedure to change the maximum use of the DTM:2 segment.

Step

Action

1

Click the DTM:2 segment with the right mouse button to access the
shortcut menu.

Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

Select the Looping tab.

In the Max Usage box, enter 1 to indicate that this segment can be used
only once per invoice.

Click OK to exit the EDI Segment Properties dialog.
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Changing the Maximum Use of the CAD Segment

Overview  The standard allows the CAD segment (Carrier Detail) to be used up to 999,999 times in
one invoice. If the form were generated now, the fields associated with the CAD segment
would be displayed on a separate frame than the majority of the invoice fields. For this
tutorial, you know that your users complete the fields in the CAD segment only once per
invoiced item. You change the maximum use of the CAD segment, which moves the
Carrier Detail fields to the frame containing other line item information.

Procedure  Use this procedure to change the maximum use of the CAD segment.

Step Action
1 Click the CAD segment with the right mouse button to access the shortcut
menu.
2 Select Properties from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

3 Select the Looping tab.

4 In the Max Usage box, enter 1 to indicate that this segment can be used
only once per invoice.

5 Click OK to exit the EDI Segment Properties dialog.
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Generating the Form

Overview  Generating a form is different from compiling a form. When you compile a form, the
source form is translated into a compiled translation object. When you generate a form,
the fields of the form are displayed on a frame in the Layout Window (right side of the
Forms main window), based on the groups, segments, and elements that are activated.

Procedure  Use this procedure to generate the screen entry form based on the groups, segments, and

elements you activated.

Step Action
1 Select the 810 INVOICE file icon. Selecting the 810 INVOICE file icon
before you generate the layout enables you to view the beginning of the
invoice layout in the Layout Window after the layout is generated.
However, selecting the 810 INVOICE file icon is not a required
prerequisite to generating the layout.
2 Click Generate Layout on the Main Toolbar.

Note

You should regenerate the form periodically as you customize the screen
entry form to ensure that the most recent changes to the frame are
reflected in the Layout Window.

System Response
The layout of the screen entry form is displayed in the Layout Window.
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After generating
the form

When you generate the form, there is one field on the right side of your screen (Layout
Window) for every activated element on the left side of your screen (EDI File Format
Window). You can click either the field or its corresponding element to select it. To access
the Element Properties dialog for a field or element, either double-click the element, or
use the right mouse button to click the field or element, and then select Properties from the
shortcut menu.

Note

When you first generate the form, each field in the Layout Window is labeled with the
same name as its corresponding element in the EDI File Format Window. As you
customize the form, however, you change some of the labels and remove others, so all the
fields are not labeled the same as their corresponding elements. Even though you change
or remove some field labels, each field still corresponds to one element.

When the screen entry form is generated, the fields associated with each non-repeating
segment or group are displayed on a frame in the Layout Window. If a segment or group is
defined as repeating, then a list is displayed on the parent frame, and the fields for that
repeating segment or group are displayed on the parent frame, and the fields for that
repeating segment or group are displayed on a separate frame.

All frames in a screen entry form are titled. The default title for each frame is its
transaction set, group, or segment name, but you can change the default titles to better
identify the information that is entered.
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Overview

Customize the EDI Data

Overview

Introduction

Setting up the
document name

Procedure

You can customize the form, including the properties of each type of form component
(group, segment, and element).

Customizing the form is an iterative process. This tutorial guides you through all the steps
involved in customizing the form, component by component. When you create forms, you
usually activate the form components you need to use, customize and format the form
components, then compile the form and test the translation object (and print a report, if
necessary). As you substantially customize the form, you usually compile and print the
form several times to view your changes before the form truly is finalized.

This section explains how to customize the form components for each sequential
component in this tutorial.

We recommend that you set up a Document Name for each form. The document name
makes the identification of a document created by the form easier in Gentran:Server.
Setting up the document name enables you to differentiate between documents in the
document browsers in Gentran:Server. If you set up the document name in the Forms
Integration subsystem, the Name field of the document browsers that contain this
document in Gentran:Server contains the data from that element. You can choose any
element as the document name, but we strongly recommend that you select an element
that occurs only once in the document and has a data type of string. For an ANSI X12 810
invoice, the document name usually is the Invoice Number.

Use this procedure to set up the document name.

Step Action

1 Double-click the BIG02 element.

System Response
The Element Properties dialog is displayed.

Recommendation

In this tutorial, we recommend that you select this element because it is a
non-recurring and mandatory element, and it helps to identify this
document meaningfully in Gentran:Server.

2 Select Standard Rule tab.

3 Select Update from the list.
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(Contd)
Step Action

4 From the Table/Group list, select Document record to indicate that you
are updating the document record in Gentran:Server.

5 From the Column/Field list, select Document Name to indicate that you
are updating the Name field (in the Gentran:Server document browsers
that contain this message) with the contents of the B1G02 element.

The dialog now should look like this:
Hame I Validationl Displa_l,ll Help I Extended Rule  Standard Rule |E0nditinns|
Fleaze zelect the standard rule to uze IUpdate j
Fleaze zelect the table [or group] to update
IDncument record j
Fleaze zelect the column [or field) to update :
QK. I Cancel Lpply Help
6 Click OK to set up the document name.

Gentran:Server for Windows — August 2008 Forms Integration ANSI Tutorial Guide



Creating a Screen Entry Form Customizing the BIG Segment

Customizing the BIG Segment

Overview  The BIG segment contains the Beginning Segment for the invoice. This segment uses two
mandatory elements: Invoice Date and Invoice Number. You also have activated the
Purchase Order Date and Purchase Order Number elements for this segment. Each of
these elements contains information that pertains to the entire invoice.

How to customize The BIGO1 element is a mandatory element that contains the Invoice Date. Your users
the BIG01 element format the date as “MM/DD/YY” when they enter the date in the screen entry translation
object, but the EDI data is sent to your trading partner as “YYMMDD.” You must change
the maximum length of this field from six to eight, to accommodate the entire date,
including separators (/). Also, you add Help text to this field.

Use this procedure to set the date format, change the element and field lengths, and add
Help text to the Invoice Date field.

Step Action

1 Double-click the BIG01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 From the Data Format list, select MM/DD/YY to indicate that this field
on the translation object accepts a date entered in the format
MM/DD/YY.

5 Verify that YYMMDD is selected in the File Format list to indicate that
the EDI data is sent in the format YYMMDD.

6 Select the Display tab.

7 In the Maximum number of characters box, enter 8 to allow the entire

date, including separators (/), to be displayed.

8 Select the Help tab.

9 In the Help Text list, enter the following text:

Enter the invoice date. Use the format MM/DD/YY.

10 Click OK to exit the dialog.
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How to customize The BIGO02 element is a mandatory element containing the Invoice Number. This element
the BIG02 element is defined by the standard to be a string of twenty-two alphanumeric characters. You know
that your invoice number is an eight-character alphanumeric string, so you change the
element and field lengths to accommodate the shorter invoice number. In addition, you
rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths and the field label, and add
Help text to the Invoice Number field.

Step Action

1 Double-click the BIG02 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow an eight-character string in this element.
4 Select the Display tab.

5 In the Label box, enter Invoice No. to replace the existing field label.

6 In the Maximum number of characters box, enter 8 to allow eight

characters to be entered in this field.

7 Select the Help tab.

8 In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the invoice number. The invoice number cannot
exceed 8 alphanumeric characters.

9 Click OK to exit the dialog.
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How to customize The BIGO03 element contains the Purchase Order Date, which is the date when your
the BIG03 element trading partner sent the purchase order. Your users format the date as “MM/DD/YY” when
they enter the date into the screen entry translation object, but the EDI data is sent to your
trading partner as “YYMMDD.” You change the maximum length of this field to eight to
accommodate the entire date, including separators (/). To save space in the screen entry
form, you rename this field. Also, you add Help text to the field.

Use this procedure to set the date format, change the element and field lengths, change the
field name, and add Help text to the Purchase Order Date field.

Step Action

1 Double-click the BIG03 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

4 From the Form Format list, select MM/DD/YY to indicate that this field
on the translation object accepts a date entered in the format MM/DD/YY.

5 Verify that YYMMDD is selected in the File Format list to indicate that
the EDI data is sent in the format YYMMDD.

6 Select the Display tab.

7 In the Label box, enter P.O. Date to replace the existing field label.

8 In the Maximum number of characters box, enter 8 to allow the entire

date, including separators (/), to be displayed.

9 In the Help Text list, enter the following text:

Enter the purchase order date. Use the format MM/DD/YY.

10 Click OK to exit the dialog.
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How to customize The BIG04 element contains the Purchase Order Number. This element is defined by the
the BIG04 element standard to be a string of twenty-two alphanumeric characters. You know that your trading
partner’s purchase order number is always a ten-character alphanumeric string, so you
change the element and field lengths to accommodate the shorter purchase order number.
In addition, you rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, change the field label, and add
Help text to the Purchase Order Number field.

Step Action

1 Double-click the BIG04 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.

3 In the Max box, enter 10 to allow a ten-character string in this element.
4 Select the Display tab.

5 In the Label box, enter P.O. No. to replace the existing field label.

6 In the Maximum number of characters box, enter 10 to allow ten

characters to be entered in this field.

7 Select the Help tab.

8 In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the purchase order number. The purchase order
number cannot exceed 10 alphanumeric characters.

9 Click OK to exit the dialog.
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(Contd)
Step Action
10 Click Generate Layout on the Main Toolbar to refresh the display of the

screen entry form.

The section of the Invoice frame that contains the fields in the BIG
segment now should look like this:

F
Invoice Date I:l

Ireedice Mo, | |

P.0. Date I:I

P.O. Mo

[ X %X )
rah

Entity Identifier Code |:|

Mame |

Address Infarmation | |

Address Information | |

City M ame |

State Or Province Code I:I

Postal Code I:I

Entity |dentifier Code |:|

Mame |

Forms Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 (



Customizing the REF Segment Creating a Screen Entry Form

Customizing the REF Segment

Overview

How to customize
the REF01 element

The REF segment contains Reference Numbers used in the EDI data, such as a contract
number. The standard allows the REF segment to be used up to twelve times in one
invoice. In this tutorial, you use the REF segment only once (for the contract number).
You already have promoted the REF segment to obtain just one instance of the reference
number, and to place the associated fields on the same frame as the BIG segment.

The REFO01 element (Reference Number Qualifier) is a mandatory element for the REF
segment. The REF01 element contains the two-character code to indicate what type of
reference number follows (e.g., contract number). Because you know that the only type of
reference number your users enter for this invoice is a contract number, you define a
constant value for the Reference Number Qualifier field, designating that the constant
“CT” always qualifies the number in the Reference Number field. Then, you hide the
Reference Number Qualifier field, because it does not need to be displayed in the
translation object.

When a user enters a contract number in the Reference Number field, the system assigns
the code “CT” to the Reference Number Qualifier field.

Use this procedure to define a constant value in the Reference Qualifier field and hide the
field.

Step Action

1 Double-click the REF01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.
3 Select the Use Constant option.
4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dialog.
Edit Constant
r —
i*’a'ue Cancel |
6 In the ID box, enter Contract Number to identify the constant.
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Customizing the REF Segment

(Contd)
Step

Action

7

From the Type list, select String to indicate that the literal constant is
formatted as a string data type.

In the Value box, enter CT to indicate that the Reference Number
Qualifier field must contain the contract number. This value is the actual
value of the literal constant.

Click OK to add the constant.

10

Click Close to exit the Map Constants dialog.

11

From the Constants list, select CT to identify the constant that is used for
this element.

12

From the Qualifies list, select 0127 REFERENCE NUMBER, which is
the element that the Reference Number Qualifier field qualifies.

13

Select the Display tab.

14

Click the This field should not be displayed option to prevent the field
from being displayed in the translation object.

15

Click OK to exit the dialog.

How to customize The REF02 element contains the Reference Number. This element is defined by the
the REF02 element standard to be a string of thirty alphanumeric characters. In this tutorial, you know that the
reference number (the contract number) is an eight-character alphanumeric string, so you
change the element and field lengths to accommodate the shorter reference number. In
addition, you rename the field label and add Help text to the field.

Use this procedure to change the field and element lengths, change the field label, and add
Help text to the Reference Number field.

Step

Action

1

Double-click the REF02 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8.

Select the Display tab.
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Creating a Screen Entry Form

(Contd)
Step

Action

5

In the Label box, enter Contract No. (note the period included in the
label) to replace the existing field label.

In the Maximum number of characters box, enter 8 to allow an eight-
character string to be entered.

Select the Help tab.

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the contract number. The contract number cannot
exceed 8 alphanumeric characters.

Click OK to exit the dialog.

10

Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The section of the Invoice frame that contains the fields in the REF
segment now should look like this:
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Customizing the N1 Groups

Overview You already promoted the N1 group twice to accommodate the information for both the
Ship To and Remit To names and addresses. There are now two N1 groups activated in the
form: N1:2 (for the Ship To name and address) and N1:3 (for the Remit To name and
address).

You activated the N1, N3, and N4 segments in each N1 group to provide the name and
address of an entity or individual. For this tutorial, you use the N1 groups to identify these
two types of addresses:

»  Ship to name and address (Entity Identifier Code “ST”)
» Remit to name and address (Entity Identifier Code “RI”)

To make the screen entry translation object more convenient for your users, you changed
the maximum use of the N3 segment (for both N1 groups) from two to one. Changing the
maximum use of the N3 segment enabled the Address Information fields of the N3
segment to be displayed on the Invoice frame with the N1 and N4 fields.

Forms Integration ANSI Tutorial Guide Gentran:Server for Windows — August 2008 ()



Customizing the N1:3 Segment Creating a Screen Entry Form

Customizing the N1:3 Segment

Overview  The N1:3 segment in the N1:2 group identifies the Name of the entity or individual. If the
N1:3 segment is used, then the N1:301 element is mandatory. The N1:301 element
contains the Entity Identifier Code, which identifies the type of name and address in that
iteration of the group.

To ensure that Gentran:Server displays the correct name and address in the Ship To and
Remit To fields, you should use the key field function. The key field function enables you
to specify a second qualification in selecting a segment (the segment name is the first
qualification). Data must be provided in the order designated through the use of key fields.
For example, for this tutorial, your screen entry translation object users enter the ship to
name and address (N1:2 group) first, and then the remit to name and address (N1:3 group).

By using the key field function, if a screen entry translation object user enters only a
Remit To name and address (N1:3 group) in a document using this invoice translation
object, then saves the document and opens it later, the Remit To name and address are
displayed in the correct fields. If you do not use the key field function, then in the same
scenario described above, the Remit To name and address are displayed in the Ship To
fields (since they are the first N1 fields in which data can be displayed).

How to use a key  Use this procedure to use a key field for the N1:3 segment (in the N1:2 group).

field for the N1:3

segment
Step

Action

1

Click the N1:3 segment with the right mouse button Select Properties
from the shortcut menu.

System Response
The EDI Segment Properties dialog is displayed.

Select the Key Field tab.

From the Field list, select 0098 ENTITY IDENTIFIER CODE.

Verify that the Use constant option is selected.

Click Edit to access the Map Constants dialog.

Click New to display the Edit Constant dialog.

Edit Constant

I} Tupe
f

| =

Walue Cancel |
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(Contd)
Step

Action

7

In the ID box, enter Ship To to identify the unique literal constant.

8

From the Type list, select String.

9

In the Value box, enter ST to identify the actual value of the constant.

10

Click OK to exit the Edit Constant dialog.

11

Click Close to exit the Map Constants dialog.

12

From the Use Constant list, select ST to indicate to the system that this
name is the Ship To name.

13

Click OK to exit the dialog.

How to customize The N1:301 element (in the N1:3 segment) contains the Entity Identifier Code, which is
the N1:301 element  used to identify whether the name and address that follows is the Ship To or Remit To

name and address. For this tutorial, you know that your users enter only the Ship To name
and address information in the fields associated with the N1:2 group. Therefore, you use
the constant value “ST” (which you defined in the previous section) in the Entity Identifier
Code field, indicating that this group (N1:2) contains only shipping information. Then,
you hide the Entity Identifier Code field, because it does not need to be displayed on the
translation object.

Use this procedure to use a constant value for the Entity Identifier Code field and hide the

field.

Step

Action

1

Double-click the N1:301 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

Select the Standard Rule tab.

Select the Use Constant option.

Click the second Constant option.

From the Constants list, select ST to identify the constant that is used for
this element.

From the Qualifies list, select 0093 NAME, which is the element that the
Entity Identifier Code field qualifies.

Select the Display tab.
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Customizing the N1:3 Segment Creating a Screen Entry Form

(Contd)
Step

Action

8

Click the This field should not be displayed option to prevent the field
from being displayed in the translation object.

Click OK to exit the dialog.

The N1:302 element (in the N1:3 segment) contains the name of the person or company
that received the order for which you are sending an invoice. Your users are familiar with

the standard address format (the name on the first line; the address on the next lines; the
city, state, and postal code on the last line). For this reason, you do not need to label the
fields containing the address, city, state, and postal code. You rename the field label and
add Help text to the field.

Use this procedure to rename the field label and add Help text to the Name field.

Step

Action

1

Double-click the N1:302 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, enter Ship To to replace the existing field label. This
label is the heading for the Ship To name and address information.

Select the Help tab.

In the Help text list, enter the following text (press Enter at the end of each
line of text below):

Enter the name of the person or organization to whom the
order was shipped. The name cannot exceed 35
alphanumeric characters.

Click OK to exit the dialog.
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Customizing the N3:3 Segment

he N3:3 Segment

The N3:3 segment (in the N1:2 group) contains the Address of the entity or individual
named in the N1:3 segment. If the N3:3 segment is used, then the N3:301 element is
mandatory. The N3:301 element contains Address Information, which can identify the
street name, suite number, or any other address information. This element does nof contain
the city, state/province, or postal code; that data is contained in the N4:3 segment. You
already activated the N3:302 element, which is a conditional element that contains an
additional line of address information, if it is necessary.

Your users need the N3:3 segment to be used only once, so you changed the maximum use
from two, as the standard allows, to one. Because you have changed the maximum use, the
fields associated with the N3:3 segment are displayed on the Invoice frame with the fields
for the N1:3 and N4:3 segments.

The address information in the N3:301 element (in the N3:3 segment) corresponds to the
name in the N1:301 element, so there is no need to display the labels associated with the
address information. For the N3:301 and N3:302 elements, you hide the field labels and

add Help text to the fields.

Use this procedure to hide the Address Information field label and add Help text.

Step Action

1 Double-click the N3:301 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list, enter the following text (press Enter at the end of

each line of text below):

Enter the first line of the address. This address line cannot
exceed 35 alphanumeric characters.

6 Click OK to exit the dialog.
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How to customize Use this procedure to hide the second Address Information field label of the Remit To
the N3:302 element address and add Help text.

Step Action

1 Double-click the N3:302 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list, enter the following text (press Enter at the end of

each line of text below):

Enter the second line of the address. This address line cannot
exceed 35 alphanumeric characters.

6 Click OK to exit the dialog.
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Customizing the N4:3 Segment

Overview  The N4:3 segment in the N1:2 group contains the Geographic Location of the entity or
individual named in the N1:3 segment. The N4:301 element contains the name of the city,
the N4:302 element contains the code for the state or province, and the N4:303 element
contains the postal code.

The geographic information in the N4:3 segment corresponds to the name in the N1:301
element, so there is no need to display the labels associated with the geographic
information. You hide the field labels for the N4:31, N4:302, and N4:303 elements and
add Help text to those fields.

How to customize  Use this procedure to hide the field label and add Help text to the City Name field.

the N4:301 element

Step

Action

1

Double-click the N4:301 element in the N1:2 group.

System Response
The Element Properties dialog is displayed.

Select the Validation tab

In the Label box, delete the existing field label.

Select the Help tab.

In the Help Text box, enter the following text (press Enter at the end of
each line of text below):

Enter the city name. The city cannot exceed 30 alphanumeric
characters.

Click OK to exit the dialog.

How to customize  Use this procedure to hide the field label and add Help text to the State or Province Code

the N4:302 element field.

Step

Action

1

Double-click the N4:302 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.
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(Contd)
Step Action

3 In the Label box, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list, enter the following text (press Enter at the end of
each line of text below):
Enter the state or province code. The code cannot exceed
2 alphanumeric characters.

6 Click OK to exit the dialog.

How to customize  Use this procedure to hide the field label and add Help text to the Postal Code field.
the N4:303 element

Step Action

1 Double-click the N4:303 element (in the N1:2 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.
3 In the Label box, delete the existing field label.
4 In the Help Text box, enter the following text (press Enter at the end of

each line of text below):

Enter the postal code. The postal code cannot exceed 9
alphanumeric characters. Do not enter a hyphen (-) before the
4-digit postal code extension (if used).

5 Click OK to exit the dialog.
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(Contd)
Step

Action

6

Click Generate Layout on the Main Toolbar to refresh the display of the

screen entry form.

The section of the Invoice frame that contains the fields in the N1:2 group

now should look like this:
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Customizing the N1:4 Segment

Overview

How to customize
the N1:401 element

The N1:4 segment in the N1:3 group identifies the Name of the entity or individual. If the
N1:4 segment is used, then the N1:401 element is mandatory. The N1:401 element
contains the Entity Identifier Code, which identifies the type of name and address in that
iteration of the group.

The N1:401 element (in the N1:4 segment) contains the Entity Identifier Code, which is
used to identify whether the name and address that follows is the Ship To or Remit To
name and address. For this tutorial, you know that your users enter only the Remit To
name and address information in the fields associated with the N1:3 group. Therefore, you
define the constant value “RI” in the Entity Identifier Code field, indicating that this group
(N1:3) contains only Remit To information. Then, you hide the Entity Identifier Code
field, because it does not need to be displayed on the translation object.

Use this procedure to define a constant value for the Entity Identifier Code field and hide
the field.

Step Action

1 Double-click the N1:401 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.
Edit Constant E2

1] Type
I | =]

ralue Cancel |

6 In the ID box, enter Remit To to identify the constant.

7 From the Type list, select String to indicate that the literal constant is
formatted as a string data type.

8 In the Value box, enter RI to indicate that the Entity Identifier Code field
must contain the Remit To name and address. This value is the actual
value of the literal constant.
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Step Action

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select RI to identify the constant that is used for
this element.

12 From the Qualifies list, select 0093 NAME, which is the element that the
Entity Identifier Code field qualifies.

13 Select the Display tab.

14 Click the This field should not appear on the form option.

15 Click OK to exit the dialog.

How to customize The N1:402 element (in the N1:4 segment) contains the name of the person or company to
the N1:402 element whom the invoice should be remitted. Your users are familiar with the standard address
format (the name on the first line; the address on the next lines; the city, state, and postal
code on the last line). For this reason, you do not need to label the fields containing the
address, city, state, and postal code. You rename the field label and add Help text to the
field.

Use this procedure to rename the field label and add Help text to the Name field.

Step Action

1 Double-click the N1:402 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, enter Remit To to replace the existing field label. This
label is the heading for the Remit To name and address information.

4 Select the Help tab.

5 In the Help text list, enter the following text (press Enter at the end of

each line of text below):

Enter the name of the person or organization to whom the
invoice should be remitted. The name cannot exceed 35
alphanumeric characters.

6 Click OK to exit the dialog.
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Customizing the N3:4 Segment

Overview

How to customize
the N3:401 element

The N3:4 segment (in the N1:3 group) contains the Address of the entity or individual
named in the N1:4 segment. If the N3:4 segment is used, then the N3:401 element is
mandatory. The N3:401 element contains Address Information, which can identify the
street name, suite number, or any other address information. This element does nof contain
the city, state/province, or postal code; that data is contained in the N4:4 segment. You
already activated the N3:402 element, which is a conditional element that contains an
additional line of address information, if it is necessary.

Your users need the N3:4 segment to be used only once in one invoice, so you changed the
maximum use from two, as the standard allows, to one. Changing the maximum use of this
segment enables the fields associated with the N3:4 segment to be displayed on the
Invoice frame with the fields for the N1:4 and N4:4 segments.

The address information in the N3:401 element (in the N3:4 segment) corresponds to the
name in the N1:401 element, so there is no need to display the labels associated with the
address information. For the N3:401 and N3:402 elements, you hide the field labels and

add Help text to the fields.

Use this procedure to hide the first Address Information field label of the Remit To
address and add Help text.

Step Action

1 Double-click the N3:401 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.
3 In the Label box, delete the existing field label.
4 In the Help Text list, enter the following text (press Enter at the end of

each line of text below):

Enter the first line of the address. This address line cannot
exceed 35 alphanumeric characters.

5 Click OK to exit the dialog.
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How to customize Use this procedure to hide the second Address Information field label and add Help text.
the N3:402 element

Step Action

1 Double-click the N3:402 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing field label.

4 Select the Help tab.

5 In the Help Text list, enter the following text (press Enter at the end of

each line of text below):

Enter the second line of the address. This address line cannot
exceed 35 alphanumeric characters.

6 Click OK to exit the dialog.
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Customizing the N4:4 Segment

Overview  The N4:4 segment in the N1:3 group contains the Geographic Location of the entity or
individual named in the N1:4 segment in the N1:3 group. The N4:401 element contains
the name of the city, the N4:402 element contains the code for the state or province, and
the N4:403 element contains the postal code.

The geographic location in the N4:4 segment corresponds to the name in the N1:401
element, so there is no need to display the labels associated with the geographic location.
You hide the field labels for the N4:401, N4:402, and N4:403 elements and add Help text
to those fields.

How to customize  Use this procedure to hide the field label and add Help text to the City Name field.
the N4:401 element

Step Action

1 Double-click the N4:401 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing field label.

4 Select the Help tab.

5 In the Help Text box, enter the following text (press Enter at the end of

each line of text below):

Enter the city name. The city cannot exceed 30 alphanumeric
characters.

6 Click OK to exit the dialog.

How to customize Use this procedure to hide the field label and add Help text to the State or Province Code
the N4:402 element  field.

Step Action

1 Double-click the N4:402 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

2 Select the Display tab.

3 In the Label box, delete the existing field label.
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Step

Action

Select the Help tab.

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the state or province code. The code cannot exceed
2 alphanumeric characters.

Click OK to exit the dialog.

How to customize Use this procedure to hide the field label and add Help text to the Postal Code field.

the N4:403 element

Step

Action

1

Double-click the N4:403 element (in the N1:3 group).

System Response
The Element Properties dialog is displayed.

Select the Display tab.

In the Label box, delete the existing field label.

Select the Help tab.

In the Help Text box, enter the following text (press Enter at the end of
each line of text below):

Enter the postal code. The postal code cannot exceed 9
alphanumeric characters. Do not enter a hyphen (-) before
the 4-digit postal code extension (if used).

Click OK to exit the dialog.
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(Contd)
Step

Action

7

Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The section of the Invoice frame that contains the fields in the N1:3
group) now should look like this (you may need to scroll down the frame
to see all of these fields):
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he ITD Segment

The ITD segment is a conditional segment that specifies the Terms of Sale/Deferred Terms
of Sale for the invoice. The standard specifies that the ITD segment can be used up to five
times in one invoice. For this tutorial, you know that your users must use the ITD segment
only once, so you changed the maximum use of this segment from five to one.

The ITDO1 element contains the Terms Type Code, a two-character code that identifies the
terms under which this invoice is valid. Gentran:Server uses a list (instead of an edit box,
or field) when you apply a standard rule that allows a selection of multiple items. When
users use a translation object that contains a list, they select an item from the list, instead
of typing a value in a field. You customize the ITDO1 element so that a list containing all
valid codes in the Terms Type Code code list is available to your users when they use the
screen entry translation object. The Terms Type Code list enables them to select the
appropriate EDI code from the code list.

After you specify the code list table to use for the list for the Terms Type Code field, you
rename the field label. Also, you add Help text to the field.

Use this procedure to load the Terms Type Code code list from the standard, rename the
field label, and add Help text to the Terms Type Code field.

Step Action

1 Double-click the ITDO01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Code option.

4 Click Edit to access the Edit Code List dialog.

5 The Table ID box contains 0336, the name of the element for which this

code list table is used. The Desc box contains TERMS TYPE CODE, the
description of the element for which this code list table is used.

6 Click Load to access the Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to access the Load Code List dialog.

7 Click Add All to select all the codes and move them to the Codes Selected
list.
8 Click OK to load the code list and exit the Load Code List dialog.
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Step

Action

9

Click Close to exit the Edit Code List dialog.

10

Select the Display tab.

11

In the Label box, enter Payment Terms Code to replace the existing field
label.

12

Select the Help tab.

13

In the Help Text list, enter the following text:

Select the payment terms code from the list.

14

Click OK to exit the dialog.

15

Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

The section of the Invoice frame that contains the field in the ITD segment
now should look like this (you may need to scroll down the frame to see
the field):
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Customizing the DTM Segment

Overview The DTM segment contains the Date/Time Reference Numbers for the invoice. In this
tutorial, the DTM segment is used for the contract date associated with the contract
number (in the REF segment). The standard allows the DTM segment to be used up to ten
times in one invoice. In this tutorial, you use the DTM segment only once (for the contract
effective date). You already changed the maximum use of the DTM segment to obtain just
one instance of the DTM segment, and to place the associated fields on the same frame as
the majority of the invoice fields.

How to customize The DTMO1 element (Date/Time Qualifier) is a mandatory element for the DTM segment.
the DTMO01 The DTMO1 element contains the two-character code from your EDI data to indicate what
element  type of date follows (e.g., contract effective date). You define a constant value for the
Date/Time Qualifier field, designating that the constant “090” qualifies the date in the
Date field. Defining the constant indicates that the Date field contains the contract
effective date.

When a user enters a contract effective date in the Date field, the system automatically
assigns the code “090” to the Date/Time Qualifier field.

Use this procedure to define a constant value and hide the Date/Time Qualifier field.

Step Action

1 Double-click the DTMO01 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dialog.

I} Type
|| _——

Walue Cancel |

6 In the ID box, enter Contract Effective to identify the constant.

7 From the Type list, select String to indicate that the literal constant is
formatted as a string data type.
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Step

Action

8

In the Value box, enter 090 to indicate that the Date/Time Qualifier field
must contain the contract date. This value is the actual value of the literal
constant.

Click OK to add the constant.

10

Click Close to exit the Map Constants dialog.

11

Select the Standard Rule tab.

12

From the Constants list, select 090 to identify the constant that is used for
this element.

13

From the Qualifies list, select 0373:6 DATE, which is the element that the
Date/Time Qualifier field qualifies.

The dialog now should look like this:

Element Properties E3

Hame I Validationl Displa_l,ll Help I Extended Rule  Standard Rule |E0nditinns|

Fleasze select the standard rule bo uze ; IUse Constant j

Flease select a constant to store in this field :

{030 -] e |

f this constant iz a qualifier for another field, Gentran can automatically uze the
exiztence of data in that fisld to determine whether to execute this standard rule. Ta
take advantage of this feature, simply select the field to be gualified ;

QK I Cancel S Help

14

Select the Display tab.

15

Select the This field should not appear on the form option.

16

Click OK to exit the dialog.
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Customizing the DTM Segment

How to customize The DTMO02 element in the DTM segment contains the contract effective date. This
the DTMO02 element is defined by the standard to be a date/time data type, consisting of six
element alphanumeric characters. In this tutorial, you know that the contract date is always an
eight-character alphanumeric string, so you change the element and field lengths to
accommodate the longer date. In addition, you rename the field label to more accurately
reflect the field contents, and add Help text to the field.

Use this procedure to change the field and element lengths, change the field label, and add
Help text to the Date field.

Step

Action

1

Double-click the DTMO02 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8 to allow the entire date, including separators
(/), to be contained in this element.

From the Form Format list, select MM/DD/YY to indicate that this field
on the translation object accepts a date entered in the format
MM/DD/YY.

Verify that YYMMDD is selected in the File Format list to indicate that
the EDI data is sent in the format YYMMDD.

Select the Display tab.

In the Label box, enter Contract Date to replace the existing field label.

In the Maximum number of characters box, enter 8 to allow the entire
date, including separators (/), to be displayed.

Select the Help tab.

10

In the Help Text list, enter the following text:

Enter the contract date. Use the format MM/DD/YY.

11

Click OK to exit the dialog.
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Action

12

Click Generate Layout on the Main Toolbar to refresh the display of the

screen entry form.

The section of the Invoice frame that contains the fields in the DTM
segment now should look like this (you may need to scroll down the frame

to see the fields):

Invdce
Fank To | :
| ]
|
|
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I
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e
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Customizing the IT1 Group

Overview

Procedure

The standard allows the IT1 group to be used up to one hundred thousand times in one
invoice. The IT1 group contains the following segments and group that you already
activated: IT1 segment, PID group, DTM:2 segment, and CAD segment.

The fields associated with the IT1 group are arranged on the 0400 Itl frame, which is
separate from the Invoice frame that you have been working with thus far in this tutorial.
Your users complete the fields on the 0400 It1 frame for each item in the invoice. The list
of all line items in the invoice is displayed in a list on the Invoice frame. In that list, the
invoiced items are displayed line by line, forming columns of information.

You already promoted or changed the maximum use of the following form components:
PID group, DTM:2 segment, and CAD segment. Now, you are ready to customize these
components and rename the IT1 group.

Use this procedure to rename the IT1 group and its frame and add Help text to the list that
is displayed on the Invoice frame.

Step Action

1 Click the IT1 group with the right mouse button and select Properties
from the shortcut menu.

System Response
The Group Properties dialog is displayed.

2 In the Desc box, enter Line Items to describe the group.

3 Select the Display tab.

4 In the Frame Caption box, enter Line Items to rename the frame.
5 In the List Caption box, enter Line Items to rename the list that is

displayed on the Invoice frame (listing the line items entered on the Line
Items frame).

6 Select the Help tab.

7 In the Frame Help Text list, enter the following text (press Enter at the
end of each line of text below):

This frame contains the line item detail
information. For online Help on an
individual field on this frame, select the
field and press F1.
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Action

8

In the Listbox Help Text list, enter the following text (press Enter at the
end of each line of text below):

This list contains the line item detail for
the invoice. The data in this list is

entered or changed on the Line Items
frame. To enter a new line item, click the
list and click New. To modify an

existing line item, click that item and click
Open.

Click OK to exit the Group Properties dialog.
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Customizing the I'T1 Segment

Overview The IT1 segment contains the Baseline Item Data that identifies the line item detail for
each item invoiced. For some of the elements in the IT1 segment, you only need to add
Help text and rename the field labels so they more accurately reflect your company’s
needs. With other elements, you change the maximum lengths for some of the fields, use
accumulators to calculate the number of line items, or define a constant value.

The IT1 group is subordinate to the Invoice frame, so Gentran:Server creates a separate
frame (the Line Items frame) to contain the group data (the line item details). The system
also creates a list (the Line Items list) on the Invoice frame to allow the user to access the
items in the list. Each set of data is displayed as a row in the list. After you customize the
line item fields, the Line Items list contains these four columns of data: Item No., Product
Code, Quantity, and Price.

How to customize The IT101 element (in the IT1 segment in the IT1 group) contains the Assigned

the IT101 element  Identification for one item in the invoice. In this tutorial, you use the Assigned
Identification field to identify sequentially each line item in the invoice. You use the Use
Accum function to obtain an incremental count of the number of line items. This number
is used in the Number of Line Items field (CTTO1 element). The data type currently
selected for this element is “String,” so you must change the type to “Number” for the
accumulators to work properly. You change the screen and EDI formats from “X” (a
format appropriate for a string data type) to “NO” (a format appropriate for a number data
type) to indicate that you expect numbers with implied decimal points and no decimal
places in both the screen entry translation object and the EDI data.

You create a list definition for the IT101 element to include the line number in the list, and
rename the field label to more accurately reflect the purpose of this field in this invoice.
You change the minimum use of this element to zero to make this element conditional.
Also, you know that your users enter no more than 99,999 line items per invoice. Each line
item is numbered sequentially, starting with one, so you need a maximum length of only
five digits for this field. You change the maximum length for this field from the default
setting of eleven to five.

Procedure  Use this procedure to count line items in the IT1 segment and generate a control total in
the CTTO1 element of the number of line items, rename the IT101 field label, change the
field length and data type, change the screen and EDI formats, add Help text, and create
the list definition for the Assigned Identification field.

Step Action

1 Double-click the IT101 element.

System Response
The Element Properties dialog is displayed.

2 Select the Validation tab.
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Action

3

In the Min box, enter 0 to make this element conditional.

4

In the Max box, enter 5 to allow a five-digit number in this element.

From the Type list, select Number to allow a number data type in this
element.

From the Form Format list, select N0 to indicate that this field on the
translation object accepts a number with an implied decimal point and no
decimal places.

From the File Format list, select NO to indicate that the EDI data contains
a number with an implied decimal point and no decimal places.

Select the Standard Rule tab.

Click the Use Accum option.

10

Click New to access the Edit Accumulator Entry dialog to create a new
calculation using this element.

Edit Accumulator Entry

| x|
Primary Accumudator  [JENIE =] Neme | ok |
- Operation Cancel |
G| 3 e e |
Sesond| | |
Tt | |
Falli | =]

11

From the Primary Accumulator list, select 0. Before any calculations are
performed on an accumulator, its content is 0. When you use this
accumulator, the system adds a new accumulator to the bottom of this list.

12

In the Name box, enter Item Number to give the accumulator a
descriptive alias that enables you to differentiate the purposes of the
accumulators you create.

13

From the First list, select Increment primary to specify that the system
increments the value in this accumulator by one for each iteration of the
IT1 group. This operation is the first operation that the system performs.
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14

From the Second list, select Use primary to specify that the system loads
the current value of the accumulator into the IT101 (Assigned
Identification) element. This operation is the second operation that the
system performs, after the First operation is completed.

The Edit Accumulator Entry dialog now should look like this:

umulatar Enlry
Piimary ccunulsice [0 [2] Mame= [l1em Mumber | i |
Operatiars Cancel
Firsl Ilmu'nutprimal_l,l Hﬂlmuhﬂnml |:|
Secorm [ Uiz primay [=]
Thd | [=]
Fauth | (=]

15

Click OK to add the accumulator and exit the Edit Accumulator Entry
dialog.

The dialog now should look like this:

Element Properties
M ame | Y alidation | Dizplay | Surnmary List | Help
Extended Rule Standard Rule | Conditions
Please select the standard rle to use : IUse Accurmulator j
Frimary Accumulator Op1l 0Op2 Op3d Opd

O-ltermn Mumber

Delete

Change... |

Ok | Cancel Sl Help

16

Select the Display tab.

17

Click the Displayed but not editable option to make this field display-
only.

18

In the Label box, enter Item No. to replace the existing field label.
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19

In the Maximum number of characters box, enter 5.

20

Select the Summary List tab.

21

In the Summary List section, click the Display this field in summary list
check box to turn this option on. The value in the Item No. field is
displayed in a column in the Line Items list.

22

In the Column Width box, enter 8 to set the width of this column in the
Line Items list.

Note

The column width should be wider than the actual content of the column.
The extra space that is not used for the content of the column provides
white space separating the columns. If the column width is the exact width
of the data, then there is no space separating the columns of data.

23

From the Sequence list, select 1 to indicate that this field is the first
column in the list.

24

Click OK to exit the dialog.

25

Double-click the CTTO01 element (in the CTT segment).

System Response
The Element Properties dialog is displayed.

26

Select the Standard Rule tab.

27

Click the Use Accum option.

28

Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.

29

From the Primary Accumulator list, select 0.

30

From the First list, select Use primary to specify that the system loads the
current value of the accumulator into the CTTO1 (Number of Line Items)
element.

31

Click OK to add the accumulator.

32

Select the Display tab.

33

Click the Displayed but not editable option. Users are able to read the
data in the Number of Line Items field, but are not able to enter a value in
this field.

34

Click OK to exit dialog.
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How to customize The IT102 element contains the Quantity Invoiced for each item in the invoice. The

the IT102 element quantity for each line item is used to calculate the total dollar amount of the invoice. From
this calculation, you generate a running total of extended price and load the final total into

the TDSO1 (Total Invoice Amount) element.

You create a list definition for the IT102 element to include the quantity invoiced in the

list. For brevity on the translation object, you rename the field label. The standard allows
up to a ten-digit number in this field. You know that your users do not enter a quantity of

more than 99,999 (a five-digit number) for any one item, so you change the maximum
length for this field and element to five.

Use this procedure to use an accumulator in the IT102 element to generate a running total

of extended price that is used in the TDSO1 element, rename the field label, change the
field and element lengths, add Help text, and create the list definition for this field.

Step

Action

1

Double-click the IT102 element (in the IT1 group).

System Response
The Element Properties dialog is displayed.

Select the Standard Rule tab.

Click the Use Accum option.

Click New to access the Edit Accumulator Entry dialog to create a new
calculation using this element.

From the Primary Accumulator list, select 1.

In the Name box, enter Extended Price to give the accumulator a
descriptive alias that enables you to differentiate the purposes of the
accumulators you create.
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7

From the First list, select Load primary to specify that the system loads
the content of the IT102 element into the Primary Accumulator for each
iteration of the IT1 group. This operation is the first operation that the
system performs.

The Edit Accumulator Entry dialog now should look like this:

Edit Accumulator Entry

E
Primary Accumulator I‘I j Mame IExtended Price k. I

— Operations Cahcel

First ILoad primany j Altermate SErunm I vl

Second I j
Third =]
Eaurtty I j

Click OK to add the accumulator.

Select the Validation tab.

10

In the Max box on the Element Properties dialog, enter 5 to allow a five-
digit number in this element.

11

From the Form Format list, select RO to indicate that this field accepts a
number with an explicit decimal point and no decimal places.

12

Select the Display tab.

13

In the Label box, enter Quantity to replace the existing field label.

14

In the Maximum number of characters box, enter 5 to allow five numeric
digits to be displayed in this field.

15

Select the Summary List tab.

16

Click the Display this field in summary list check box to turn the option
on. The value in the Quantity field is displayed in a column in the Line
Items list.

17

In the Column Width box, enter 8 to set the width of this column in the
Line Items list.

18

From the Sequence list, select 3 to indicate that this field is the third
column in the list.

19

Select the Help tab.
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20

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the quantity of this invoiced item. The quantity cannot
exceed 5 digits.

21

Click OK to exit the dialog.

22

Double-click the IT104 element.

System Response
The Element Properties dialog is displayed.

Element Properties
Extended Fule I Standard Rule I Conditions
Name | Walidation I Dizplay I Summary List I Help

Pleaze enter the name :

|0212

Flease enter a short description :

UINIT PRICE

Cancel Apply Help

o |

23

Select the Standard Rule tab.

24

Click the Use Accum option.

25

Click New to access the Edit Accumulator Entry dialog to create a new
calculation using this element.

26

From the Primary Accumulator list, select 1.
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27

From the First list, select Multiply with primary to specify that the
system multiplies the value of the IT104 (Unit Price) element by the
content of the primary accumulator, and stores the result in the primary
accumulator for each iteration of the IT1 group. This operation is the first
operation that the system performs.

The Edit Accumulator Entry dialog now should look like this:

Frimary Accumulator I‘I VI Hame IExtended Price] a4 I

— Operations Cancel |
First IMuItipIy with primary j Altemate Secu I s I

Second I j
Tt =
Gt I j

28

Click OK to add the accumulator.

The dialog now should look like this:

Element Properties E
I ame | W alidation | Display | Sumrnary List | Help
Estended Rule Standard Rule | Conditions
Flease select the standard rule to use : IUse Accurmnulator j
Primary Accumulator Opl 0Op2 0Op3d Opd
1-Ertended Price Fult
Change... |
Delete |
QK | Cancel | Al | Help |

29

Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.

30

From the Primary Accumulator list, select 2.
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31

In the Name box, enter Running Price to give the accumulator a
descriptive alias that enables you to differentiate the purposes of the
accumulators you create.

32

From the First list, select Add primary to alternate to specify that the
system adds the content of the primary accumulator to the content of the
alternate accumulator, and stores the result in the primary accumulator for
each iteration of the IT1 group.

33

From the Alternate Accum list, select 1. This operation specifies that the
system adds the value of accumulator 1 (which contains the extended
price for a line item) to the value of accumulator 2. The system stores the
sum in accumulator 2, which contains a running total of the extended price
with each iteration of the IT1 group.

34

Click OK to add the accumulator.

System Response
The dialog now should look like this:

Element Properties
Mame | Validation | Dizplay | Summary List I Help
Extended Fule Standard Rule Conditions
Pleaze select the standard rule bo uze IUse Accumulator j

Primary Accumulaton Op1 0Op2 0Op3 Opd
1 ' Mt Hew...

Change. ..

Delete

i

Qk I Cancel | S | Help

35

Click OK to exit the Element Properties dialog.

36

Double-click the TDS01 element (in the TDS segment).

System Response
The Element Properties dialog is displayed.

37

Select the Standard Rule tab.

38

Click the Use Accum option.
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39

Click New to access the Edit Accumulator Entry dialog to create a new
calculation for this element.

40

From the Primary Accumulator list, select 2.

41

From the First list, select Use primary to specify that the system loads the
content of the primary accumulator into the TDSO01 (Total Invoice
Amount) element.

System Response
The Edit Accumulator Entry dialog now should look like this:

Edit Aceammulatar Enbry

2 rane AL izl |2 |£| bzme |?u1ri';|P'c:3 l e I
Car Lo I

Mpistion
Tizt|Lsa pimew 3] s oo | |zl
o 3
T | &
| 3

42

Click OK to add the accumulator.

43

Select the Validation tab.

44

From the Form Format list, select R2 to indicate that this field accepts a
number with an explicit decimal point and two decimal places.

45

Select the Display tab.

46

Click the Displayed but not editable option. Users are able to read the
data in the Total Invoice Amount field, but are not able to enter a value in
this field.

47

Click OK to exit the dialog.
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How to customize The IT103 element contains the Unit or Basis for Measurement Code for each item in the

the IT103 element invoice. For brevity on the translation object, you rename the field label. Also, you
customize the IT103 element so that a list containing all valid codes in the Unit or Basis
for Measurement Code code list is available to your users when they use the screen entry
translation object. The list enables them to select the appropriate EDI code from the ones
available.

Use this procedure to rename the field label, add Help text, and load the code list table

Customizing the IT1 Segment

from the standard for the Unit or Basis for Measurement Code field.

Step

Action

1

Double-click the IT103 element (in the IT1 group).

System Response
The Element Properties dialog is displayed.

Element Properties E
Extended Ruls | Standard Rule | Conditions
Name | Walidation I Dizplay | Summary List I Help

Pleaze enter the name
|0355

Fleaze enter a short description :
UMIT OR BASIS FOR MEASUREMENT CODE

Ok, I Cancel Sl Help

Select the Display tab.

In the Label box, enter UOM to replace the existing field label.

Select the Help tab.

In the Help Text list, enter the following text:

Select the unit of measurement for the invoiced item.

Select the Standard Rule tab.

Select the Use Code option.
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8

Click Edit to access the Edit Code List dialog.

Edit Code List

— T able Details
Table D [0355 Desc [UNIT OF BASIS FOR MEASLIREMENT CO (0%
—Allawed Code Cancel
Code Yalus Drescription

Change...

Delete

[ X]
|
[t
__peee |

The Table ID box contains 0355, which is the name of the element for
which this code list table is used. The Desc box contains UNIT OR
BASIS FOR MEASUREMENT CODE, which is the description of the
element for which this code list table is used.

Click Load to access the Load Code List dialog.

You are prompted to select an ODBC data source name. Select the
appropriate DSN and click OK to access the Load Code List dialog.

Load Code List
— Select Code Source
Standard  [-/003040/0 | tist foxms =
Cancel |
—Select Codes
Codes In Standard Codes Selected

S TUAL FOUNGE ﬁl

g5 ETATUTE MILE :

03 SECONDS M
04 GSMALL SPRAY

05 LFTS Add Al =5

0 HEATLOTS [Tl

10 GROUP )

11 QUTFIT _lﬂ —l< femave
*

10

Click Add All to select all the codes and move them to the Codes Selected
list.

11

Click OK to load the code list and exit the Load Code List dialog.
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(Contd)
Step Action

12 Click Close to exit the Edit Code List dialog.

The dialog now should look like this:
Element Properties E

Hame I Y alidation | Dizplay | Summary List I Help
Extended Rule Standard Rule | Conditions

Pleasze select the standard rule to use : IUse Code j

Please select the code list to use

|D355 UNIT OF BASIS FOR MEASUREMENT CODE j

" Raise a compliance eror if the code is not found in the list

IF pou would like the description of the code to be stored in a field, pleaze
select that field below :

| =

0K | Cancel Sl Help

13 Click OK to exit the dialog.

The IT104 element contains the Unit Price for each item in the invoice. You already used
an accumulator for this field so that the price for each line item is used to calculate the
total dollar amount of the invoice. From this calculation, a running total of extended price
is generated and the final total is loaded into the TDSO01 (Total Invoice Amount) element.
You create a list definition for the IT104 element to include the unit price in the list.

For this tutorial, you rename the field label. Also, the standard designates an “R9” screen
format for this field, meaning that the price is formatted with an explicit decimal point and
up to nine decimal places. Your users enter a price in an “R2” format (a number with up to
two decimal places), so you change the screen format from “R9” to “R2.”

The standard defines this element as having a maximum length of fourteen. For this
tutorial, the items you sell Pet Zone are not priced at more than $9,999.99 each, so this
field needs a maximum length of only eight (four places for the dollars; two places for the
cents; one place for the decimal point; and one place for a plus or minus sign, if present).
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Use this procedure to rename the field label, change the field length and number format,
add Help text,

and create the list definition for the Unit Price field.

Step

Action

1

Double-click the IT104 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8 to allow eight numeric digits in this field,
including a plus or minus sign and a decimal point.

From the Form Format list, select R2 to indicate that this field on the
translation object accepts a number with an explicit decimal point and up
to two decimal places.

Select the Display tab.

In the Label box, enter Price to replace the existing field label.

In the Maximum number of characters box, enter 8 to allow eight numeric
digits in this field, including a plus or minus sign and a decimal point.

Select the Summary List tab.

Select the Display this field in summary list check box.

System Response
The value in the Price field is displayed in a column in the Line Items list
box.

10

In the Column Width box, enter 8 to set the width of this column in the
Line Items list.

11

From the Sequence list, select 4 to indicate that this field is the fourth
column in the list.

12

Select the Help tab.

13

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the unit price for this item. The price cannot exceed 8
digits, including a plus or minus sign and a decimal point.

14

Click OK to exit the dialog.
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How to customize The IT106 element contains the Product/Service ID Qualifier for each item in the invoice.

the IT106 element The IT101 element contains the two-character code to indicate what type of product/
service ID is in the Product Code field (IT107 element). You know that the only type of
product/service ID that your users enter for this invoice is the UPC code, so you define a
constant value for the Product/Service ID Qualifier field, designating that the constant
“UP” qualifies the number in the Product Code field. When a user enters a UPC code in
the Product Code field, the system automatically assigns the code “UP” to the Product/
Service ID Qualifier field.

Use this procedure to define a constant value and hide the Product/Service ID field.

Step Action

1 Double-click the IT106 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to access the Map Constants dialog.

5 Click New to access the Edit Constant dialog.
Edit Constant E

1D Type
| | =]

ralue Cancel |

6 In the ID box, enter UPC Package Code to identify the constant.
7 From the Type list, select String.

8 In the Value box, enter UP.

9 Click OK to add the constant.

10 Click Close to exit the Map Constants dialog.

11 From the Constants list, select UP.
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How to customize
the IT107 element

Customizing the IT1 Segment

Creating a Screen Entry Form

(Contd)
Step Action
12 From the Qualifies list, select 0234 PRODUCT/SERVICE ID, which is
the element that the Product/service ID Qualifier field qualifies.
The dialog now should look like this:
Element Properties [ ]
Mame | Walidation | Dizplay | Summary List | Help
Extended Rule Standard Rule | Conditions
Flease select the standard ule to uze IUse Caonstant j
Please select a constant to stare in this figld :
up =] Edit. |
IF thiz constant is a qualifier for another field, Gentrat can automatically use the
eriztence of data in that field to determing whether to execute this standard mile. To
take advantage of this feature, simply selact the field to be qualified :
24 PRODUCT ASERY
ak I Cancel Al Help
13 Select the Display tab.
14 Select the This field should not appear on the form option.
15 Click OK to exit the dialog.

The IT107 element contains the Product/Service ID for each item in the invoice. For this
tutorial, you rename the field label to Product Code. The standard allows up to a thirty-

character string in this field. You know that your users enter product identification
numbers (UPC codes) that are no longer than ten characters, so you change the maximum
length for this field. Also, you create a list definition for the IT107 element to include the
product code in the Line Items list on the Invoice frame.

Use this procedure to rename the field label, change the field length, add Help text, and
create the list definition for the Product/Service ID field.

Step

Action

1

Double-click the IT107 element.

System Response
The Element Properties dialog is displayed.
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Customizing the IT1 Segment

(Contd)
Step

Action

2

Select the Validation tab.

3

In the Max box, enter 10.

Select the Display tab.

In the Label box, enter Product Code.

In the Maximum number of characters box, enter 10.

Select the Summary List tab.

Select the Display this field in summary list check box. The value in the
Price field is displayed in a column in the Line Items list box.

In the Column Width box, enter 13 to set the width of this column in the
Line Items list.

10

From the Sequence list, select 2 to indicate that this field is the second
column in the list.

11

Select the Help tab.

12

In the Help Text box, enter the following text (press Enter at the end of
each line of text below):

Enter your company's product code for this item in the invoice.
The product code cannot exceed 10 alphanumeric
characters.

13

Click OK to exit the dialog.
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Customizing the PID Group Creating a Screen Entry Form

Customizing the PID Group

Overview  The PID group contains the Product/Item Description for each item in the invoice. You
already activated the PID:2 segment in the PID group.
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Creating a Screen Entry Form

Customizing the PID:2 Segment

Customizing the PID:2 Segment

Overview

How to customize
the PID:201
element

The PID:2 segment (in the PID group) contains the Product/Item Description for each
item in the invoice. When the PID:2 segment is activated, the PID:201 element is
mandatory. Earlier in this tutorial, you activated the PID:205 element also. The PID:205
element provides a description of each item in the invoice, and the PID:201 element
qualifies that description.

By standard definition, the PID:201 element contains the Item Description Type (“F” for
free-form item description, “S” for structured description, or “X” for semi-structured
description) for the invoiced item. For this tutorial, you know that the only type of
description your users enter for this invoice is a free-form description. You define a
constant value for the Item Description Type field to indicate that the constant “F”
qualifies the text in the Description field. When a user enters a free-form description in the
Description field, the system automatically assigns the code “F” to the Item Description
Type field.

Use this procedure to define a constant value and hide the Item Description Type field.

Step Action

1 Double-click the PID:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to access the Map Constants dialog.
5 Click New to access the Edit Constant dialog.

[n] Type
|| _——

Walue Cancel |

6 In the ID box, enter Free-Form Description to identify the constant.

7 From the Type list, select String to indicate that the literal constant is
formatted as a string data type.

8 In the Value box, enter F to indicate that the Product/Service ID Qualifier
field is a free-form description. This value is the actual value of the literal
constant.
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Customizing the PID:2 Segment Creating a Screen Entry Form

(Contd)
Step Action
9 Click OK to add the constant.
10 Click Close to exit the Map Constants dialog.
11 From the Constants list, select F to identify the constant that is used for

this element.

12 From the Qualifies list, select 0352 DESCRIPTION, which is the
element that the Item Description Type field qualifies.

The dialog now should look like this:

Element Properties E
M armne I W alidation | Dizsplay | Sumrmary List I Help
Extended Rule Standard Rule | Conditions
Flease zelect the standard rule to use IUse Conztant j

Fleaze select a constant ta stare in this field :
F x| Edt. |

If this constant iz a qualifier for anather field, Gentran can automatically uze the
existence of data in that field to determine whether to execute thiz standard ule. To
take advantage of this feature, simply zelect the field to be qualified :

I PTION

QK I Cancel S Help

13 Select the Display tab.
14 Select the This field should not appear on the form option.
15 Click OK to exit the dialog.
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Creating a Screen Entry Form Customizing the PID:2 Segment

How to customize The PID:205 element contains the Description of each invoiced item, and is defined by the
the PID:205 standard to be a string of up to eighty alphanumeric characters. You add Help text to this
element  field.

Use this procedure to add Help text to the Description field.

Step Action

1 Double-click the PID:205 element.

System Response
The Element Properties dialog is displayed.

2 In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the description of the invoiced item. The description
cannot exceed 80 alphanumeric characters.

3 Click OK to exit the dialog.
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Customizing the DTM:2 Segment Creating a Screen Entry Form

Customizing the DTM:2 Segment

Overview

How to customize
the DTM:201
element

In this tutorial, you use two iterations of the DTM segment (Date/Time Reference). The
first active DTM segment in the invoice (the DTM:2 segment) is used to enter the contract
date of the invoice. The DTM:2 segment you customize first is in the IT1 group (on the
Line Items frame) and specifies the date on which each item in the invoice was shipped.
You already changed the maximum use of the DTM:2 segment so that its associated fields
are displayed on the same frame as the PID:2 and IT1 fields.

The DTM:201 element (Date/Time Qualifier) is a mandatory element for the DTM:2
segment. The DTM:201 element contains the three-character code from your EDI data to
indicate what type of date follows (e.g., date shipped). You define a constant value for the
Date/Time Qualifier field, designating that the constant “011” qualifies the date in the
Date field.

When a user enters the date on which the item was shipped in the Date field, the system
automatically assigns the code 011 to the Date/Time Qualifier field. The user does not
need to enter the code in the qualifier field, so the qualifier field does not need to be
displayed.

Use this procedure to define a constant and hide the Date/Time Qualifier field.

Step Action

1 Double-click the DTM:201 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab.

3 Click the Use Constant option.

4 Click Edit to display the Map Constants dialog.

5 Click New to display the Edit Constant dialog.
Edit Constant E

1D Type
| | =]

ralue Cancel |

6 In the ID box, enter Date Shipped to identify the constant.

7 From the Type list, select String to indicate that the literal constant is
formatted as a string data type.
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Creating a Screen Entry Form

Customizing the DTM:2 Segment

(Contd)
Step

Action

8

In the Value box, enter 011 to indicate that the Date/Time Qualifier field
contains the Date Shipped. This value is the actual value of the literal
constant.

Click OK to add the constant.

10

Click Close to exit the Map Constants dialog.

11

From the Constants list, select 011.

12

From the Qualifies list, select 0373:6 DATE, which is the element that the
Date/Time Qualifier field qualifies.

The dialog now should look like this:

Element Properties E
Marne I Walidation | Dizplay | Surmary List I Help |
Extended Fule Standard Rule | Conditions
Please select the standard rule to uze : ILIse Constant j

Pleaze select a constant bo store in this field ;
0 =zl Edt. |

IF thiz constant iz a qualifier for another figld, Gentran can automatically use the
existence of data in that field to determine whether to execute this standard ule. To
take advantage of thiz feature, simply select the field to be qualified :

] ATE

Qg I Cancel Aol Help

13

Select the Display tab.

14

Select the This field should not appear on the form option.

15

Click OK to exit the dialog.
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Customizing the DTM:2 Segment Creating a Screen Entry Form

How to customize The DTM:202 element in the DTM:2 segment contains the Date qualified by the Date/
the DTM:202 Time Qualifier field. This element is defined by the standard to be a Date/Time data type
element of six characters. In this tutorial, you know that the shipped date is always an eight-
character date, so you change the element and field lengths to accommodate the new
length. Also, you rename the field label and add Help text to the field.

Your users format the date as “MM/DD/YY” when they enter the date in the screen entry
translation object, but the EDI data is sent to your trading partner as “YYMMDD.” You
set the screen format and EDI format for this element accordingly.

Use this procedure to set the date format, change the element and field lengths, rename the
field label, and add Help text to the Date field.

Step

Action

1

Double-click the DTM:202 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 8 to allow the entire date, including separators
(/), in this element.

From the Form Format list, select MM/DD/YY to indicate that this field
on the translation object accepts a date entered in the format MM/DD/YY.

Verify that YYMMDD is selected in the File Format list to indicate that
the EDI data is sent in the format YYMMDD.

Select the Display tab.

In the Label box, enter Date Shipped.

In the Maximum number of characters box, enter 8 to allow the entire
date, including separators (/), to be displayed.

Select the Help tab.

10

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter the date on which this invoiced item was shipped. Use
the format MM/DD/YY.

11

Click OK to exit the Display dialog.
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Customizing the CAD Segment

Overview

How to customize
the CADO1
element

The CAD segment contains Carrier Detail, such as the transportation method. For this
tutorial, you provide a list for users from which users select the transportation method for
the invoiced item, and provide a field so they can enter a reference number to identify the
carrier.

The CADO1 element, the Transportation Method/Type Code, contains the two-character
code that identifies the transportation method (e.g., parcel post, air express, etc.) for each
invoiced item. You customize the CADO1 element so that a list containing all valid codes
in the Transportation Method/Type Code list is available to your users when they use the
screen entry translation object.

After you specify the code list table to use for the list for the Transportation Method/Type
Code field, you rename the field label to identify this field better.

Use this procedure to load the code list table from the standard, rename the field label, and
add Help text to the Transportation Method/Type Code field.

Step Action

1 Double-click the CADO1 element.

System Response
The Element Properties dialog is displayed.

2 Select the Standard Rule tab..

3 Select the Use Code option.
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Customizing the CAD Segment Creating a Screen Entry Form

(Contd)
Step

Action

4

Click Edit to access the Edit Code List dialog.

The Table ID box contains 0091, the name of the element for which this
code list table is used. The Desc box contains TRANSPORTATION
METHOD/TYPE CODE, the description of the element for which this
code list table is used.

Edit Code List E
— Table Detail
Table ID |UUEI'I Desc ITHANSPDHTATIDN METHOD/TYPE COD
r Allowed Codes Cancel |
Code Value Dezcription

Mem...
Change...
Delete

Load..

i

Click Load to access the Load Code List dialog. You are prompted to
select an ODBC data source name. Select the appropriate DSN and click
OK to access the Load Code List dialog.
Load Code List

— Select Code Source

H
e
]

Standard [/003040/0 2l Lt foos

Cancel |

— Select Codes

Codes In Standard Codes Selected
1 alR CHARTEH

£ MILITARY DFFIEIA\:’ 5
7 AL M

& AIR

4T AIRCHARTER Add Al -5
8F AR EXPRESS [ ez |
&F AR FREIGHT )

xxj AIR TAX) _ILI ﬂl
4 »

KN - 0|

Click Add All to select all the codes and move them to the Codes Selected
list.

Click OK to load the code list and exit the Load Code List dialog.
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Customizing the CAD Segment

(Contd)
Step

Action

8

Click Close to exit the Edit Code List dialog.

The dialog now should look like this:

Element Properties [ x|

Mame | Walidation I Display I Surmmary List I Help
Extended Rule Standard Rule | Conditions
Please select the standard rule to use : |U$e Code j

Pleaze select the code list to uze
IDDS1 TRAMSPORTATION METHOD/TYFE CODE j

™ Raize a compliance emor if the code iz not found in the list

If pou would like the description of the code to be stored in a field, pleaze
zelect that field below :

| =

0K Cancel AppEy Help

Select the Display tab.

10

In the Label box, enter Transport Method.

11

Select the Help tab.

12

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Select the transportation method code for this invoiced item
from the list.

13

Click OK to exit the dialog.
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Customizing the CAD Segment Creating a Screen Entry Form

How to customize The CADO8 element contains a Reference Number, which is used in this tutorial to
the CADOS identify the carrier for an invoiced item. This element is defined by the standard to be a
element string of thirty alphanumeric characters. Your company has assigned reference numbers to
the carriers with whom they have contracted. In this tutorial, you know that the carrier
reference number cannot exceed twelve alphanumeric characters. You change the element
and field lengths to accommodate the shorter reference number. In addition, you rename
the field label and add Help text to the field.

Use this procedure to change the field and element lengths, rename the field label, and add
Help text for the Reference Number field.

Step

Action

1

Double-click the CADO0S8 element.

System Response
The Element Properties dialog is displayed.

Select the Validation tab.

In the Max box, enter 12.

Select the Display tab.

In the Label box, enter Carrier Code.

In the Maximum number of characters box, enter 12.

Select the Help tab.

In the Help Text list, enter the following text (press Enter at the end of
each line of text below):

Enter your company's reference number for this carrier. The
reference number cannot exceed twelve alphanumeric
characters.

Click OK to exit the Display dialog.

10

Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.
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Creating a Screen Entry Form Customizing the CAD Segment

(Contd)
Step Action
11 Click Save from the File menu to save the form.

The Line Items list now should look like this:

Item Mo, |:| 3
Duiantity :

LOM 7]

Product Code |

Description |

Date Shipped

Tranzportation Method E[

Carrier Code i

W &
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Customizing the TDS Segment

Overview  The TDS segment contains the Total Monetary Value Summary for the invoice. You
already used an accumulator in the TDSO1 element to calculate the total dollar amount
invoiced, and made this field display-only so that users cannot change the value in this
field.
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Customizing the CTT Segment

Overview  The CTT segment is a mandatory segment that displays Transaction Totals for the invoice.
For this tutorial, you use the CTTO1 element to display the total number of line items
invoiced. You already used an accumulator in the CTTO1 element to generate a total of the
number of line items, and made this field display-only so that users cannot change the
value in this field.

Now that you have customized all of the elements used in this invoice, you are ready to
format the fields and labels to make the frames more consistent and visually attractive.
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Format the Screen Entry Form

Overview

Introduction In the previous section of this tutorial, you customized the screen entry form for an ANSI
X12 003040 invoice (810) that your users will use to enter data to invoice Pet Zone for
items that were shipped to them. After successfully customizing the fields and elements of
the screen entry form, you are ready to format the layout of the form.

This section explains how to format the form, field by field.
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Creating a Screen Entry Form Resizing the Invoice Frame

Resizing the Invoice Frame

Overview  When a form is compiled into a translation object, the fields are arranged according to
how the frames and the fields contained on them were arranged when the form was
compiled. You should eliminate unnecessary space as you arrange the fields on each
frame.

CAUTION

WHEN YOU RESIZE THE FRAMES OF A SCREEN ENTRY FORM,
YOU MUST RESIZE BASED ON THE RESOLUTION OF THE TARGET
MONITOR (E.G., THE MONITOR ON WHICH THE END USER VIEWS
THE TRANSLATION OBJECT). FOR EXAMPLE, IF YOU SIZE THE
FRAMES OF A SCREEN ENTRY FORM ON A SUPER VGA MONITOR,
THE COMPILED TRANSLATION OBJECT MAY NOT FIT IN THE
DISPLAY AREA OF A VGA MONITOR.

Procedure  Use this procedure to resize the Invoice frame.

Step Action
1 Click the 810 INVOICE file icon to display the Invoice frame in the
Layout Window.
Note

When the form is generated, the upper left corner of each frame in the
form is placed in the upper left corner of the Layout Window.

2 To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window is wide enough to display as much of the form as
you want to view.
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Creating a Screen Entry Form

(Contd)
Step

Action

3

To resize the Invoice frame, click and drag the right side of the frame
approximately to the 14 cm. mark on the horizontal ruler so that the form
is wide enough to format the fields according to the instructions in this
tutorial.

Note

Use the horizontal ruler at the top of the frame to help you resize the
frame. The instructions in this tutorial are given in centimeters. If your
rulers display inches (the default) as the measurement system, you can
toggle the measurement system from inches to centimeters by double-
clicking the yellow square where the vertical and horizontal rulers meet.

The Invoice frame now should look like this:

Involce
I nvice Diata ] 2

Imvice Mo. |

F.0. Dt |:|

F.0. Wi | |

Conlract Mo | |

ShipTo |

Remi Ta
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Arranging the Fields on the Invoice Frame

Arranging the Fields on the Invoice Frame

Overview

Invoice frame

You begin formatting the screen entry form by arranging the fields on the Invoice frame.
You place the fields in the translation object in a logical order, then align the fields to give
the frame a consistent and orderly appearance.

When you have finished arranging the fields, your Invoice Frame should look like the one
in the example below.

Invralce
et [ | o] M £
S — Poos [
L — L
ShipTo: [ |
I |
I |
I LI
Aaeiit Toe | |
I I
I |
I I
Pagmen| Taina Code |:| E
Lina b 4
3
= [
Humber OF Line [bamE: |:|
Toddl Intcica Arncunt |:|
r

By default, each field and its associated label are displayed on their own line. However, it
is common for invoices to place two or more fields on a line.

You prevented some of the field labels from being displayed (by removing the field label
in the Label field of the Display dialog). For these fields, the fields are displayed on your
screen entry form, but their associated labels are not displayed.

Note

If you forget which unlabeled field contains what data, you can click the field. Its
associated element is highlighted in the EDI File Format Window, providing you with a
description of the field.
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How to resize, Use this procedure to resize, move, and align the fields on the Invoice frame of the screen
move, and align  entry form:

the fields Note

If a field and its corresponding field label move together, the Lock Labels to Fields option
is selected. Click the Lock Labels button on the Main Toolbar to turn off the Lock Labels

option.
Step Action
1 Select the following fields:
» Invoice Date
» Invoice No.
» P.O.Date
» P.O.No.
» Contract No.
» Contract Date
Note
To select more than one field, click the first field, then press CTRL and
click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.
Note
If any of these fields is not in the part of the Invoice frame that currently is
displayed, then use the scroll bar to scroll down the frame until you locate
the hidden fields.

2 Select Size to Length from the Display menu. The selected fields are
resized to the lengths specified in the Maximum number of characters box
of the Display dialog for each field.

3 Select the Invoice Date label and field and drag them to the upper right
corner of the Invoice frame.

4 Select the Invoice Date ficld and drag it closer to its label.

5 Select the Invoice No. label and field and drag them to the upper left
corner of the frame.

6 Select the Invoice No. field and drag it closer to its label.

7 Select the P.O. Date label and field and drag them to the right side of the
frame, below the Invoice Date label and field.

8 Select the P.O. Date field and drag it closer to its label.

9 Select the P.O. No. label and field and drag them to the left side of the
frame, below the Invoice No. label and field.
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Arranging the Fields on the Invoice Frame

(Contd)
Step

Action

10

Select the P.O. No. field and drag it closer to its label.

11

Select the Contract No. label and field and drag them to the left side of
the frame, below the P.O. No. label and field.

12

Select the Contract No. field and drag it closer to its label.

13

Select the Contract Date label and field and drag them to the right side of
the frame, below the P.O. Date label and field.

Note

If the Contract Date field is not in the part of the Invoice frame that
currently is displayed, then use the scroll bar to scroll down the frame
until you locate the Contract Date field.

14

Select the Contract Date field and drag it farther away from the label so
that they do not overlap.

15

Select the Ship To field (not the field label) and the two Address
Information fields and the City Name field of the Ship To address. (The
two Address Information fields and the City Name field are located below
the Ship To field.)

16

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned in a row.

17

Select the State or Province Code field of the Ship To address and drag it
to the immediate right of the City Name field of the Ship To address.

18

Select the Postal Code field of the Ship To address and drag it to the
immediate right of the State or Province Code field of the Ship To address.

19

Click and drag all of the Ship To fields (including the Ship To field label)
to the left side of the frame, below the Contract No. label and field.

Note

To select a group of items, click and drag the mouse diagonally across all
the fields/labels you want to select. When you release the mouse button,
all the fields and field labels completely included within the space formed
by dragging the mouse has handles, indicating they were selected.

20

Select all of the Ship To fields (not including the Ship To field label) and
drag them closer to the Ship To field label.

21

Select the Remit To field (not the field label) and the two Address
Information fields and the City Name field of the Remit To address. (The
two Address Information fields and the City Name field are located below
the Remit To field.)
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(Contd)
Step

Action

22

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned in a row.

23

Select the State or Province Code field of the Remit To address and drag
it to the immediate right of the City Name field of the Remit To address.

24

Select the Postal Code field of the Remit To address and drag it to the
immediate right of the State or Province Code field of the Remit To
address.

25

Select all of the Remit To fields (not including the Remit To field label)
and drag them closer to the Remit To field label.

26

Click and drag all of the Remit To fields (including the Remit To field
label) below the Ship To address.

27

Select the Payment Terms Code list.

28

Click and drag its right handle so that the list is approximately 1.5 cm.
wide (including the Down Arrow).

Note
Use the horizontal ruler to help you find specific locations on the ruler, or
to help you measure width.

29

Click and drag its bottom handle to make the drop-down part of the list
long enough to list approximately four codes.

30

Select the Payment Terms Code list and label and drag them to the center
of the frame, below the Remit To address.

31

Select the Line Items list and drag it closer to its label.

32

Select the Line Items list and label and drag them to the center of the
frame, below the Payment Terms Code list and label.

Note

Leave extra space between the Payment Terms Code list and label, and the
Line Items list and label, to add column headings (using static text) to
label the data in the list.

33

Select the Number of Line Items field and drag it closer to its label.

34

Select the Number of Line Items label and field and drag them to the
center of the frame, below the Line Items list and label.

35

Select the Total Invoice Amount field and drag it closer to its label.

36

Select the Total Invoice Amount label and field and drag them to the
center of the frame, below the Number of Line Items label and field.
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Creating a Screen Entry Form

Arranging the Fields on the Invoice Frame

How to resize the You should resize the Invoice frame to make the most efficient use of space. You already
invoice frame resized the frame horizontally before you began arranging the fields. Then, you arranged

the fields on th

e frame, so the fields do not use the same amount of vertical space as before

you arranged the fields. To make better use of the frame space, you resize the frame

vertically now.

Step

Action

1

To resize the Invoice frame, click and drag the bottom of the frame to just
below the Total Invoice Amount label and field

The Invoice frame now should look like this:

Involce
e — e — :
Cortract No |:| Carirac! u.|=|:|
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| |
| |
| I
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| |
| |
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[+]
= =
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Tola Invaice Ameart |:|
0

Select Save from the File menu.

Forms Integration ANSI Tutorial Guide

Gentran:Server for Windows — August 2008 ()



Arranging the Fields on the Invoice Frame

Creating a Screen Entry Form

How to align the Now that the fields in the Invoice frame are resized and moved to their proper locations,
fields and field you can align the fields and labels.

labels

Use this procedure to align the fields and field labels on the Invoice frame.

Step

Action

1

Select the following field labels:

» Invoice No.

» P.O.No.

» Contract No.
» Ship To

» RemitTo
Note

To select more than one item, click the first item, then press CTRL and
click the second item. Repeat the process of pressing CTRL and clicking
the item for each subsequent item you want to select.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

Select the following fields:
» Invoice No.

» PO.No.

» Contract No.

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned.

Select the following field labels:
» Invoice Date

» P.O.Date

» Contract Date

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

Select the following fields:

» Invoice Date
» P.O.Date
» Contract Date
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Creating a Screen Entry Form

Arranging the Fields on the Invoice Frame

(Contd)
Step

Action

8

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned.

Select the following field labels:
» Number of Line Items

» Total Invoice Amount

10

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected field labels are
aligned.

11

Select the following fields:
» Number of Line Items

» Total Invoice Amount

12

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned.
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Creating a Screen Entry Form

(Contd)
Step

Action

13

To align the tops of all of the field labels and fields, select each row of
items (one row at a time), select Align Controls from the Display menu,
then select Top from the Align Controls submenu. The items for each row
are listed below:

The Invoice frame now should look like this:

Invoice No. label and field, Invoice Date label and field
P.O. No. label and field, P.O. Date label and field
Contract No. label and field, Contract Date label and field
Ship To label and field

City Name, State or Province Code, and Postal Code fields of the
Ship To address

Remit To label and field

City Name, State or Province Code, and Postal Code fields of the
Remit To address

Payment Terms Code label and list
Line Items label and list
Number of Line Items label and field

Total Invoice Amount label and field

Invokee
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Creating a Screen Entry Form Arranging the Fields on the Invoice Frame

How to add Gentran:Server labels the fields on the Line Items frame, but does not label the column
column headings headings for the Line Items list on the Invoice frame. The Line Items list displays the
to the line items list information entered into the fields on the Line Items frame. To label the columns in the
Line Items list, you must add the column headings with static text (text that is always

included in the screen entry translation object).

You add the following column headings to the Line Items list on the Invoice frame:

Column Heading
(Static Text) Placement Above Line Items List
Item First column
Product Second column
Qty. Third column
Price Fourth column

After you add the column headings and move each column heading to its proper location,
the Line Items list and the column headings should look like this:

Itam - Product by, Pric=

Lie ltems *

=] "

Use this procedure to add and position the column headings.

Step Action

1 Click Add Text on the Main Toolbar. Text is added to the current frame,
displayed in the upper left corner of the frame. If the template is larger
than the frame (there is a scroll bar on the right side of the frame), the
static text is displayed in the upper left corner of the part of the template
that is displayed, not at the top of the template.

2 In the new text box, enter Item.

3 Click Add Text on the Main Toolbar. Again, text is added to the current
frame in the upper left corner.

4 In the new text box, enter Product.

5 Click Add Text on the Main Toolbar. Again, text is added to the current

frame in the upper left corner.
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Creating a Screen Entry Form

(Contd)
Step

Action

6

In the new text box, enter Qty. (note the period in the text).

7

Click Add Text on the Main Toolbar. Again, text is added to the current
frame in the upper left corner.

In the new text box, enter Price.

The column headings you added are displayed in the upper left corner of
the frame.

Select the Item static text.

10

Click and drag it to above the Line Items list, immediately to the right of
the left margin of the Line Items list (so it looks like the example on 3 -
119).

11

Select the Product static text.

12

Click and drag it to above the Line Items list, to the right of the Item
column heading (so it looks like the example on 3 - 119).

13

Select the Qty. static text.

14

Click and drag it to above the Line Items list, to the right of the Product
column heading (so it looks like the example on 3 - 119).

15

Select the Price static text.

16

Click and drag it to above the Line Items list, to the right of the Qty.
column heading (so it looks like the example on 3 - 119).
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Arranging the Fields on the Invoice Frame

(Contd)
Step

Action

17

To ensure that the column headings (static text) you just added are aligned
properly, select all the static text you just added (Item, Qty., Product,
Price). Select Align Controls from the Display menu, then select Top
from the Align Controls submenu.

Note

To select more than one item, click the first item, then press CTRL and
click the second item. Repeat the process of pressing CTRL and clicking
the item for each subsequent item you want to select.

The Invoice frame now should look like this:
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How to set the tab
sequence on the
invoice frame

Arranging the Fields on the Invoice Frame

Creating a Screen Entry Form

The tab sequence is the order in which the cursor moves from field to field in the screen
entry translation object when a user presses TAB. When you create a screen entry form,
the system automatically positions the fields and sets the tab sequence for those fields.

However, usually you want to modify the tab sequence of the fields to meet your screen
entry requirements and the new positions of the fields on the frame.

Use this procedure to set the tab sequence for the fields on the Invoice frame.

Step

Action

1

Select Set Tab Order from the Display menu.

System Response
Numbers are displayed in the fields on the frame to indicate the current
tab sequence.
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Arranging the Fields on the Invoice Frame

(Contd)
Step

Action

2

Click the fields and list box listed below in the order in which they are
listed. As you click each field, the tab sequence number for that field will
change to the next sequential number in the tab sequence.

Note

If you click a field out of sequence, you must begin setting the tab
sequence again. To start over, select Set Tab Order from the Display menu
so that the tab sequence numbers are no longer displayed in the fields on
the frame, and then begin these steps again.

a. Invoice No.

b. Invoice Date

c. P.O.No.

d. P.O. Date

e. Contract No.

f. Contract Date

g. Ship To name

h. Ship To address (first line of address)

i.  Ship To address (second line of address)

j. Ship To city

k.  Ship To state or province code

1. Ship To postal code

m. Remit To name

n. Remit To address (first line of address)

0. Remit To address (second line of address)

p.- Remit To city
g- Remit To state or province code
r.  Remit To postal code

s. Payment Terms Code
t. Line Items
u. Number of Line Items

v. Total Invoice Amount

When you click the last field in the sequence (Total Invoice Amount), the
tab sequence is set, and the tab sequence numbers no longer are displayed
in the fields.
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Step

Action

23

The new tab sequence should look like this:
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Creating a Screen Entry Form Arranging the Fields on the Line Items Frame

Arranging the Fields on the Line Items Frame

Overview  Now that the fields, labels, and static text are arranged on the Invoice frame, you are ready
to arrange the fields on the Line Items frame. You will place the fields in a logical order,
then align the fields (as you did with the fields on the Invoice frame) to give the frame a
consistent and orderly appearance. When you finish arranging the fields, the Line Items
frame in your form should look like the one in the example below.

lem Ho I:l Piodicl Crde I:l sy I:l ﬂ‘
| —

Deserplicn |

e I T e | [ R

[=]]

How to resize the Before you begin arranging the fields on the Line Items frame, you should resize the frame
line items frame so that it is the same width as the Invoice frame. When this form is compiled into a
translation object, the fields will be arranged according to how the frames and the fields
contained on them were arranged when the form was compiled. You should eliminate
unnecessary space as you arrange the fields on each frame.

Note
When the form is generated, the upper left corner of each frame in the form is placed in the
upper left corner of the Layout Window.

Step Action
1 Click the IT1 group to display the Line Items frame in the Layout
Window.
2 To resize the Line Items frame, click and drag the right side of the frame

to the 14 cm. mark on the horizontal ruler so that the form is wide enough
to format the fields according to the instructions in this tutorial.

Note
Use the horizontal ruler at the top of the frame to help you resize the
frame.
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(Contd)
Step

Action

3

To display more of the form on your screen, click and drag the center bar
between the EDI File Format Window and the Layout Window to the left
until the Layout Window is wide enough to display as much of the form as
you want.

The Line Items frame now should look like this:
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How to resize the
fields

Use this procedure to resize the fields on the Line Items frame of the screen entry form.

Step

Action

1

Select the following fields:

» Item No.
» Quantity
» Price

» Product Code

» Date Shipped

» Carrier Code

Note

To select more than one field, click the first field, then press CTRL and

click the second field. Repeat the process of pressing CTRL and clicking
the field for each subsequent field you want to select.
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Creating a Screen Entry Form Arranging the Fields on the Line Items Frame

(Contd)
Step Action
2 Select Size to Length from the Display menu.

System Response
The selected fields are resized to the lengths specified in the Maximum
number of characters box of the Display dialog for each field.

How to move and Use this procedure to move and align the fields on the Line Items frame of the screen entry
align the fields  form.

Step Action

1 Select the UOM list and drag its right handle so that it is approximately 2
cm. wide (including the Down Arrow).

Note
Use the horizontal ruler at the top of the frame to help you measure width.

2 Drag its bottom handle so that the list is long enough for four codes to be
displayed in it when the drop-down section is open.

3 Select the Transport Method and UOM lists (in that order).

4 Select Size Equally from the Display menu. The Transport Method list is
the same size as the UOM list (the reference).

5 Select each field on the frame individually and move it closer to its
respective field label. If the field overlaps its label (e.g., Date Shipped),
move the field slightly to the right of the label.

6 Select the Product Code label and field and drag them to the right of the
Item No. label and field (use the example on 3 - 126 for reference).

Note

The Item No. label and field already are positioned where you want them
to be (in the upper left corner of the frame). You do not need to move
them.

7 Select the Quantity label and field and drag them to the right of the
Product Code label and field (use the example on 3 - 126 for reference).

8 Select the UOM label and list and drag them below the Item No. label and
field. The left side of the UOM field label should be aligned with the left
side of the Item No. field label. (Use the example on 3 - 126 for
reference.)
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Arranging the Fields on the Line Items Frame Creating a Screen Entry Form

(Contd)
Step

Action

9

Select the Price label and field and drag them below the Product Code
label and field. The left side of the Price field label should be aligned with
the left side of the Product Code field label. (Use the example on 3 - 126
for reference.)

10

Select the Description label and field and drag them below the UOM and
Price labels and fields. The left side of the Description field label should
be aligned with the left side of the Item No. and UOM field labels. (Use
the example on 3 - 126 for reference.)

11

Select the Date Shipped label and field and drag them to the left side of
the frame, below the Description label and field. The left side of the Date
Shipped field label should be aligned with the left side of the Item No.,
UOM, and Description field labels. (Use the example on 3 - 126 for
reference.)

12

Select the Transport Method label and list and drag them to the right of
the Date Shipped label and field (use the example on 3 - 126 for
reference).

13

Select the Carrier Code label and field and drag them to the right of the
Transport Method label and field (use the example on 3 - 126 for
reference).

Use this procedure to resize the Line Items frame.

line items frame
Step

Action

1

To resize the Line Items frame, click and drag the bottom of the frame to
below the last row of fields and labels (Date Shipped, Transport Method,
and Carrier Code).

Note
Allow enough space between the last row of fields/labels and the bottom
of the frame for the Transport Method list to be opened.

The Line Items frame now should look like this:
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Arranging the Fields on the Line Items Frame

How to align the  Use this procedure to align the fields and field labels on the Line Items frame.

fields and field

labels
Step

Action

1

Select the following labels and fields:

» Item No.

» Product Code

» Quantity

Note

To select more than one item, click the first item, then press CTRL and

click the second item. Repeat the process of pressing CTRL and clicking
the item for each subsequent item you want to select.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and labels are
aligned in a row.

Select the following labels and fields:
» UOM

» Price

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and labels are
aligned in a row.

Select the Description label and field.

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the field and label are aligned in a
row.

Select the following labels and fields:
» Date Shipped
» Transport Method

» Carrier Code

Select Align Controls from the Display menu, then select Top from the
Align Controls submenu. The tops of the selected fields and labels are
aligned in a row.

Select the following field labels:
» Item No.

» UOM

» Description

» Date Shipped
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(Contd)
Step

Action

10

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected field labels are
aligned in a row.

11

Select the following fields:
» Item No.
» UOM

» Description

12

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned in a row.

13

Select the following field labels:
» Product Code

» Price

14

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected field labels are
aligned in a row.

15

Select the following fields (in this order):
» Price
» Product Code

16

Select Align Controls from the Display menu, then select Left from the
Align Controls submenu. The left margins of the selected fields are
aligned in a row.

The Line Items frame now should look like this:

Item No. l:l Product Code l:l Quantity l:l
uaM [ & Pie ]

Desciiption |

Diate Shipped l:l Tranzportation Method vI Carier Code l:l
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Creating a Screen Entry Form

Arranging the Fields on the Line Items Frame

How to set the tab Use this procedure to set the tab sequence of the fields on the Line Items frame.

sequence on the

line items frame
Step

Action

1

Select Set Tab Order from the Display menu.

System Response
Numbers are displayed in the fields on the frame to indicate the current
tab sequence.
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(Contd)
Step

Action

2

Click the fields listed below in the order in which they are listed. As you
click each field, the tab sequence number for that field change to the next
sequential number in the tab sequence you are now setting.

Note

If you click a field out of sequence, you must begin setting the tab
sequence again. To start over, select Set Tab Order from the Display menu
so that the tab sequence numbers are no longer displayed in the fields on
the frame, and then begin these steps again.

a. Product Code

b. Quantity
c. UOM
d. Price

e. Description

f.  Date Shipped

g. Transport Method
h. Carrier Code

i. Item No.

Note

The Item No. field is the last field in the tab sequence, although it is the
first field in the layout of the Line Items frame. This field is display-only,
displaying the next consecutive line item number (the line item number is
generated by an extended rule in the IT1 segment). By placing the Item
No. field last in the tab sequence, this field can be skipped easily by users
entering data. The first field in the sequence is the Product Code field,
which is the first field into which users can enter a value.

10

The new tab sequence should look like this:
Item Mo, El Praduct Code: Quantiy El ﬂ
oM m Price D

Description E

[rate Shipped D Transportation Method ﬂ - Carrier Code D

Note
When you click the last field in the sequence (Item No.), the tab sequence
is set, and the tab sequence numbers no longer are displayed in the fields.
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Changing the Invoice Frame Title

Changing the Invoice Frame Title

Overview  The system automatically titles the frames in a screen entry form when the form is created,
based on the name of the file, segments, or groups. You can modify the frame titles (for
example, at the file or document level) to distinguish one form from the others. The parent
frame of the invoice currently is titled Invoice. You give this frame a more descriptive title
to distinguish it from other invoices that your company uses.

Procedure  Use this procedure to change the frame title.

Step

Action

11

Click the 810 INVOICE file icon with the right mouse button and select
Properties from the shortcut menu.

System Response
The File Format Properties dialog is displayed.
File Format Properties E

Marne | Displa_l,ll Delimiters' Loop Extended Hulesl

Flease enter the name :
|81 i

Flease enter a short description :
INVOICE

0k I Cancel Al Help

12

Click the Display tab.

13

In the Frame Caption box, enter ANSI X12 Invoice (810) - Pet Zone.

14

Click OK.

System Response
The new frame title is displayed in the frame title in the Layout Window.

15

Click Generate Layout on the Main Toolbar to refresh the display of the
screen entry form.

16

Select Save from the File menu to save the form.

You have completed your Invoice form. Now, you are ready to finalize the form.
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Overview Creating a Screen Entry Form

Finalize the Form

Overview

Introduction Now that you have created and customized a screen entry form, you are ready to compile
the form to generate the translation object (*.TPL) that Gentran:Server uses before you
print the report and test the compiled translation object.
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Creating a Screen Entry Form Compiling the Form

Compiling the Form

Overview  The Compile function compiles the form. The form that you create using Gentran:Server
is a source form. When that source form is compiled, the result is a compiled translation
object.

This translation object must be registered with the Gentran:Server system before you can
use it. Use the Compile function after the form is completed and saved.

Procedure  Use this procedure to compile the form.

Step Action
1 Select Compile from the File menu to display the Run-Time Translation
Object Name dialog.
Run-Time Translation Object Hame EHE

Save jn: Ia Trans0bj j gl IEE_

File name: IPET_81 05.TPL

Save az lupe: ITransIation Objects [~ TPL) j Cancel |

2 Click Save to accept the translation object name (pet_810s.tpl) in the “File
name” box.
3 This name for the compiled translation object (.TPL file) is the same file

name as the source form (.STP file). Preserving the same file name (with
different file extensions) ensures that the relationship between the source
form and the compiled translation object remains evident.

The system compiles the form and generates an error report. The error
report is displayed in the Compile Errors dialog.

4 Click OK to exit the Compile Errors dialog.

Note

If the Compile Errors dialog contains errors, you must fix the problems by
redoing the appropriate section of the tutorial. Recompile the form after
you correct the errors and save the form.

5 Select Save from the File menu to save the form. The date on which you
compiled the form is automatically loaded into the Compiled on box on
the Translation Object Details dialog.
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Printing the Report

Creating a Screen Entry Form

Overview  The Gentran:Server report enables you to validate and review the translation object, and
make modifications as needed. If you review the report and determine that the translation
object is incorrect, you should reiterate the form creation process as many times as
necessary (make the modifications, save the form, recompile the form, and print the report

again).

Procedure  Use this procedure to print the Gentran:Server report.

Step

Action

1

Select Print from the File menu to access the Print Options dialog.

Print Options E2

— Repart zections

¥ Frint branching diagram
¥ Prirt record details Cancel |
¥ Print mapping details
¥ Print extended rules

™ Frirt code lists

W Include anly active objects

Click OK to accept the defaults on this dialog (all options checked), so the
report includes all sections and only the activated form components.

System Response
The Print dialog is displayed.

Do you need to change setup options (to select a specific printer, paper
orientation, or size and source of paper) ?

» Ifyes, click Properties. Set the appropriate options. Click OK to
begin the print process.

» Ifno, click OK to begin the print process.
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Testing the Translation Object

Overview  After you compile the form, print and verify the report, and register the translation object

with Gentran:Server, you should test the translation object to verify that the data is

translated correctly. To test the compiled translation object, you should use the translation
object to create a new document. You also should verify acknowledgement processing (if

applicable) and verify communications with your network.

Important
The translation object must be registered with the Gentran:Server system before you can
use it. See the “Gentran:Server® Windows® User’s Guide” for information on registering

the translation object.

Procedure Use this procedure to test the screen entry translation object you just created.

Step

Action

1

Register the PET_810S.TPL translation object with Gentran:Server.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on registering a translation object.

If you have not done so already, import the PETZONE.PAR partner
relationship into Gentran:Server.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on importing a partner.

Verify (in Partner Editor) that the SCREEN 810 Pet Zone screen entry
translation object is selected for the Outbound Relationship.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on selecting outbound translation objects.

Create a new document to enter the data in the screen entry translation
object you created.

Reference
See the “Gentran:Server® Windows® User’s Guide” for more
information on creating a document.
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Glossary

?In Documents This Gentran:Server browser contains a list of documents that were received by the
system but failed compliance checking or that do not have an identifiable partner or
transaction set.

?0ut Documents  This Gentran:Server browser contains a list of documents that were imported into the
system via unattended processing but are invalid.

acknowledgement  This term is used to indicate the ANSI 997 functional acknowledgement, the EDIA 999
acceptance/rejection advice, and the EDIFACT CNTRL document.

activation This function enables you to make map components available for use. The system
activates all the groups, segments, composites, and elements that are defined as
“mandatory” (must be present) by the standard. The system does not enable you to
deactivate the mandatory groups, segments, composites, and elements. When translating
data, the system does not process groups, segments, composites, and elements (or records
and fields) that are not activated. Therefore, you must activate the groups, segments,
composites, and elements that are not defined as mandatory by the standard, but that you
have determined that you need to use in mapping.

AIAG The Automotive Industry Action Group (AIAG) is the standards-setting group for the
automotive industry. The standards form a subset of the ANSI X12 standard.

ANA  Article Numbering Association.

ANSI  American National Standards Institute. ANSI sets standards for many products and
services, such as safety glasses and battery capacities. The ANSI X12 committee is the
chief EDI standards-setting organization for the United States.

application file If you are creating an import or export map, you must define your application to the
Application Integration subsystem. In Gentran:Server terminology, your application file is
also referred to as a fixed-format file or a positional file. Your application file must contain
all the information that you either need to extract from your partner’s document (if the
map is inbound) or need to send to your partner (if the map is outbound), so that your
system can accurately process the data.
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Glossary

Computer systems, outside of EDI, designed to fulfill specific business functions. These
include accounting, purchasing, materials control, human resources, shipping, and other
systems.

A browser is a window that displays a list of items, such as documents (transaction sets),
interchanges, translation objects, etc. A document browser displays only documents.

A check box enables you to select or clear options from a list. You can select as many
options from the list as you need. A selected check box contains a checkmark. The labels
of unavailable options are dimmed.

These are used by EDI standards as repositories for lists of codes. Each EDI standard
provides a code list for each element that can be further defined with a code.

This feature enables you to select foreground and background colours to visually define
the various map components. The use of colour is optional.

Everything sent and received to/from one telephone number in one continuous period of
connection. This could include sending two or three interchange envelopes to a network,
each for a different trading partner.

This function compiles the form and creates a translation object. The form that you create
using Gentran:Server is a source form. When that source form is compiled, the result is a
compiled translation object. This translation object must be registered with the
Gentran:Server system before you can use it.

This means that the document conforms to the EDI standards as defined by the translation
object.

A simple data element that belongs to a composite data element. Component data
elements are also called subelements.

A contains two or more component data elements or subelements. Composites are defined
by the EDI standards that use them (EDIFACT, TRADACOMS, and certain ANSI X12
standards).

See relational conditions.
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constant

This standard rule enables you to move a literal constant value to the specified element or
field, indicate a qualifying relationship with another element or field, and map the current
date or time to the specified element or field.

This table is created in Partner Editor and is used to convert your values to your trading
partner's values during outbound processing, or your partner's values to your values during
inbound processing.

This type of field or element contains a date or time. If you specify that a field or element
is a date/time type, you must specify exactly how the date or time must be formatted.

This function enables you to make map components unavailable for use by the system.
The system does not enable you to deactivate the mandatory groups, segments,
composites, and elements.

A predefined value — programs use these built-in values unless you specifically override
them.

One transaction set containing actual data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is treated
as a single entity. For example, regardless of whether a purchase order contains one item
or ten thousand, if it is one purchase order, it is one document.

If a trading partner sends you a communication containing 10 purchase orders, you have
received 10 documents. If the communication contained 15 invoices, you have received
15 documents.

International Article Numbering Association, Brussels, Belgium.

Electronic Data Interchange (EDI) is the process by which companies can exchange
business documents directly from application to application by computer without paper
documents being produced.

The EDI File Format Window contains the EDI file format. When you click a segment or
group in the EDI file format, the corresponding frame is displayed in the Layout Window.
When you click an element in the EDI file format, the corresponding layout component is
highlighted in the Layout Window.

This is the rules for turning a business document into an EDI document.
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EDIA Glossary

EDIA  The Electronic Data Interchange Association, formerly known as the Transportation Data
Coordinating Committee (TDCC).

EDIFACT  This is the standards organization of the United Nations Economic and Social Council.
The acronym is short for the Electronic Data Interchange for Administration, Commerce,
and Transport.

element  The smallest piece of usable information defined by the standards. Examples might
include a quantity, unit price, or description. An individual element can have somewhat
different meanings depending on context. Therefore, elements are normally not
considered to have useful meaning until they are combined into segments. An element is
the EDI map component that is mapped (linked) to a corresponding application field to
move data to and from the EDI file.

There are three types of data elements, as illustrated in the table below:

Data Element Definition

Simple data element | A single piece of information
defined by the standards.

Composite data A data element that is made up of
element multiple component elements.
Component data A simple data element that belongs
element to a composite data element.

Component data elements are also
called subelements.

envelope A way of separating information in transmissions for ease of processing. Each envelope
contains a header segment and a trailer segment, which separate the envelope from other
envelopes and provide information about the contents of the envelope.

There are three levels of envelopes, as follows:

» Transaction Set
Each transaction set (business document) is contained within a transaction set
envelope.

» Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

» Interchange Envelope
All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term Transmission
Envelope to refer to this level of envelope. Since we use the term transmission for
other uses, we refer to Interchange Envelope only.
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Note

A communications session could easily include a number of interchange envelopes.
For this reason, the standards-setting bodies are considering a fourth level of
envelope to cover an entire communications session.

This function enables you to reinstate the two sides of the map with focus in equal
dimensions. The use of the Equalize function is optional.

This map defines how to move data from the EDI standard-formatted documents that your
partners send you to your application file (flat file definition). An export map is necessary
for inbound processing.

See export map.

These rules enable you to use a Gentran:Server proprietary programming language to
perform virtually any mapping operation you require.

The smallest piece of information defined in the application file. A field is the application
map component that is mapped (linked) to a corresponding EDI element to move data to
and from your application file.

See application file.

A form is a set of instructions you define in the Forms Integration subsystem that indicates
how the system should format data

A frame contains the groups, repeating segments, and elements at that level (single
segments are not represented on the frame). Gentran:Server uses frames to format the EDI
file for the translation object.

A group of transaction sets that the standards-setting body (such as ANSI) has defined as
fitting together with other related transaction sets. An example might be a Functional
Group defined as containing all purchasing transaction sets.
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Glossary

A looping structure that contains related records/segments and/or groups that repeat in
sequence until either the group data ends or the maximum number of times that the loop is
allowed to repeat is exhausted. If you create a group that is subordinate to another group (a
subgroup), this corresponds to a nested looping structure (a loop within a loop). The
application (positional) file and the EDI file are both groups and therefore, they is visually
represented the same way as other groups and subgroups in Gentran:Server.

This command enables you to import data from an external application file. Depending on
the content of the file, the system may prompt you for partner, transaction, or translation
object information.

This map defines how to move data from your application file (flat file definition), which
may contain multiple documents, to the EDI standard-formatted documents that your
partners expect to receive from you. An import map is necessary for outbound processing.

See import map.

The system translates your trading partner’s EDI standard formatted business document to
your application file format, so you can receive documents from you partners. To translate
inbound data, you need to create an export map.

This Gentran:Server browser contains a list of documents that the system received but that
have not yet been processed by the user. Once the documents are processed (printed or
exported) the documents are transferred to the In Drawer.

This Gentran:Server browser contains a list of documents that were received and
processed.

An integer is a number that has an implied decimal point (e.g., “2.01” is formatted as
‘6201”).

The interchange contains all the functional groups of documents (transaction sets) sent
from one sender to one receiver in the same transmission.
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Glossary Layout Window

Layout Window  The Layout Window contains the actual format of the translation object. Each group (with
a maximum usage greater than one) and repeating segment has a corresponding frame in
the Layout Window. When you click a segment or group in the EDI file format, the
corresponding frame is displayed in the Layout Window. When you click an element in
the EDI file format, the corresponding layout component is highlighted in the Layout
Window.

literal constant  These are used by the system as a repository to store information that is used at a later
point in the map. Typically, constants are used in an outbound map to generate a qualifier.

location table This is a table created in Partner Editor that is used to contain address-related information
about the partner.

lookup table  This is a table created in Partner Editor that is used to select information related to a value
in inbound or outbound data.

loop count  This standard rule enables you to count the number of times a loop is repeated, if the
element or field is part of a loop. If the loop is a nested loop, you can track the current loop
or the outer loop. For example, if the Y loop is nested within the X loop, and the Y loop
has cycled through 15 iterations and the X loop has cycled through 3 iterations, you can
choose to count either the “15” (Y loop) or the “3” (X loop).

loop start/loop end  Certain EDI standards use Loop Start (LS) and Loop End (LE) segments. LS and LE
segments differentiate between two or more loops of the same type. If the transaction
contains LS and LE segments and depending on whether your map is inbound or
outbound, you must define the LS and LE segments for the loops you are using in the map
in one of two different ways.

map A set of instructions you define in the Application Integration subsystem that indicates the
corresponding relationship between your application file and the EDI standards, and
defines how the system should translate data.

network  Also known as a Third Party Network or Value-Added Network (VAN) that accepts and
holds transmissions from companies until it is convenient for a trading partner to accept
them.

number This type of field or element contains either an integer or real number. If you specify that a
field or element is a number type, you must designate the format by specifying a format of
either “N” (integer) or “R” (real) and the number of decimal places.
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Glossary

The Organization for Data Exchange by Tele-Transmission in Europe.

The system translates your application file format to EDI standard formats, so you can
send documents to your partners. To translate outbound data, you need to create an import
map and a system import map in the Application Integration subsystem.

This Gentran:Server browser contains a list of documents that are ready to be sent. After
the documents are successfully sent, they are automatically transferred to the Out Drawer.

This Gentran:Server browser contains a list of documents that were successfully sent out
by the system.

Another firm with which your company trades documents. Also referred to as a trading
partner.

This Gentran:Server function enables you to define, edit, and delete all partner
information for your company and all of your trading partners.

See application file.

This Gentran:Server function enables you to move compliant documents from the
Workspace to the Out Documents.

On a data entry translation object, a default value for a particular element. You can change
the value as necessary.

This is produced when data received from a trading partner passes through a print
translation object. You do not have to actually print the data. The printout could be to a file
on your hard disk.

A print translation object organizes and formats the printout of EDI documents that are
received from or sent to the trading partners for which you have established a trading
relationship (inbound or outbound) that utilizes that print translation object. The print
translation object enables you to view the EDI document in an easily readable format.
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promote

This function extracts one iteration (instance) of a group or repeating segment. This
enables you to map unique data from your application file, and/or enter a specialized
definition. Gentran:Server specifies that only one-to-one (no loops) or many-to-many
(loop) mapping relationships are valid.

This is an element that has a value expressed as a code that gives a specific meaning to the
function of another element. A qualifying relationship is the interaction between an
element and its qualifier. The function of the element changes depending on which code
the qualifier contains.

A real number has an explicit decimal point (e.g., “2.01” is formatted as “2.01”), and
truncates trailing zeroes.

This Gentran:Server function enables you to manually initiate a communications session
to receive data from a network through an invocation of the Connection Manager.

Contains a group of related fields. A record can occur once or can repeat multiple times.

This function enables to connect fields together for syntax or compliance reasons. For
example, Field A is invalid unless Field B is present. Therefore, if you set up a condition
that pairs Fields A and B, the system generates a compliance error if one of those fields is
not present.

This Gentran:Server function enables you to create a turnaround document (using the Turn
Around translation object in the partner relationship) in response to one or more selected
documents in the In Drawer.

An organization that develops and updates standards for EDI communications. These
organizations include ANSI, EDIA, AIAG, UCS, EDIFACT, ODETTE, and VICS.

A screen entry translation object provides a standardized format for keying an EDI
document into the Document Editor, for translation and transmission to your trading
partners, for which you have established an outbound trading relationship that utilizes that
screen entry translation object. The screen entry translation object ensures that your users
key all the data necessary to create the required EDI document.
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Glossary

A group of related elements or composite data elements that combine to communicate
useful data. Segments are defined by the EDI standards. A segment can occur once or can
repeat multiple times. For example, a catalog price segment might consist of elements for
item description, volume, price, lead time, etc. By themselves, none of these elements
would communicate useful information. Together, they provide the information necessary
for someone to tell if the item is what is desired, whether the price is reasonable, etc. A
number of segments together form a transaction set.

This standard rule enables you to select entries from a location table, cross-reference table,
partner table, or lookup table (all tables created in the Gentran:Server Partner Editor). You
can then map the fields in those tables to one or more fields in the data. The Select
function uses the value of the current field to perform the selection.

This Gentran:Server function enables you to manually start a communications session to
send data to a network through an invocation of Connection Manager. Only selected
documents are enveloped and sent. If no documents are selected, ALL documents are sent.
Successfully sent documents are moved to the Out Drawer.

See Transaction Set.

See link.

This function enables you to split (break) a group or repeating segment into two loops.
You typically use this function when you need more than one instance of the same map
component that still occurs multiple times.

These rules give you access to functions that are necessary for mapping operations that are
more complex than simple linking, but less involved than extended rules. Each of the
standard rules are mutually exclusive (you can use only one on a particular field).

Static text is text that is always included in the screen entry or print translation object.
Examples of static text include legends and column headings. Field labels, which usually
accompany fields to identify the contents of the fields, are not considered static text.

The status bar of an application window defines information about a selection, command,
or process, defines Menu Bar items as the user highlights each item, and indicates any
current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock” key or NUM
for the “Num Lock” key, etc.).
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string

This type of field or element contains one or more printable characters. If you specify that
a field or element is a string type, you must designate the format by specifying a syntax
token.

This function enables you to designate a “token” that defines ranges of characters and/or
numbers that are allowed to be used for a string-type element or field. You can then use
the syntax tokens in the Format field of the Field Properties dialog. This enables you to
define what type of characters should be used while compliance checking each element/
field (i.e., alphanumeric within a certain range, numeric within a certain range, etc.).

The translator uses this map to determine which trading relationship (established in
Partner Editor) corresponds to each document in the application file, so the system knows
which import map to use to process the document. You need a system import map that is
defined in EDIMGR.INI to translate outbound data.

See system import map.

These translation objects control the creation and separation of interchanges, functional
groups, and transaction sets. They also used to generate and reconcile functional
acknowledgements. All the required system translation objects are automatically installed
with the Gentran:Server system.

See EDIA.

TDF is the Transaction Data File. This file serves as a filter between your document files
and the Gentran:Server translator. For outbound processing, data is imported from a TDF
file and translated to EDI format using a TDF Import translation object. The data is then
ready to be posted and sent to your trading partner. For inbound processing, EDI
documents that are received by Gentran:Server can be exported to a TDF-formatted file
using a TDF Export translation object. This data file is then ready to be processed or
converted to your internal application files.

See Network.

The title bar of an application window contains the name of the application and enables
you to move the window to another position on your desktop.

This contains buttons that graphically represent commands available in the Menu Bar.
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TRADACOMS Glossary

TRADACOMS  The UK. standards for EDI that are published by the Article Numbering Association
(UK) LTD.

trading partner  Another firm with which you company trades documents. Also referred to as a partner.

transaction set A business form as defined by the standards. Examples include an ANSI 850 purchase
(document)  order or an UCS 880 invoice. The standards define each transaction set in terms of the
segments and elements that make up the form, the order in which they appear, and the

relationships among them. This is also known as “message” in Europe.

translation object A predesigned layout set up to ensure that input or output for a particular transaction set
exists and is presented in a usable fashion. You must specify which translation objects are
used by each partner relationship.

Inbound Translation Objects:

» Turn Around: This translation object is used when a document is received, to create
the natural response document that contains as many elements from the received
document as possible.

» Export File: This translation object indicates that when a document is received, it is
exported to a specified file format.

» Print: This translation object is used to print documents.

Outbound Translation Objects:
» Import: This translation object is used to import data from an application file.

»  Print: This translation object is used to print documents.

» Data Entry: This translation object is used to enter data into the Document Editor
facility.

translator This is the engine that processes data for the Gentran:Server, Application Integration
subsystem and Forms Integration subsystem.

transmission See Communications Session.

transmission chain A path an EDI communication could follow, including one company, one trading partner,
and one or more network services.

turnaround A document into which data elements from the source document have been automatically
document transferred using a turnaround map.
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turnaround map

A series of instructions that the system uses to create a turnaround document (a logical
response document to the source) from an inbound (source) document, by transferring
data from the source document to elements in the target document (translation object).

The Uniform Communications Standard is the standard used by the grocery industry.

This standard rule enables you to update a specific field in a document record, envelope
segment, interchange, group, current partner, or document (if the map side format type is
EDI), with the contents of the element or field.

This standard rule gives you access to a set of numeric variables that you can manipulate
via numeric operations, and then transfer to and from fields. This function enables you to
add, change, or delete calculations for the element/field, including hash totals (used to
accumulate numeric field values, i.e., quantity, price, etc.). This function also enables you
to map the accumulated total into a control total field, and use accumulators.
Accumulators are used generally for counting the occurrences of a specific element or
generating increasing or sequential record or line item numbers.

This standard rule enables you to match an element or field against a predefined code
table, specify whether or not a compliance error is generated if the element or field does
not contain one of the values in the code table, and store a code’s description in another
element or field.

These translation objects control data entry, importing, exporting, document turnaround,
and creating printed reports. These translation objects are created using the Application
Integration or Forms Integration subsystems. The Application Integration subsystem
enables you to generate import, export, and document turnaround translation objects. The
Forms Integration subsystem enables you to generate data entry and print translation
objects.

Each standards-setting body updates its standards on a regular basis. Each formal update is
referred to as a version.

The Voluntary Inter-industry Communication Standards is the standards-setting body for
the retail industry, a subset of ANSI X12.

This Gentran:Server browser contains a list of outbound “Work in Progress” documents. It
also contains recently imported or data entry documents.

The ANSI committee that sets and publishes standards for EDI.

Forms Integration TRADACOMS Tutorial Guide Gentran:Server for Windows — August 2008 ()



L X12 Glossary

() Gentran:Server for Windows — August 2008 Forms Integration TRADACOMS Tutorial Guide



	Table of Contents
	About This Guide
	Contents
	Welcome
	Overview
	Related manuals
	Intended audience
	Prerequisite knowledge
	Overview
	Organization of chapters
	Overview
	Introduction
	Phone number
	Before calling support
	Accessing the Sterling Commerce Support Web Site
	Documentation

	Getting Started
	Contents
	Introducing Forms Integration
	Overview
	What is a form?
	What is a print translation object?
	What is a screen entry translation object?

	Navigation
	Overview
	Forms Integration Window
	Forms Integration Window parts and functions
	Main Toolbar

	EDI File Format Pane
	Overview
	Generating EDI files
	Generating specialized EDI standard versions
	Form components

	Layout Pane
	Overview
	List formats
	Field formats
	Frames
	Displaying information

	Building a Form with Forms Integration
	Overview
	Stages of building a form

	How to Launch Forms Integration
	Overview
	Procedure

	How to Install Gentran Standards
	Overview


	Creating a Print Form
	Contents
	Overview
	Introduction
	In this chapter
	Purpose of this tutorial
	Form criteria
	Mandatory components
	Before you begin

	Phases of Designing a Form
	Design phases

	Getting Started
	Overview
	Print form scenario


	Analyze the EDI File
	Basic Tasks
	Introduction
	Form analysis
	Mandatory components
	Required components
	Segment analysis
	Customization tasks


	Design and Create the Form
	Verifying the Global EDI Date Formats
	Introduction
	Procedure

	Defining the Type of Form
	Overview
	Procedure

	Activating Groups, Segments, and Elements
	Overview
	Example
	Groups, segments, composites, and elements used in this tutorial
	Procedure

	Verifying EDI Delimiters
	Overview
	EDI delimiters table
	Procedure


	Modify Form Components
	Promoting and Changing Segments and Groups
	Introduction
	Changing the maximum use

	Modifying the Maximum Use of the REF Segment
	Overview
	Procedure

	Inserting a New N4 Group
	Overview
	How to add a group
	How to cut and paste the N4 segment

	Modifying the Maximum Use of the PID Group
	Overview
	Procedure

	Promoting the DTM:2 Segment
	Overview
	How to promote the segment
	How to make the DTM:4 segment conditional
	How to change the maximum use of the DTM:2 segment

	Creating a CTT Group
	Overview
	How to create the CTT group
	How to cut and paste the CTT segment

	Generating the Form
	Overview
	Procedure
	After generating the form


	Customize the EDI Data
	Overview
	Introduction
	How to set up the document name

	Customizing the BEG Segment
	Overview
	How to customize the BEG01 element
	How to customize the BEG02 element
	How to copy the BEG02 element
	How to change the BEG09 element and field properties
	How to change the BEG09 element and field properties (contd)
	How to hide the BEG02 Field and load a code list table from the standard
	How to hide the BEG02 Field and load a code list table from the standard (contd)
	How to customize the BEG03 element
	How to customize the BEG05 element

	Customizing the NTE Segment
	Overview
	How to customize the NTE02 element

	Customizing the REF Segment
	Overview
	How to customize the REF01 element
	How to customize the REF02 element

	Customizing the ITD Segment
	Overview
	Customizing the ITD01 element
	How to copy the ITD01 element
	How to change the ITD16 element and field properties
	How to hide the ITD01 field and load the code list table from the standard
	How to hide the ITD01 field and load the code list table from the standard (contd)
	How to customize the ITD12 element

	Customizing the N1 Group
	Overview
	After customization

	Customizing the N1 Segment
	Overview
	Customizing the N101 element
	How to copy the N101 element
	How to change the N107 element and field properties
	How to hide the N101 Field and load the code list table from the standard
	How to customize the N102 element

	Customizing the N3 Segment
	Overview
	How to customize the N301 element
	How to customize the N302 element

	Customizing the N4 Segment
	Overview
	How to customize the N401 element
	How to customize the N402 element
	How to customize the N403 element

	Customizing the PO1 Group
	Overview
	Before customizing
	After customizing

	Customizing the PO1 Segment
	Overview
	How to customize the PO101 element
	How to customize the PO102 element
	How to customize the PO103 element
	How to customize the PO104 element
	How to customize the PO106 element
	How to customize the PO107 element

	Customizing the PID Group
	Overview
	How to customize the PID:201 element
	How to customize the PID:205 element

	Customizing the DTM:4 Segment
	Overview
	How to use a key field for the DTM:4 segment
	How to customize the DTM:401 element
	How to customize the DTM:402 element

	Customizing the DTM:2 Segment
	Overview
	How to use a key field for the DTM:2 segment
	How to customize the DTM:201 element
	How to customize the DTM:202 element


	Format the Print Form
	Overview
	Introduction

	Resizing the Header Frame
	Overview
	Procedure

	Adding a Title to the Form
	Overview
	Procedure
	How to center the text

	Arranging the Header Fields (BEG and REF Segments)
	Overview
	How to resize the header fields
	How to move and align the header fields and field labels

	Arranging the Note Field
	Overview
	How to move the field
	How to resize the NTE frame

	Arranging the Terms of Sale Fields
	Overview
	How to resize the ITD fields
	How to move the fields
	How to align the fields
	How to resize the ITD frame

	Arranging the Name and Address Fields
	Overview
	How to resize the N1 frame
	How to resize the N3 frame
	How to resize the N4 frame
	How to arrange the N1 fields
	How to arrange the N3 fields
	How to arrange the N4 fields

	Arranging the Line Items Fields
	Overview
	How to resize the PO1 frame
	How to resize the line items fields
	Adding column headings
	Adding column headings (contd)
	Procedure
	How to add lines separating column headings and fields
	Moving the PO1 fields, column headings, and separating lines
	How to arrange the line no. column
	How to arrange the prod ID column
	How to arrange the code type column
	How to arrange the Qty Ord column
	How to arrange the Unit column
	How to arrange the Price Each column
	How to arrange the Requested Ship Date column
	How to arrange the Ship No later column
	How to move the Description field
	How to resize the PO1 frame
	How to align rows
	How to align columns
	Creating the Line Items frame without column headings
	How to copy and paste the PO1 group
	How to change the maximum use of the PO1 group
	How to change the maximum use of the PO1:2 group
	How to move the PO1:2 column headings below the print area

	Resizing the Transaction Total Frame
	Overview
	Procedure


	Finalize the Form
	Overview
	Introduction

	Compiling the Form
	Overview
	Procedure

	Printing the Report
	Overview
	Procedure

	Testing the Translation Object
	Overview
	Procedure



	Creating a Screen Entry Form
	Contents
	Overview
	Introduction
	In this chapter
	Form criteria
	Mandatory components
	Before you begin
	Before you begin (contd)

	Phases of Designing a Form
	Design phases

	Getting Started
	Overview
	Screen entry form scenario


	Analyze the EDI File
	Basic Tasks
	Introduction
	Form analysis
	Mandatory components
	Required components
	Segment analysis
	Customization tasks


	Design and Create the Form
	Verifying the Global EDI Date Formats
	Introduction
	Procedure

	Defining the Type of Form
	Overview
	Before you begin
	Procedure

	Activating Groups, Segments, and Elements
	Overview
	Example
	Groups, segments, composites, elements used in this tutorial
	Procedure

	Verifying EDI Delimiters and Adding Frame Help Text
	Overview
	EDI delimiters
	Procedure


	Modify Form Components
	Promoting and Changing the Maximum Use of Segments and Groups
	Introduction

	Modifying the Maximum Use of the REF Segment
	Overview
	Procedure

	Modifying the Maximum Use of the N3 Segment
	Overview
	Procedure

	Promoting the N1 Group
	Overview
	Procedure

	Changing the Maximum Use of the ITD Segment
	Overview
	Procedure

	Changing the Maximum Use of the DTM Segment
	Overview
	Procedure

	Changing the Maximum Use of the PID Group
	Overview
	Procedure

	Changing the Maximum Use of the DTM:2 Segment
	Overview
	Procedure

	Changing the Maximum Use of the CAD Segment
	Overview
	Procedure

	Generating the Form
	Overview
	Procedure
	After generating the form


	Customize the EDI Data
	Overview
	Introduction
	Setting up the document name
	Procedure

	Customizing the BIG Segment
	Overview
	How to customize the BIG01 element
	How to customize the BIG02 element
	How to customize the BIG03 element
	How to customize the BIG04 element

	Customizing the REF Segment
	Overview
	How to customize the REF01 element
	How to customize the REF02 element

	Customizing the N1 Groups
	Overview

	Customizing the N1:3 Segment
	Overview
	How to use a key field for the N1:3 segment
	How to customize the N1:301 element
	How to customize the N1:302 element

	Customizing the N3:3 Segment
	Overview
	How to customize the N3:301 element
	How to customize the N3:302 element

	Customizing the N4:3 Segment
	Overview
	How to customize the N4:301 element
	How to customize the N4:302 element
	How to customize the N4:303 element

	Customizing the N1:4 Segment
	Overview
	How to customize the N1:401 element
	How to customize the N1:402 element

	Customizing the N3:4 Segment
	Overview
	How to customize the N3:401 element
	How to customize the N3:402 element

	Customizing the N4:4 Segment
	Overview
	How to customize the N4:401 element
	How to customize the N4:402 element
	How to customize the N4:403 element

	Customizing the ITD Segment
	Overview
	How to customize the ITD01 element

	Customizing the DTM Segment
	Overview
	How to customize the DTM01 element
	How to customize the DTM02 element

	Customizing the IT1 Group
	Overview
	Procedure

	Customizing the IT1 Segment
	Overview
	How to customize the IT101 element
	Procedure
	How to customize the IT102 element
	How to customize the IT103 element
	How to customize the IT104 element
	How to customize the IT104 element (contd)
	How to customize the IT106 element
	How to customize the IT107 element

	Customizing the PID Group
	Overview

	Customizing the PID:2 Segment
	Overview
	How to customize the PID:201 element
	How to customize the PID:205 element

	Customizing the DTM:2 Segment
	Overview
	How to customize the DTM:201 element
	How to customize the DTM:202 element

	Customizing the CAD Segment
	Overview
	How to customize the CAD01 element
	How to customize the CAD08 element

	Customizing the TDS Segment
	Overview

	Customizing the CTT Segment
	Overview


	Format the Screen Entry Form
	Overview
	Introduction

	Resizing the Invoice Frame
	Overview
	Procedure

	Arranging the Fields on the Invoice Frame
	Overview
	Invoice frame
	How to resize, move, and align the fields
	How to resize the invoice frame
	How to align the fields and field labels
	How to add column headings to the line items list
	How to set the tab sequence on the invoice frame

	Arranging the Fields on the Line Items Frame
	Overview
	How to resize the line items frame
	How to resize the fields
	How to move and align the fields
	How to resize the line items frame
	How to align the fields and field labels
	How to set the tab sequence on the line items frame

	Changing the Invoice Frame Title
	Overview
	Procedure


	Finalize the Form
	Overview
	Introduction

	Compiling the Form
	Overview
	Procedure

	Printing the Report
	Overview
	Procedure

	Testing the Translation Object
	Overview
	Procedure
	?In Documents
	?Out Documents
	acknowledgement
	activation
	AIAG
	ANA
	ANSI
	application file
	application system
	browser
	check box
	code list tables
	colours
	communications session
	compile
	compliant
	component data element
	composite data element
	conditions
	constant
	cross-reference table
	date/time
	deactivation
	default
	document
	EANA
	EDI
	EDI File Format Window
	EDI standard
	EDIA
	EDIFACT
	element
	envelope
	equalize
	export map
	export translation object
	extended rules
	field
	fixed-format file
	form
	frame
	functional group
	group
	import
	import map
	import translation object
	inbound mapping
	In Documents
	In Drawer
	integer
	interchange
	Layout Window
	literal constant
	location table
	lookup table
	loop count
	loop start/loop end
	map
	network
	number
	ODETTE
	outbound mapping
	Out Documents
	Out Drawer
	partner
	Partner Editor
	positional file
	post
	predefined
	printout
	print translation object
	promote
	qualifier
	real number
	receive
	record
	relational condition
	respond
	responsible agency
	screen entry translation object
	segment
	select
	send
	set
	simple mapping
	split
	standard rules
	static text
	status bar
	string
	syntax token
	system import map
	system import translation object
	system translation object
	TDCC
	TDF
	third-party network
	title bar
	toolbar
	TRADACOMS
	trading partner
	transaction set (document)
	translation object
	translator
	transmission
	transmission chain
	turnaround document
	turnaround map
	UCS
	update
	use accum
	use code
	user translation object
	version
	VICS
	Workspace
	X12





<<
  /ASCII85EncodePages false
  /AllowTransparency false
  /AutoPositionEPSFiles true
  /AutoRotatePages /All
  /Binding /Left
  /CalGrayProfile (Dot Gain 20%)
  /CalRGBProfile (sRGB IEC61966-2.1)
  /CalCMYKProfile (U.S. Web Coated \050SWOP\051 v2)
  /sRGBProfile (sRGB IEC61966-2.1)
  /CannotEmbedFontPolicy /Warning
  /CompatibilityLevel 1.4
  /CompressObjects /Tags
  /CompressPages true
  /ConvertImagesToIndexed true
  /PassThroughJPEGImages true
  /CreateJDFFile false
  /CreateJobTicket false
  /DefaultRenderingIntent /Default
  /DetectBlends true
  /ColorConversionStrategy /LeaveColorUnchanged
  /DoThumbnails false
  /EmbedAllFonts true
  /EmbedJobOptions true
  /DSCReportingLevel 0
  /EmitDSCWarnings false
  /EndPage -1
  /ImageMemory 1048576
  /LockDistillerParams false
  /MaxSubsetPct 100
  /Optimize true
  /OPM 1
  /ParseDSCComments true
  /ParseDSCCommentsForDocInfo true
  /PreserveCopyPage true
  /PreserveEPSInfo true
  /PreserveHalftoneInfo false
  /PreserveOPIComments false
  /PreserveOverprintSettings true
  /StartPage 1
  /SubsetFonts true
  /TransferFunctionInfo /Apply
  /UCRandBGInfo /Preserve
  /UsePrologue false
  /ColorSettingsFile ()
  /AlwaysEmbed [ true
  ]
  /NeverEmbed [ true
  ]
  /AntiAliasColorImages false
  /DownsampleColorImages true
  /ColorImageDownsampleType /Bicubic
  /ColorImageResolution 300
  /ColorImageDepth -1
  /ColorImageDownsampleThreshold 1.50000
  /EncodeColorImages true
  /ColorImageFilter /DCTEncode
  /AutoFilterColorImages true
  /ColorImageAutoFilterStrategy /JPEG
  /ColorACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /ColorImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000ColorACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000ColorImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasGrayImages false
  /DownsampleGrayImages true
  /GrayImageDownsampleType /Bicubic
  /GrayImageResolution 300
  /GrayImageDepth -1
  /GrayImageDownsampleThreshold 1.50000
  /EncodeGrayImages true
  /GrayImageFilter /DCTEncode
  /AutoFilterGrayImages true
  /GrayImageAutoFilterStrategy /JPEG
  /GrayACSImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /GrayImageDict <<
    /QFactor 0.15
    /HSamples [1 1 1 1] /VSamples [1 1 1 1]
  >>
  /JPEG2000GrayACSImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /JPEG2000GrayImageDict <<
    /TileWidth 256
    /TileHeight 256
    /Quality 30
  >>
  /AntiAliasMonoImages false
  /DownsampleMonoImages true
  /MonoImageDownsampleType /Bicubic
  /MonoImageResolution 1200
  /MonoImageDepth -1
  /MonoImageDownsampleThreshold 1.50000
  /EncodeMonoImages true
  /MonoImageFilter /CCITTFaxEncode
  /MonoImageDict <<
    /K -1
  >>
  /AllowPSXObjects false
  /PDFX1aCheck false
  /PDFX3Check false
  /PDFXCompliantPDFOnly false
  /PDFXNoTrimBoxError true
  /PDFXTrimBoxToMediaBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXSetBleedBoxToMediaBox true
  /PDFXBleedBoxToTrimBoxOffset [
    0.00000
    0.00000
    0.00000
    0.00000
  ]
  /PDFXOutputIntentProfile ()
  /PDFXOutputCondition ()
  /PDFXRegistryName (http://www.color.org)
  /PDFXTrapped /Unknown

  /Description <<
    /FRA <>
    /ENU (Use these settings to create PDF documents with higher image resolution for improved printing quality. The PDF documents can be opened with Acrobat and Reader 5.0 and later.)
    /JPN <FEFF3053306e8a2d5b9a306f30019ad889e350cf5ea6753b50cf3092542b308000200050004400460020658766f830924f5c62103059308b3068304d306b4f7f75283057307e30593002537052376642306e753b8cea3092670059279650306b4fdd306430533068304c3067304d307e305930023053306e8a2d5b9a30674f5c62103057305f00200050004400460020658766f8306f0020004100630072006f0062006100740020304a30883073002000520065006100640065007200200035002e003000204ee5964d30678868793a3067304d307e30593002>
    /DEU <>
    /PTB <>
    /DAN <>
    /NLD <>
    /ESP <>
    /SUO <>
    /ITA <>
    /NOR <>
    /SVE <>
  >>
>> setdistillerparams
<<
  /HWResolution [2400 2400]
  /PageSize [612.000 792.000]
>> setpagedevice


